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Welcome to Concordance, the flexible and powerful text analysis 
software. 
 
Do you want to start now? See Getting Started
 
Context-sensitive help is available at nearly all times by pressing the F1 key. 
 
 
Disclaimer 

 
 

This software is provided AS IS without warranty of any 
kind, either express or implied. There is no warranty as 
to merchantable quality or fitness for a particular 
purpose. The entire risk as to the quality and 
performance of the program is with you.  Should the 
software prove defective, you assume the cost of all 
necessary servicing, repair, or correction.  In no event 
shall I, the author, be liable for any damages of any kind 
whether direct, indirect, or otherwise, arising out of the 
delivery, performance or use of this software. This 
software has been written with great care but it is not 
warranted to be error-free. You may not attempt to 
reverse-compile, modify, translate or disassemble the 
software in whole or in part.  As the software is the 
product of one person, not a company, it is 
supported on a best-effort basis, i.e. as time permits, 
and purchasing the software does not confer a right 
to support. 
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CONCORDANCE COPYRIGHT © 1999 - 2009 R.J.C. WATT   

 
ALL RIGHTS RESERVED 

 
 

About Concordance: main features 

  
Concordance is a program for Windows Vista / XP / 2000 / NT4.0 and Windows 98 / ME, 
which makes wordlists, concordances, and Web Concordances from your electronic texts. 
 
Concordance is fully copyrighted. You may try it out free of charge for thirty days for 
personal evaluation only, but if you wish to keep on using it you must register it with the 
author and pay the registration fee. By using it you consent to the Licence Terms and 
Conditions. Please note them carefully, as there are restrictions on what you may do with 
the unregistered version. For example, the unregistered version may not be used for work 
purposes of any kind, including teaching or demonstration purposes, nor as part of an 
educational course, and you may not publish or distribute anything made with the 
unregistered version.  The free trial is granted purely for you to evaluate the software. 
 
Features 
 
You can: 
•  Make wordlists, word frequency lists, and indexes  
•  Make full concordances to texts of any size, limited only by available disk space and 
memory   
•  Make selective concordances, picking your selection of words from text   
•  Use multiple input files  
•  Make concordances straight from text in other Windows programs  
•  Make Web Concordances: turn your concordance into linked HTML files, ready for 
publishing on the Web, with a single click  
•  View a full wordlist, a concordance, and your original text simultaneously   
•  Browse through the original text and click on any word to see the concordance for that 
word   
•  Edit and re-arrange a wordlist by drag and drop   
•  See the collocation counts for every word, up to four words left and right  
•  Lemmatise a wordlist - group together any words you choose 
 
Powerful Facilities:  
•  Support for many different languages and character sets   
•  User-definable alphabet   
•  User-definable reference system   
•  User-definable contexts  
•  Very flexible search, selection, and sorting criteria   
•  Statistics on your text   
•  Stop Lists let you specify words to be omitted from your concordance  
•  Word length chart  
•  Full print preview and printing, with control over page size, margins, headers, footers, fonts 
etc.   
•  Can save concordances as plain text, as a single HTML file, or as a Web Concordance  
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Comprehensive tools:  
•  Built-in file viewer can display files of unlimited size   
•  Built-in editor allows fast editing of files up to 16MB   
•  Tools supplied for converting from OEM to ANSI character sets and from Unix to PC files  
 
High usability:  
•  Easy user interface with modern Windows features   
•  Context-sensitive help system with over 200 topics   
•  Runs fast - can make and display a full concordance to the Complete Works of 
Shakespeare (980,000 words) in around 80 seconds on a computer with a 3GHz Core2 Duo 
processor  
•  Entirely native 32-bit code for speed and stability  
 
Make sure you have the latest version by visiting the Concordance website . 
 
See also: What the program does
 
CONCORDANCE COPYRIGHT © 1999 - 2009 R.J.C. WATT  ALL RIGHTS RESERVED 
 

Getting Started: analyse your first text 
 
Remember that context-sensitive help is available at nearly all times by pressing the F1 key. 

Quick Start 
 
Here's a minimalist's guide to using Concordance: 
•  Select 'Make Full Concordance'  from the File Menu, then select a plain (ASCII) text file 
containing the text you want to use. A Full Concordance show all the words from your text. If 
you want to analyse another kind of file that is not plain text (for example, a file from Microsoft 
Office, or from a web page), see Preparing Text . 
•  I urge you to begin with the tutorial files which are in the Sample Files folder where 
Concordance is installed.  The first one is called Demo1.txt. 
•  Alternatively, choose  'Make Selective Concordance' from the File Menu. A Selective 
Concordance shows only the words you select. Specify the words you want to include in your 
concordance, then select the file containing your text. 
•  The concordance will be made and displayed.  The left-hand pane is the Wordlist View, 
containing the words found in the text, with these number of times they occurred.  Click on 
any word to display all its contexts in the right-hand pane, the Context View. 
•  In the Context View, click on a line and a viewer will open showing the full text from which 
the concordance was made, positioned to the line you clicked on. 
•  In the full text viewer, double-click on any word, and the Wordlist View will position itself to 
display that word.   
 
After that, see Preparing Text and Changing What's Displayed to get fuller control over your 
results. 
 
Concordance has a huge variety of flexible options. Before you start on a large or important 
project, it is always a good idea to develop and test your settings by using very small files and 
checking that the results are what you would expect. Concoct such files for the purpose if 
necessary. 
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Don't overlook the tutorial files in the Sample Files folder where Concordance is 
installed.  You are strongly recommended to make concordances to them as a quick 
way of learning the essential features of the program. 
 
More advanced tutorial material, written by professional users of Concordance, is available 
on the web. Links are on the page on the Concordance website entitled Getting started with 
text analysis. 
 
See also: 

 What is a concordance?
 What the program does
 The program's main window
 Tutorial files

 

What is a concordance? 

 
Concordances are general-purpose working tools for the close study of texts, whether the 
texts are literary, linguistic, historical, religious, philosophical, legal, commercial, or of other 
kinds.  
 
A concordance is first of all a comprehensive index to a text, similar to the index at the back of 
a book, except that every occurrence of every word in the text can have an entry in a 
concordance.  By looking up a word in a full concordance you can be certain you have found 
every instance of that word in the text. 
 
In addition, every instance of each word is shown in an illustrative context, and is provided 
with a reference to show whereabouts the word (and its context) occur in the original text. 
 
If the words are given with references but no contexts, you have a verbal index instead of a 
concordance; and if neither references nor contexts appear, you have a wordlist.  This 
program can do both. 
 
Because words are given with their contexts, the concordance makes it easy to compare all 
the usages of any word in a text or body of writing.  This makes possible all kinds of insights 
into meaning and usage. 
 
Words are shown with the number of times they occur (their frequency of occurrence).  This 
opens up rich possibilities for studying the language of your texts and comparing it with the 
language of other texts. 
 
See also:  
What is a Web Concordance?
Quick Start
Tutorial files  
 
 

What the program can do 

 
Using Concordance you can analyse text files in very flexible ways. 
•  You can make wordlists - lists of all the different words which occur in a text. The wordlists 
can be arranged (sorted) in many different ways. Each word can be optionally accompanied 
by a count of the number of times it occurs, and by a note of the percentage of all words 
which it represents. 
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•  You can make concordances - wordlists where each occurrence of each word is shown in 
its context - that is, an extract from the original text which includes the word.  Contexts can be 
selected and arranged in many different ways. 
•  The program can make complete concordances to all the words in your text. It is not limited 
to doing a few words at a time, though it can do so if you wish.  It can handle large texts and 
has very few intrinsic limits on their size. In practice, the size of input texts is limited only by 
the amount of available disk space on your computer and, to some extent, by the amount of 
free memory (RAM). 
•  Complete concordances are made using Make Full Concordance on the File Menu.  
Concordances to selected words of your choice are made using Make Selective 
Concordance on the File Menu. 
•  While viewing the results, you can select the words you want to keep in your wordlist or 
concordance using powerful selection criteria. 
•  You can browse the wordlist, the concordance, and your original text at will, and all three 
are interlinked so that you can jump immediately to any item of interest. 
•  You can print the concordance, having selected which elements you want to appear in the 
printed version.  There is good control over page layout and fonts, and there is a powerful 
print preview. 
•  You can save the concordance as a plain text file suitable for further editing, or as an 
HTML file for use with a web browser.   
•  Finally, you can turn your concordance into a Web Concordance - a series of files which 
are ready for deployment on the web and represent a wordlist, a concordance, and a source 
text hypertextually linked. 
 
See also: 
About Concordance
What is a Concordance?  
What is a Web Concordance?
Tutorial files  
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The Main Window 
If you use Concordance's help system directly, rather than viewing this printed version, you 
can click on parts of the image below to see an explanation of their function.  
 
 
See also:  
Quick Start
Splitting Views
Re-sizing and re-arranging columns  
 

 
 
 
 
 
 

About the Registered Version 

 
You may try out Concordance free of charge for a period of thirty days. If you wish to use it 
for work during the 30 days, or to keep on using it after that time, you must buy a registration.  
Please read the Licence Terms and Conditions first, as there are restrictions on what you 
may do with the unregistered version. 
 
  How to buy including prices 
  Multiple Copy Pricing
  Postal Registration Form (non-credit card orders only) 
  Getting the Latest Version
  Distribution
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The Unregistered Version 
 
The unregistered version of Concordance is fully functional. You are allowed to use it for no 

nger than thirty (30) days for personal evaluation and trial purposes only.  lo
 
If you have not registered after thirty days, the program will cease to work until you register.   
 
You can register during the thirty-day trial period or afterwards. If the trial period has expired 
and the program has ceased to work, it will start to work again when you register. 
•  You may not distribute, publish, or exhibit files, Web Concordances, or other 
materials made with the unregistered version.  You may not make them accessible on a
website. 

 

 may 

o remind you to register, the unregistered version will add an 'Unregistered' notice to 
export or print them. You may not remove these notices.  

d to 

d to buy two or more 

•  The unregistered version may not be used for work purposes, including teaching or 
demonstration purposes, or as part of an educational course in any way, whether as 
eacher or as student. t
•  You may not install or use multiple copies of the unregistered version, and you
not permit others (for example, a class of students) to do so. 
 
T
concordances when you 
 

When you register 
 
Once you have registered, you will receive by e-mail a personal registration key and 
instructions for entering it into the program. You may enter your key in exactly one (1) copy of 
the program, installed on a single computer. More than one person is allowed to use the 
software, as long as no two people use it at the same time. If in doubt, think of it as a book: it 
can be read by many people, but by only one person at a time.  If two or more people nee
use it at the same time, you need to buy two or more copies.  If you want to install it on two or 

ore computers (including one at work and one at home), you neem
copies. See the Licence Terms and Conditions for fuller details. Second and subsequent 

y Pricingcopies are attractively priced: see Multiple Cop . 

rogram or download anything else when you register. 

 charge and without re-registering 

d with documents you create using a word processor.  
tional 

 
A
 

ll registration keys are distributed by e-mail.  

You won't have to re-install the p
 

Benefits of Registration 
•  You will no longer see 'Unregistered' messages when you export and print.   
•  You will receive e-mail notification when new versions of the program are available. 
  You will be entitled to upgrade to new versions free of•

for some time to come.  If a subsequent major release of the program does require a new 
purchase, existing customers will get preferential rates. 
 
You will be entitled to publish or distribute files, Web Concordances, and all other materials 
which you make with the registered version.  (Be sure you are not infringing someone else's 
copyright on the source texts.)  All materials you create with the registered version of 
Concordance are your property entirely and you may do whatever you like with them, just as 
you coul
•  You will be able to use your registered copy for teaching or study as part of an educa
ourse. c
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•  If you need to ask me questions, I will give them higher priority than questions from 
nregistered users. 

red version adds a single unobtrusive 'Made with Concordance' message to the 
ML files it creates.  You are invited to let this remain, but you are free to remove 

s made with the program, the message with its link to 
 save you having to answer questions about how you created 

u
 

The Registered Version 
 

he registeT
end of the HT
it if you wish.  If you publish any web file
the Concordance website will
them. 
 
See also:  
  How to buy including prices 
  Multiple Copy Pricing
  Postal Registration Form (not for credit card orders) 
  Getting the Latest Version
  Distribution
  Licence Terms and Conditions
 
CONCORDANCE COPYRIGHT © 1999 - 2009 R.J.C. WATT  ALL RIGHTS RESERVED 
 

How to buy 

 
You can buy your registration for Concordance at any time during or after your 30-day free 
trial.   
 

ou can buy now online using a credit orY
h

 debit card via the secure ordering links at 
ww.concordancesoftware.co.uk/buynow.htmttp://w  . 
ge also has the latest information about pricing, ordering, and delivery times.  Go 

ere now and you can skip the information here below!  Read on if you want to order by 
That pa
th
another means, or if you have questions. 
 
Price 
 
For current prices, please see http://www.concordancesoftware.co.uk/buynow.htm . 
 
Second and subsequent copies are attractively priced: see Multiple Copy Pricing.  
 
Instructors at recognised educational establishments can arrange to purchase copies on 
behalf of their own students at the second-copy price. Again, see Multiple Copy Pricing. 
 

 more than one person

 

 will be using the program at the same time, you must register a copy 
the program on more than one computer, you must buy 
you want to use one copy at work and another at 

ome.  See About the Registered Version

If
for each of them. If you want to install 
additional copies. This applies even if 
h  for more information about the registered and 

 with 

unregistered versions.  
 
Your registration comes by e-mail 
 
When your order and payment have been received, you will get your registration key by e-
mail as soon as possible, with full instructions for entering it in the program. When you enter 
the key, your copy of the program becomes fully functional, registered to your name, and
no time limit. There is nothing else you need to download. 
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Please ensure you include a valid e-mail address with your order.  Experience shows tha
around 5 per cent of people give incorrect e-mail addresses or have mailboxes that are 
refusing mail, so please check yours carefully. If you are 

t 

in any doubt, test it by sending 
ourself a message.  

rders are normally processed within 24 hours of payment clearing, unless I am away on 
 

y
 
O
business or holiday. Any possible delays will be announced next to the Secure Ordering link
at http://www.concordancesoftware.co.uk/buynow.htm . 
 
Advantages of on-line ordering 
 
Try to order on-line using a credit/debit card if you can. It is much the quickest and easiest 

It 
 
by 

rd company will convert the payment into your own 
urrency, usually at a better exchange rate than a tourist would get.  If you are fully familiar 

te 
lter all 

esponsible for the exact price you pay, not for any charges 
k. 

our order, do not 
tly at 

way to get your registration, and (unless you have a U.K. bank account) probably cheapest.  
is secure and reliable.  Payments are handled by the biggest and most reputable specialist
on-line software ordering companies.  If you need further re-assurance, discuss it with me 
e-mail. You can also order multiple copies this way. 
 
Whatever your own currency, it still makes sense to pay on-line.  If your own currency is not 
offered by the online payment system, you can choose to pay in a different currency from 
your own and then your credit/debit ca
c
with exchange rates and charges, you can sometimes take advantage of a favourable ra
and get the software cheaper than usual! Please note that because exchange rates a
the time, I cannot predict or be r

ade by your card provider or banm
 
If you have any problems, questions, complaints, after placing y

ontact the on-line payment service. Send e-mail to me, the author, direcc
R.J.C.Watt@dundee.ac.uk
 
 
Ordering without a credit/debit card (for users in all countries) 
 
If you do not use a credit/debit card, you can pay by wire transfer, BACS transfer, 
heck/cheque, cash, or Paypal.  Purchase orders from recognised organisations are also 
ccepted. For all these options, you need to start the process online, even though you will 

c
a
complete the payment by other means. Go to the Buy Now page here 

ttp://www.concordancesoftware.co.uk/buynow.htmh  on the Concordance website and follow 

ou can print and complete the Postal Registration Form

the links to the secure payment services. 
 
 
Ordering without a credit/debit card by post (mail)  - for UK users only 
 
Do try to order on-line by credit/debit card if you can (see above for the advantages).  
Otherwise y  and send it by post 

heques must be in UK pounds sterling for the current price and drawn on a UK branch of a 

egistration Form

together with your payment.  You will receive your registration by e-mail as soon as your 
payment clears. The postal address is at the foot of the Postal Registration Form. 
 
C
UK bank.  
•  Remember to print and complete the Postal R  to accompany your postal 
ayment.  I need you to fill in that information so I can process your order. My postal address p

is on the form.  
 
If you order by post, your registration will still be sent by e-mail. Make sure you fill in a valid 
e-mail address on the postal registration form! 
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Orders from Institutions 
 
Please try to order on-line by credit/debit card and avoid using invoices, purchase orders, and 

ou will 
lly 

e supplied direct from me to you as end-user.  There are no 
 re-sellers or agents for Concordance. Any third party offering to sell 

d such licences will be invalid.  If your 
cal re-seller, you should begin by getting in touch with 

ostal Registration Form

such-like paperwork if you possibly can.  Many institutions are such slow payers that y
probably be unable to use the software for weeks until your payment arrives. If you rea
must order this way, please e-mail me. Try telling your finance people that I will add a 
handling charge to encourage your institution to use more modern methods. 
 
All valid licences ar
authorised
licences to you is acting without authorisation an
company policy obliges you to use a lo
me. 
 
See also:  
P  (not for credit card orders) 
Getting the Latest Version
Distribution
Licence Terms and Conditions
Multiple Copy Pricing
 

Multiple Copy Pricing 

 
Second and subsequent copies of the software are available at greatly reduced price. 

ou can buy popular numbers of multiple copies via the website at 
 
Y
http://www.concordancesoftware.co.uk/buynow.htm . Please look there to make sure you 
ave the latest information.  

ail me. 

red to the same name. 

es on 
ady 

dle the purchasing arrangements on 
ements. 

aneously, please e-mail me, 
ee.ac.uk

h
 
If the exact number of copies you want is not listed on the secure ordering server, e-m
 
Multiple copies purchased in one transaction must all be registe
 
Instructors at recognised educational establishments can arrange to purchase copi
behalf of their own students at reduced price, provided they themselves are alre
registered users of Concordance and are willing to han
behalf of their students. Please e-mail to make arrang
 
 you wish to buy more than twenty-five copies simultIf

R.J.C.Watt@dund    with your requirements. I can quote you prices for: 
ease specify how many  

ce (unlimited users) without expiry date  
•  A fixed number of users - pl
•  Site licen
•  Site licence (unlimited users) renewable annually. 
 
See also: 

bout the Registered Version
 

A
How to buy
Postal Registration Form (not for credit card orders) 
Getting the Latest Version
Distribution
Licence Terms and Conditions  
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Licence Terms and Conditions 

 
Concordance Copyright © 1999 - 2
 

009 R.J.C. Watt  All rights reserved. 

lease read this licence agreement. By installing and using the software you indicate your 

ou are granted a licence to use the unregistered version of ordance (the software) 
. You may evaluate the 

rposes or as part of an educational course in any way, 

rdances, or other 
aterials made with the unregistered version.  You may not make them accessible on a 

u may 
not permit others (for example, a class of students) to do so. 

o remind you to register, the unregistered version will add an 'Unregistered' notice to 

ther person.  

ly 

ubt, think of it as a book: it can be read by many people, but by only one 
 

puter, 

signed to others by any means. 

ware 

alid licences are supplied direct from me to you as end-user.  There are no 
uthorised re-sellers or agents for Concordance.  Any third party offering to sell 

licences to you is acting without authorisation and such licences will be invalid.  If your 

P
agreement to the following terms.   

Unregistered Version 
 
Y Conc
free of charge for personal evaluation and trial purposes only
software for a period of up to 30 days from the date of installation. After that period, you must 
register the software or remove it from your computer. 
 
The free trial is granted purely for you to evaluate the software. 
•  The unregistered version may not be used for work purposes of any kind, including 
teaching or demonstration pu
either as teacher or as student. 
•  You may not distribute, publish, or exhibit files, Web Conco
m
website or in any other way. 
•  You may not install or use multiple copies of the unregistered version, and yo

 
T
concordances when you export or print them. You may not remove these notices.  

Registered Version 
 
When you register you will be granted a user licence and given a registration code. You may 
enter this code in exactly one copy of the program, installed on a single computer. The 
registered software may not be copied nor distributed in any way, nor may the registration 
code be divulged to any o
 
All materials you create with the registered version of Concordance are your property entire
and you may do whatever you like with them, just as you could with documents you create 
using a word processor.  
 
More than one person is allowed to use the software, as long as no two people use it at the 
ame time. If in dos

person at a time.  If more than one person is to use the software at the same time, you need
to buy a copy for each person.  If you want to install the program on more than one com
you must buy additional copies. This applies even if you want to use one copy at work and 
another at home. 
 
When you buy a licence, you buy a right to use the software. The licence is non-
ransferable: it may not be sold, nor given away, nor ast

The software is protected by copyright and other intellectual property laws and by 
international treaties. Title, ownership rights, and intellectual property rights in the Soft
shall remain with R.J.C. Watt.  The software is the product of R.J.C. Watt solely and is not the 
product of nor endorsed by any organisation or institution. 
 

ll vA
a
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company policy obliges you to use a local re-seller, you should begin by getting in touch w
me. 

ith 

 
atically if you fail to comply with the conditions described 

ere. 

e 
e risk as 

are prove 
efective, you assume the cost of all necessary servicing, repair, or correction.  In no event 

his software has been written with great care but it is not warranted to be error free. You 

s the software is the product of one person, not a company, it is supported on a best-
ffort basis, i.e. as time permits, and purchasing the software does not confer a right to 

support. 
 
 

The licence will terminate autom
h

Disclaimer of Warranty 
 
This software is provided AS IS without warranty of any kind, either express or implied. Ther
is no warranty as to merchantable quality or fitness for a particular purpose. The entir
to the quality and performance of the program is with you.  Should the softw
d
shall I, the author, be liable for any  damages of any kind whether direct, indirect, or 
otherwise, arising out of the delivery, performance or use of this software. 
 
T
may not attempt to reverse compile, modify, translate or disassemble the software in whole or 
in part.  
 
A
e
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To print this form, press the Print button above. 
Registration Form (Only for orders by mail, without a Credit Card, from UK users) 

 
 
Name:         _________________________________________ 
 
Organisation: _________________________________________ 
 
Address:      _________________________________________ 
 
              _________________________________________ 
   
              _________________________________________ 
 
E-mail (essential for delivery):____________________________ 
 
 
Name to register Concordance to (Your name or your organisation's, as you wish it 
displayed by the program): 
 
         _________________________________________ 
 
Number of Registrations to purchase:
 
  Register ____ copy/copies of Concordance 
 
Price for first copy: £55(U.K. pounds sterling). Further copies: £25 each. (But check 
Concordance website for any recent changes, please) 
 
  Total cost: _______________ 
  
Payment method
 
  [  ]  Cheque in U.K. pounds sterling drawn on U.K. branch of U.K. 
bank. Payable to R.J.C. Watt 
  [  ]  Cash - U.K. pounds sterling (not recommended - please insure 
yourself against loss!) 
     
I understand the licence terms completely. I understand that I will receive my registration 
number via e-mail along with instructions to enter it in the program. I have checked that my 
e-mail address is entered correctly above. I agree that the software has to be treated like a 
book: only one person may use the software at a time. I agree that if several people will be 
using the software, I have to buy a licence for every one of them. I accept that improper 
payment will not be returned. 
 
Date: __________________     Signature: 
 
 
Post this form and your payment to: 
R.J.C. Watt 
Learmonth House 
Liff 
DUNDEE 
DD2 5NN 
Scotland, U.K. 
 
If you have any suggestions for improving the program, please write on the back of this form.  

 17



Concordance 3.3 manual  

Getting the latest version 

 
The latest information on Concordance, and the latest version, can be found on the 
Concordance website . 
 
See also: Installing, Upgrading, Moving, and Uninstalling.
 

Distribution to others 

 
The software is fully copyrighted and commercial and is not in the public domain nor 
freeware.   
 
The registered version  
 
The registered version of Concordance may not be distributed or copied in any way, nor may 
it be re-sold.  All valid licences are supplied direct from me to you as end-user.  There 
are no authorised re-sellers or agents for Concordance.  Any third party offering to sell 
licences to you is acting without authorisation and such licences will be invalid.  
 
The unregistered version  
 
The unregistered version of the program in its original archive may be distributed subject to 
the following limitations: 
•  You may not include the distribution archive on a CD-ROM without explicit permission in 
advance.  Such permission is usually granted, but is subject to negotiation. 
•  Distribution must be limited to the original distribution archive file.  You may not alter, 
delete or add any files in the distribution archive. You may not change the name of the 
archive: it must remain as it appears on the distribution website.   
•  You may not charge money for distributing the archive, beyond reasonable cost of shipping 
and packaging. 
 
Please check the Concordance website to make sure you have the latest version. 
 
CONCORDANCE COPYRIGHT © 1999 - 2009 R.J.C. WATT  ALL RIGHTS RESERVED  
 

Preparing text 
 
You can make a concordance to any plain text file, often called an ASCII file. If the file 
displays correctly in the File Viewer, it will probably be suitable. 
 
If your text is in a word processor, you can save it as a plain text file and use that to make the 
concordance from. (In Microsoft Word, save your file as 'Text Only with Line Breaks'. In Word 
2002, an option to save a file as text with line breaks does not appear when you choose 'Save 
as...''  Instead, you can choose to save as Plain Text; an additional dialog will then appear 
which allows you to select an option to 'insert line breaks'.)  
 
Alternatively, you can simply display your document in your word processor, select all the 
text, and copy it to the Clipboard, where Concordance will see it immediately. You can do the 
same with text in many other Windows programs including a web browser. Remeber that in 
most Windows programs, you can select all text immediately by pressing Control+A. You do 
not need to draq the mouse over the whole text! 
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For best results, make sure that each line is no longer than is comfortable for human beings 
to read: see Input Text File Format.  Don't split words across line-breaks - Concordance is 
happy to handle hyphenated words, but each part of the word must be on the same line. 
 
You can also make a concordance to the text in a HTML file - see the Ignore topic for an 
example.  For fuller technical details, including information about analysing SGML files, see 
Input Text File Format.  
 
If the text you want to work with seems to contain strange characters, see Character Sets.  
Concordance is not a Unicode program. Because it is written to work on all versions of 
Windows, it uses the ANSI (Windows) character set. Unicode files need conversion to plain 
(ANSI) text before they can be used. 
 
Before you make a concordance you should set options which relate to the features of your 
source text and the way you want it to be read.  These options are all on the Text menu: 
•  Alphabet  
•  References  
•  Context Styles  
•  Text to Read and Ignore
 
Once you have set these options, you are ready to make a concordance. Choose Make Full 
Concordance or Make Selective Concordance on the File menu. The concordance will be 
made and displayed. 
 
All the above options on the Text menu affect the way the source text is read while 
constructing the concordance. Consequently if you decide to make changes to any of these 
options, you need to re-make the concordance to see the effect of the changes. 
 
By contrast, items on other menus allow you to alter the concordance after it has been 
constructed and see the changes immediately. See Changing What's Displayed for some of 
them. 
 
Considerations when preparing text 
 
A common reason for difficulty when analysing e-text is that the text has been prepared using 
the same symbol or character with more than one meaning.  For example, if you use an 
apostrophe to denote a possessive (as in English father's), but also use it to denote a closing 
speech mark (as in He said 'Yes'), nothing you do in Concordance will be able to tell them 
apart. Another instance would be using a double hyphen to stand for a dash. 
 
The answer is to edit your text using characters in ways which are not ambiguous. 
 
Another important point to bear in mind when marking up text is this: later in your project, it is 
easy to ignore information you no longer need, but much harder to include information you 
forgot to add in the first place.   
 
 
 

 19



Concordance 3.3 manual  

 

Tutorial Files 

 
Several tutorial files are provided with Concordance. They are installed in the Sample Files 
folder, a sub-folder of the one where you chose to install Concordance. On computers that 
use English, this folder is probably C:\Program Files\Concordance. 
 
You are strongly recommended to look at these files and make concordances to them as a 
way of learning the essential features of the program. Most of them contain comments which 
explain how to set options on the Text Menu for best results. They are particularly helpful to 
learn how to use References, one of the most powerful aspects of the software. 
 
More advanced tutorial material, written by professional users of Concordance, is available 
on the web. Links are on the page on the Concordance website entitled Getting started with 
text analysis .  
 

Input Text File Format 
 
Concordance expects your input text to be in plain text files.  For fuller information on how to 
prepare a plain text file, see Preparing Text. 
 
Your files should be divided into lines of human-readable length.  

Line lengths 
 
The program imposes no limit on the length of a line, but in practice it works much better if 
line lengths are kept within limits convenient for humans to read - around 60 to 100 
characters.  
 
Many word processors treat each paragraph as a single long line so that they can wrap text to 
your margins. With a program such as Word you can overcome this by saving your file as 
"Text Only with Line Breaks". (In Word 2002, an option to save a file as text with line breaks 
does not appear when you choose 'Save as...''  Instead, you can choose to save as Plain 
Text; an additional dialog will then appear which allows you to select an option to 'insert line 
breaks'.)  
 
Some other common files, notably SGML files, mark line endings with their own notation 
instead of using a carriage return (CR) and/or line feed (LF) as used in plain text files.  (For 
more detail on line endings, see below.)  Such files, which lack CR/LF line endings, consist of 
a single 'line' as far as most programs are concerned, including this one.   
 
Although this program should still produce a correct concordance from a file with long lines, it 
will take longer than usual, and there will be other undesirable features.  
 
For example, contexts based on the actual line in which a word occurs are pretty useless if 
the whole input is on a single line: each word will have the entire text as its context, and the 
concordance will consequently be n times as long as the original, where n is the number of 
words in the original. This is to be avoided at all costs!  Another reason is that Concordance 
uses line numbers as the default reference system, and it isn't helpful if all words are 
referenced to the same line. 
 
If you make a concordance and find everything is referenced to line 1, you should check your 
input file to see whether it has CR+LFs. 
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The Context View in Concordance will not scroll to show contexts longer than 255 
characters, although any further text is still there and will be correctly preserved when you 
save, print, or export the concordance. 

File sizes 
Most counting functions in the program are limited to numbers no bigger than 2,147,483,647.  
 
The technical details below can be skipped unless you encounter problems - for 
example, if you find that everything in your concordance is referenced to line 1. 

Line endings 
 
The file should have line endings according to either the Windows/DOS convention or the 
Macintosh convention.  Both of these formats can be read directly by the program.  Unix files, 
however, should be converted first. 
 
Technically speaking, this means that line endings should be marked with a carriage-return 
and line-feed (CR+LF) pair, or with a carriage return alone, but not with a line feed alone.  
This table summarises the differences between systems: 

System Line ending  Conversion 
needed  

Windows/DOS CR+LF no 
Mac CR no 
Unix LF  yes 
 
In the ASCII and ANSI character sets, CR is no. 13 (hexadecimal 0D) or Ctrl+M, and LF is no. 
10 (hexadecimal 0A) or Ctrl+J. 
 
You can check which line-end characters a file uses by loading it into the File Viewer, then 
choosing Hex Mode on the Options Menu.  Carriage returns will be displayed as 0D and line 
feeds as 0A. 
 
Files produced on Unix systems can easily be converted to Windows files. A conversion 
program is provided on the Tools Menu. Some file transfer (FTP) programs can do the 
conversion automatically when fetching a file from a Unix to a DOS/Windows system, and 
some text editors can also do the conversion. 
 
If you choose multiple input files to make your concordance from, Concordance 
automatically concatenates them into a single new file before making the concordance.  If you 
prefer to do this yourself, use any text editor, including the Multiple Document Editor which 
comes with Concordance. The command-prompt (DOS) Copy command can also 
concatenate files.   
 

Alphabet 
 
The alphabet that Concordance uses is fully under your control. You can define the 
characters in your Alphabet using the edit box in the Alphabet Dialog on the Text Menu.  The 
Alphabet controls the way that Concordance recognises words: characters you choose to 
include in the Alphabet are seen as part of a word and all other characters are not.  
Alternatively, you can set Concordance to add automatically all the characters it finds in your 
texts to your Alphabet.  
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The Alphabet has no effect on sorting: see below for more on sorting. 
 
Getting the right alphabet is a powerful way of producing exactly the results you want, and a 
little trial and error is often needed. 
 

Edit Alphabet 
 
Use the Alphabet Editor to define which characters you want in your alphabet. 
 
Note that in Concordance Version 2.0.0 and later, the numerals 0..9 are included in the 
default alphabet. In earlier versions they were not part of the default alphabet and you had to 
add them if your text or your references contained numerals which you wanted to keep. 
 
You can copy and paste characters from the Character Set display in the Language and Font 
Control using the right mouse button or standard Windows keys. 
 

Characters not in Alphabet, when found in text: add or ignore? 
 
If you select 'Add to Alphabet' instead of 'Ignore', when Concordance reads your text and 
finds a character which is not in your Alphabet, the character will automatically be included in 
the Alphabet and hence will be treated as part of a word. If you select 'Ignore' instead, 
characters not in the Alphabet will be removed entirely from your concordance.  (They will be 
removed even if they occur inside reference markers.)   
 
Either way, Concordance will tell you which characters it is adding to the Alphabet or 
ignoring. This information appears in the Progress dialog as a concordance is being made. 
 
Choosing 'Add to Alphabet' may seem like an easy option - it means, for example, that you 
can start with an empty Alphabet and still have all words recognised. In practice it may create 
as many problems as it solves. If every undefined character is treated as part of a word, you 
tend to end up with a lot of words like "and/or" because the slash has been added to the 
alphabet.  
 
If you choose 'Add to Alphabet', then, you may need to make your concordance over again 
after expelling some unwanted characters added during the first attempt. If you choose 
'Ignore', you may have to do the opposite: add characters one at a time to the Alphabet which 
were reported as ignored. 
 
Tip: Avoid adding lots of characters to your alphabet that you don't really need for the text 
you are working with.  It's best to start with the simplest possible alphabet and add characters 
as required.  'Add to Alphabet' is a better option for new users; 'Ignore' for experienced users. 
 
Each concordance you make has its user-defined alphabet saved with it. Using the Options 
dialog, you can choose a setting so that reloading a concordance from disk will restore the 
alphabet which was in force when it was made.  This setting is off by default. 
 
You should open the Alphabet Editor from time to time and check what alphabet is currently in 
force, as it may not be what you expect. 
 
Tip: If you choose 'Add to Alphabet' and make a concordance, lots of characters you don't 
really want may be added to your Alphabet.  If your Alphabet is one you have worked 
carefully to refine, you might like to save it separately in case you need to revert to it later. 

 22



Concordance 3.3 manual  

Copy and paste all the characters from your Alphabet to a new file in the Multiple Document 
Editor and save the file. 
 

Sort Alphabet 
 
You can sort the characters in your alphabet at any time by pressing the Sort Alphabet 
button.  
 
Sorting here is for ease of reading only.  You cannot alter the order in which Concordance 
sorts words by moving letters around in your Alphabet.   All that counts in the Alphabet 
dialog is the presence or absence of characters, not their order. The order of the letters is 
defined by Windows, depending on the language you have chosen and the current character 
set.   
 
This sort is not case-sensitive: hence a lower-case letter may sometimes appear before its 
upper-case equivalent, and sometimes after.  This makes no difference. 
 
If you are trying to change the way Concordance sorts your finished concordance, see 
Sorting. 
 

Restore Defaults 
 
This button replaces the contents of the Alphabet Editor with the default alphabet. This is as 
follows: the letters a..z and A..Z, the hyphen, the apostrophe, and (starting in Version 2.0.0) 
the numerals 0..9. 
 

Languages 
 
This button opens the Language and Font Control which provides support for languages other 
than English. 
 

Word separators 
 
In the Alphabet Dialog you can also specify word separators. These are characters which will 
be treated as marking a division between words.  A space is always treated as a word 
separator. 
 
By using different combinations of alphabet and word separators you can gain extensive 
control over the way your source text is processed. 
 
Overlap between Alphabet, Word Separators, and Reference Markers 
 
If a character is in your Alphabet, it cannot also be a Word Separator or a Reference Marker.  
If you have any duplication of this kind, the program will warn you (repeatedly!), and will not 
make a concordance until you remove the duplication.  To alter Reference Markers, go to the 
References dialog. 

Handle split words as in Version 2.0.0 
 
This checkbox allows you to choose between two alternative behaviours for splitting words 
when non-word characters are encountered in the middle of a word.  The default  behaviour 
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matches that of Version 3.0; the alternative matches that of Version 2.0.0.  For full details see 
this topic. 
 

Translate OEM (DOS) Characters to ANSI (Windows) 
 
If your source text was prepared using an OEM character set, Concordance can 
automatically convert what it reads to the Windows (ANSI) character set as the source text is 
read. Try this option if characters such as accented characters and special symbols in your 
source text are being changed into unrelated characters in the concordance. You will still 
need to add the characters to your alphabet for them to be included in the concordance. 
Since translation of OEM to ANSI characters takes place before the removal of all characters 
not declared in your alphabet, you should add the translated, not the untranslated, characters 
to your alphabet. 
 
If this still doesn't give the results you want, your source text may contain some characters 
that bear no direct relation to the Windows characters you want, perhaps because the file was 
prepared on a different computer system. In that case you need to edit the source text!  And if 
translation gets confusing, give up and edit the source text instead. 
 
Bear in mind, too, that translating OEM characters to ANSI characters is done for the 
concordance, but your source text is not altered - Concordance never alters your source text 
unless you edit it yourself. So viewing the text in the File Viewer and File Editor will show 
untranslated characters.  If you want a permanently translated version of your source text, 
use the stand-alone tool OEM to ANSI File Converter
 
Definitions: 
 
An OEM character set is one specified by the code page currently in force on the computer. 
 
The Windows operating system in the US and most of Europe uses the ANSI character set.  
DOS uses the ASCII character set. 
 
Both ASCII and ANSI characters can be entered at the keyboard even if they do not have a 
dedicated key. To enter an ASCII character, hold down the Alt key and type the character's 
three-digit code on the numeric keypad (e.g. Alt+155).  To enter an ANSI character, use the 
same method but add a zero in front of the three-digit code (e.g. Alt+0248). 
 
Early versions of DOS were limited to a single version of the (extended) ASCII character set. 
With later versions of DOS, Microsoft and IBM introduced the concept of the code page. US 
ASCII, for example, is codepage 850. Code pages offer some support for different languages 
by assigning special characters to certain numeric values and keys. 
 
If you need to know more, see the very detailed reference information on character sets
 
 
See also: 
Preparing text
  Saving and restoring settings
Character table
Language and Font Control
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References 

 

What are references? 
 
In brief:  
•  Although you do not need to use References, they are one of the most powerful 
aspects of Concordance.  References are generated from mark-up you add to your text. 
They show you which section of your text each word comes from, or let you mark text 
as belonging to any category you define.   
•  References can accompany each line of context in a concordance, and might look 
like this: 
 
  Macbeth Act 1 Scene 1 First Witch 
 
Or like this: 
 
  Speaker: Alistair  Session: 20 August  Topic: Apoptosis 
•  You can also select text using references. For example, you could select all text by a 
particular speaker.  See below
•  Concordance automatically gives the line number as a reference for each 
occurrence of each word. If this is all you need, you don't have to define any 
references of your own. 
•  If you have multiple files and want to use the filenames as a reference, Concordance 
can add them automatically. See below. 
•  You can also add Page references for Microsoft Word files
 
 
Take a little time to learn how to use references, as they are one of the most powerful aspects 
of the software.  A good way to get started with references is to work through the sample files 
which were installed with the program. 
 
The References Dialog on the Text Menu lets you specify the way references are handled.  
You must also add the references you want to your source text. This can be as simple as 
adding <C Chapter 1> at the right point in your text. 
 
Uses of references 
 
A reference can be generated for each line of context in a concordance. It is often used to 
indicate the location of both the word and its illustrative context in the full source text.  A 
simple reference might show which section or chapter of a text each word comes from. 
References can also show any other information you want to include.  
 
In drama, for example, you might choose to have your concordance show which character is 
the speaker at any point, whether the speech is prose or verse, and which act and scene 
each word belongs to.  Or if you were analysing transcripts of interviews, you could add tags 
to show which material is relevant to Topic A, which to Topic B, and so on.  Several reference 
categories can be in force at any time, so a piece of text can be marked as relevant to several 
different topics. 
 
If you have many different texts or authors combined in your concordance, you can use 
references to distinguish among them. 
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When your concordance is made and displayed, the references will be displayed for each 
word in its context, and you can sort the contexts by the references you have used. 
 
If you don't want to use references of your own, you need not define any.  Concordance 
automatically keeps track of the line number in which each word occurred, and this provides a 
form of referencing which is adequate for simple projects. 
 

Reference Markers and Categories 
 
Reference markers are symbols which you use in your source text to enclose references. For 
example, 
<T Macbeth> 
<A Act 1> 
<S Scene 1> 
<C First Witch> 
Here < and > are the opening and closing reference markers. You can choose other markers 
if you wish.  Opening and closing reference markers must each be a single character, but 
need not be a 'matched pair', so you could choose { and # , for example. 
 
In the above example the letters T, A, S, and C denote reference categories which can be 
collected and printed. You can use any letters from A to Z. Concordance doesn't care which 
letters you use for what.  Only you have to remember what you're using them to stand for as 
you mark up the text.    
 
The example above would produce a reference like this: 
 
Macbeth Act 1 Scene 1 First Witch 
 
- assuming you told Concordance to collect all four reference categories T, A, S, and C.   
 
To take another example, if you later decide that you want only the act and scene references, 
you don't have to alter anything in your text: just make a new concordance, telling 
Concordance to collect only reference categories A and S.  That would produce a reference 
like this: 
Act 1 Scene 1 
 
A reference stays in force until you change it. So, at the start of Scene 2, you could add <S 
Scene 2> and all words from there on would have "Scene 2" as part of their reference, until 
another reference with the category <S > is found, such as <S Scene 3>. 
 
If you want to stop using a reference category before the end of a text, set it empty like this: 
<S > 
 

Preparing References 
 
When adding references to a source text, follow these rules: 
•  References can appear anywhere on a line.  
•  References can be changed as often as needed in the course of any line.  
•  References cannot occur inside a word.  
•  The reference opening marker should be immediately followed by the reference category 
letter, then a space, then the text of the reference.  
•  Each reference must end (close) on the same line it began on.  
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The program will try to warn you if the last of these rules is broken. If your text breaks the third 
or fourth rules, unpredictable results can occur. 

Collecting References 
 

In the References Dialog under 'References to collect'  you enter the letters from A to Z  
which your input text uses to identify reference categories and which you wish to collect when 
you next make a concordance. You can choose to collect some, all, or none of the references 
from the source text on any particular run. 

Order of display for references 

It does not matter in what order you enter the letters in the Reference dialog. When 
Concordance displays your references, it will use the order in which it first encountered 
reference categories in your text.  For instance, using the Macbeth example above, if you 
wanted references displayed with the character first, like this, 

   First Witch Macbeth Act 1 Scene 1  

you should make sure that the character reference is the first to appear in your text, like this: 

<C First Witch> 
<T Macbeth> 
<A Act 1> 
<S Scene 1> 
 

In cases where this does not make good sense, you can include empty references to get you 
started and achieve the required order.  An empty reference looks like this:  <C > 

Example: Numerals in references 

The program treats literally any text you place inside your reference markers (that is, to the 
right of the space after the reference category letter and before the closing reference marker). 
Numerals are treated no differently from any other text.  So, for example, if your text had two 
subsections, each with two paragraphs, you might want references like this: "1, 1",  "1, 2", "2, 
1", "2, 2". To achieve this, you could mark up your text as follows: 

<S 1,> 
<P 1> 
  text of first paragraph in section 1 
<P 2> 
  text of second paragraph in section 1 
 
<S 2,> 
<P 1> 
  text of first paragraph in section 2 
<P 2> 
  text of second paragraph in section 2 
 
Then tell Concordance to collect reference categories S and P.  Note that we can get a 
comma between section number and paragraph number by including it after the section 
number:  "<S 1,>" 

You must also make sure that any characters you want to use in your references (in this case, 
the numerals 0 to 9) are in Concordance's Alphabet. 

Example: Page references for indexes 
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A macro for Microsoft Word to insert Concordance-style page references automatically into a 
Word document is here. 

Displaying References 
 
References are displayed to the right of contexts.  The first example above would produce a 
reference like this: 
Macbeth Act 1 Scene 1 First Witch 
 
By choosing Show Reference Categories on the Contexts menu, you can choose to display 
them like this instead: 
<T Macbeth><A Act 1><S Scene 1><C First Witch> 
 
This is useful when you want to sort contexts by reference categories.  That sort method, 
however, still works even if reference categories are not being displayed. 
 
References and the Alphabet 
 
Remember that characters in your source text which are not in your user-defined alphabet will 
be removed entirely from your concordance if you have chosen to ignore them in the Alphabet 
dialog. This applies even if the characters occur inside reference markers. Make sure you add 
any special characters you need to your alphabet, or choose to have all characters not in the 
Alphabet automatically added. See the Alphabet dialog. 
 
 
Overlap between Alphabet, Word Separators, and Reference Markers 
 
If a character is in your Alphabet, it cannot also be a Word Separator or a Reference Marker.  
If you have any duplication of this kind, the program will warn you (repeatedly!), and will not 
make a concordance until you remove the duplication.  To alter the Alphabet or Word 
Separators, go to the Alphabet dialog. 

_____________________________________ 
 

Selecting text using references 
 
Once your have marked up your text with some references, they can be used not just for 
display in your concordance but also to select text when using Make Selective Concordance. 
 
The lower half of the References dialog lets you choose up to two reference categories and 
their values. The two can be combined with the usual boolean operators: 'and', 'or', 'xor', 'and 
not'. ('Xor'  -- exclusive or -- means 'either A or B but not both'.) 
 
For example, if your text was marked up with references like this: 
 
<T Macbeth> 
<A Act 1> 
<S Scene 1> 
<C First Witch> 
 
you could make a concordance which picks words only when the Act is 1 and the speaker is 
First Witch.  Or if your text had page numbers, you could select only the text where the page 
number was 2. 
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Example: selecting text by speaker 
 
Assume you want to select all text where the speaker is Mary, rejecting all text by other 
speakers. 
 
First you must mark up your text with references, so that a reference such as <S Mary> 
precedes each speech by Mary, and a reference such as <S Catherine> or <S Someone 
Else> precedes each speech not by Mary. 
 
Now open the Make Selective Concordance dialog.  Under Word Selection Method, select 
the radio button next to Reference, then press the adjacent Edit button. This opens the 
References dialog.  In the upper part of the dialog, ensure you have chosen < and > as the 
reference opening and closing markers, and include S as a reference category to collect.  In 
the lower part of the dialog, set the controls so as to "Select text when reference category S is 
the string Mary".  Then press OK to close the References dialog and press the Make 
Selective Concordance button. 
 
 
Filename References 
 
When you make a concordance to more than one file, you can choose to have Concordance 
automatically add a reference to show which file a word came from. The reference will be the 
name of the file. To make this happen, open the 'Make Concordance from Files' dialog (press 
F5) and tick Add filenames as refs.  Filename references are not automatically added if 
there is only one active file.  
 
Filename references are independent of, and additional to, the references you define in the 
References dialog on the Text menu. 
 
See also: 
Preparing text
Saving and restoring settings
Page references for Microsoft Word files
Make Selective Concordance
 

Page references for Microsoft Word files 

 
In Microsoft Word, you can use a macro (a sequence of recorded actions) to insert 
Concordance-style page references automatically into a Word document, then copy the 
whole document to the Clipboard and make a concordance from it.  This can be particularly 
useful if you want an Index. 
 
Here is how to do it in versions of Word from Word 97 to Word 2003. It has not been tested in 
Word 2007, but may well work without problems. 
 
In Word 97 to 2003, go to Tools -> Macro -> Macros.  (In Word 2007, go to Office Button -> 
Word Options -> Popular, tick "Show Developer tab in the Ribbon", and click OK. You can 
then use the Macros button.)  Type "ConcPageNums" (without the quotes) as the name of a 
new macro, then press the Create button. Microsoft Visual Basic should open with the macro 
editor.   
 
After the line which says "Macro created <today's date> by <your name>" and before the line 
"End Sub", insert the following lines by copying and pasting. 
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Dim count_ 
WordBasic.StartOfDocument 
count_ = 1 
WordBasic.EditBookmark "Temp", Add:=1 
WordBasic.InsertField Field:=" PAGE \# " + Chr(34) + "'<P '#'>'" 
+Chr(34) 
WordBasic.WW7_EditGoTo Destination:="+1" 
While WordBasic.CmpBookmarks("\Sel", "Temp") <> 0 
    WordBasic.EditBookmark "Temp", Add:=1 
    count_ = count_ + 1 
    WordBasic.InsertField Field:=" PAGE \# " + Chr(34) + "'<P '#'>'" 
+Chr(34) + "\*MERGEFORMAT" 
    WordBasic.RepeatFind 
Wend 
WordBasic.EditBookmark "Temp", Delete:=1 
WordBasic.MsgBox "Added page references to " + Str(count_) + " pages" 
 
 
Make sure that no long line has been split or wrapped onto two lines when you have pasted. 
For example, there should be only four lines of text in the indented section between While 
and Wend: the third of those lines is very long, ending with "\*MERGEFORMAT"     
 
Now you can go to a Word document, choose Tools -> Macro -> Macros, choose 
ConcPageNums, and press Run. This will add the page references. 
 
See your Word help for more on installing and using macros.  If any of this doesn't work, you 
should seek help from your local support person who specialises in Microsoft Office. Your 
copy of Word may be set up to disallow macros. As author of Concordance, I am not in a 
position to offer support for Word.   

______________________________________ 
 
 
Here is an older version of the macro for Word 6.0: 
 
Sub MAIN 
StartOfDocument 
count = 1 
EditBookmark "Temp", .Add 
InsertField .Field = " PAGE \# " + Chr$(34) + "'<P '#'>'" + Chr$(34) 
EditGoTo .Destination = "+1" 
While CmpBookmarks("\Sel", "Temp") <> 0 
EditBookmark "Temp", .Add 
count = count + 1 
  InsertField .Field = " PAGE \# " + Chr$(34) + "'<P '#'>'" +  
Chr$(34)   + " \* MERGEFORMAT" 
RepeatFind 
Wend 
EditBookmark "Temp", .Delete 
MsgBox "Added page references to " + Str$(count) + " pages" 
End Sub 

______________________________________ 
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Languages and character sets 

 
Concordance provides support for different Western languages and character sets, primarily 
those with the Latin alphabet. 
 
Some users have been able to get good results with non-Latin languages, including East 
Asian languages (on Western versions of Windows), but this is a bonus and I cannot 
guarantee it. See the Concordance website for information, including a link to help on using 
the software with East Asian languages. 
 
Support for non-Western languages depends to a large extent on which version of Windows 
you use, and is much superior in Windows 2000,  XP, and Vista. 
 
The primary tools to use are the Language and Font Control and the user-defined Alphabet.  
It is important to choose the correct settings for both of these. 
 
If your version of Windows has non-Western languages installed, these may appear in the 
Language and Font Control. That does not guarantee Concordance will work correctly with 
them.   
 
There is a Character Table which is useful for reference (it does not alter the program's 
behaviour.) 
 
In addition, for solving difficult problems, there is extensive reference information on 
Character Sets and related issues. 
 
 

Context Styles 

 
Context Styles are chosen before you make a concordance.  Several styles are available for 
the contexts which accompany each headword in a concordance. They can be set using the 
Context Styles dialog on the Text Menu. 
 
Don't confuse context styles with context views, the left-aligned and centred views in the right-
hand pane which can be altered as you look at the concordance. 
 
Available Styles 
•  The simplest style of context is the actual line in which the word occurs - that is, the 
physical line from the source text which contains a particular word.  This context style is 
particularly suited to lists, to verse, and to any text where each line contains a logically or 
syntactically complete unit. 
•  Contexts of selected length are more versatile.  You can choose separately the kind of 
context which comes before the occurrence of the headword and that which follows it. In 
either case these can be contexts delimited by sense-unit or contexts delimited by number 
of words. 
 
If you choose contexts which run from the start or to the end of a sense-unit, you can define 
the punctuation which the program will use in recognising those sense-units.   
 
If you choose contexts which run for a number of words before or after the headword, you can 
choose the number of words in each case. 
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The maximum length for contexts of selected length is 100 words before and after the 
headword. 
 
Bear in mind that choosing large contexts for each word will have a very big impact on the 
size of the finished concordance. A concordance with five words of context before and after 
the headword will be more than ten times the size of the original text. This is intrinsic to the 
nature of concordances: just look at a printed concordance - they are big books. One with 
twenty-five words of context before and after the headword will be more than fifty times the 
size of the original!  A ludicrous extreme occurs if you have all your text on one line (never 
recommended) and you then choose Actual Line as the context for each word: in this case 
every word in the text has effectively a copy of the entire text as its context.  If such a text had 
10,000 words, the concordance to it would contain 100,000,000 words!   
 
Tips: 
 
Speed: 
•  Concordances are made faster if you choose contexts which are the actual line, not a 
selected number of words, provided the lines in your text are fairly short, like a book. 
 
Size: 
•  If your concordance results in a huge concordance file, you need to limit the length of 
contexts. The best way to do this depends on whether your text has short lines (say, up to a 
dozen words per line, like a book) or longer ones.   If your text has short lines, choosing 
Actual Line for your context will be enough to ensure things don't get too big (this is also best 
for speed).  If your text has long lines, choose Selected Length for your contexts and limit the 
length to a few words before and after the headword. 
 
 
See also: 
Saving and restoring settings
Preparing text
 

Text to read and ignore 

 
Choose Ignore on the Text Menu if you wish to specify that only parts of your source text are 
to be read.   
 

Skip Markers 
 
Skip markers are symbols or characters or strings used in the input text which enclose text 
that you want to be ignored. If any skip markers are defined here, all text between them will 
be ignored when analysing the input files. You can define up to five different pairs of skip 
markers. If you define an opening skip marker, you must define its closing counterpart.  The 
maximum length of a skip marker is ten characters. 
 
You can use skip markers to add notes or comments to your source text which need not form 
part of the concordance. They are also useful for temporarily 'commenting out' parts of the 
text so that the concordance includes only a selection of the text.  This is easier than having 
to prepare a new version of the source text. 
 
Example: If your text contains this line: 
 
New Presbyter is but old Priest writ large {Trin. MS: writ at large} 
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and if you define the characters { and } as a pair of skip markers, then the comment at the 
end of the line enclosed in curly brackets will be ignored when making the concordance. 
 

Selecting by position on line 
 
You can also choose to have Concordance read text from selected positions (columns) on 
each line of the source text.  For example, if a source text has been prepared with line 
numbers in the left margin, you can skip them.   
 
If you want to start reading text from (say) column 3 and continue right to the end of the line, 
enter 3 for the start column and 0 (or any very large number) for the end column. 
 

Example: Making a concordance to an HTML file 
 
You can make a concordance to the text in an HTML file without having to convert it to plain 
text first. Just define the characters < and > as a pair of skip markers. The effect will be to 
skip all HTML markup in the file, leaving only the text, since HTML markup encloses tags like 
this: <tag> 
 
This removes only HTML markup.  You can also translate HTML special characters such as 
&eacute; (which is HTML for the letter e with an acute accent) into Windows characters: see 
Converting HTML entities. 
 
See also: 
Preparing text
Saving and restoring settings
 

Treat upper and lower case separately 

 
Headwords appear by default in upper case, since Concordance normalises words as they 
are read from your text.  So, for example,  'This', this', and 'THIS' will normally all be gathered 
together and counted as instances of the same word.  You can, however, change this 
behaviour. 
 
On the Text menu, choose Special, then Treat upper and lower case separately.  When 
you next make a concordance, no normalising will be done. Then, for example, 'This', this', 
and 'THIS' will all have separate entries in the Wordlist. 
 
If you combine this option with Show duplicate words separately and then sort the Wordlist by 
order of occurrence, you will get an exact list of the words in your text in the order they 
originally appeared. This can sometimes be useful. 
 
If you choose this option and also use the Pick List to make a Selective Concordance, the 
words picked from your text will be those which are a case-sensitive match with the words in 
the Pick List.   
 
You can also change the case of all words while the concordance is displayed.  See 
Changing case of words.  
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Analyse characters instead of words 

 
Almost everything in Concordance is based on analysing words.  You can, however, tell it to 
analyse letters (characters) instead of words.  To do this, go to the Text menu, choose 
Special, then choose Analyse characters instead of words. 
 
This causes the program to treat every letter as if it were a complete word in itself.  This 
effectively produces a frequency count of the characters in your text, like this: 
 
A 1440 
B 289 
C 407 
D 832 
E 2267 
 
and so on. 
 
Note that if you have also chosen Contexts of Selected Length   -- say 3 words of context 
before and after every headword -- then you will get 3 letters of context instead of  3 words.  
(Choosing actual-line contexts will still show the whole line of context.) 
 
Analysing letters instead of words is a special ability which breaks Concordance's 'rule' of 
being word-based, and you will find aspects of the program which do not make very good 
sense when you do so.  One or two are specifically disallowed: if you make a Selective 
Concordance which picks words using Regular Expressions or Phrases, the option to analyse 
characters instead of words is ignored. 
 
Warning: if you combine this option with Show duplicate words separately, you will get a 
separate entry in the Wordlist for every character in your text!  This will quickly produce so 
many entries that your patience will be exhausted and your computer's memory probably 
overwhelmed.  The program will warn you before you try to make a concordance which 
combines these options.  
 
 

Making Concordances 

 
After preparing your text, you are ready to make a concordance. 
 
You can make a Full Concordance or a Selective Concordance. A Full Concordance shows 
all the words from your text. A Selective Concordance shows you only the words you choose. 
 
Concordance has a huge variety of flexible options. Before you start on a large or important 
project, it is always a good idea to develop and test your settings by using very small files and 
checking that the results are what you would expect. Concoct such files for the purpose if 
necessary. 
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Make Full Concordance 

 
A Full Concordance is one which includes all words from the source text, except any you 
have specified in the Stop List. (Use of the Stop List is optional.) The whole text is read and 
words are selected and displayed in their contexts. 
 
You can make a Full Concordance  
•  from Files - using any plain text file (or files) that you choose;  or 
•  from the Clipboard - using the text in any other open Windows application which is able to 
copy plain text to the Clipboard. 
 
After making a Full Concordance, you can always remove words from the Wordlist using 
Select Words on the Headwords menu. If you know in advance which words you want to 
reject, use the Stop List.  If you know in advance which words you want to select, it is easier 
to make a Selective Concordance, which picks only your chosen words. 
 
If your source text is large, making a Full Concordance takes longer than making a Selective 
Concordance. However, once the full concordance has been made and displayed, it is 
quicker to browse around in it than to do repeated fast concordances with different selections 
of words each time. 
 
See also: Make Selective Concordance  
 

Stop List 
 
The Stop List allows you to list words which can be ignored (omitted) when you make a Full 
Concordance.  A Full Concordance includes every word found in your input files, unless you 
choose to use a Stop List, in which case it includes all words except those in the Stop List. 
 
A Stop List is often used to omit high-frequency words such as 'the', 'a', 'and' in English.  
Omitting just a few high-frequency words can greatly reduce the size of a finished 
concordance since they occur so often. The concordance will also be made faster. 
 
To prepare or edit a Stop List, choose Edit Stop List from the Text menu, or press Edit Stop 
List in the Make Full Concordance dialog. 
 
To use a Stop List, first make sure it contains the words you want, one word per line. Then on 
the File menu choose Make Full Concordance from Files or Make Full Concordance from 
Clipboard. Before you press the button to make your concordance, tick the Use Stop List 
box . 
 
A Stop List should consist of words, one per line. Words may include the pattern-matching 
symbols (wildcards)  ?, standing for any one letter, and * , standing for any number of any 
letters. This works identically to the Pick List.  See the help for the Pick List under 'Selecting 
words using patterns'.   
 
The Stop List Manager 
 
The Stop List Manager works identically to the Pick List Manager.  Again see its help topic. 
 
Stop List Files 
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When you first open the Stop List Manager, it opens a Stop List file called Stoplist.txt if 
that file exists in the same folder as the program itself. (It should do, because it was placed 
there by the installation.) Stoplist.txt is a short sample file.  You can create any number 
of your own Stop List files and they do not have to be called Stoplist.txt.  
 
Use the commands on the Stop List Manager's File menu to cereate new Stop List files or 
save a Stop List file under a different name. If you want a different Stop List file to be loaded 
automatically when you open the Stop List Manager, use Choose Stop List File on the 
Options menu and also tick the Auto-load Stop List File option. 
 
On a shared network installation, your system administrator should give you your own copy of 
Stoplist.txt.  
 

Make Selective Concordance 

 
A Selective Concordance is one where you specify how to pick words from the source text.  
The whole text is read and all instances of the words that match your selection criteria are 
selected and displayed in their contexts. All other words are rejected. 
 
You can make a Selective Concordance  
•  from Files - using any plain text file (or files) that you choose;  or 
•  from the Clipboard - using the text in any other open Windows application which is able to 
copy plain text to the Clipboard. 
 
If you do not know in advance which words you want to select, make a Full Concordance  
instead.  
 
If your source text is large, making a Selective Concordance is much quicker than making a 
Full Concordance because the program has to handle only the words you have picked. 
 

Selecting Words 
 
There are six different ways of selecting the words you want to keep in a Selective 
Concordance.  
 
Pick List  
Phrase searching
Proximity searching
Sampling
Regular Expressions (regex)
References
 
Choose among them using Word Selection Method in the Make Selective Concordance 
dialog. 
 
You can also select words (or reject words you don't want) after the concordance has been 
made by choosing Select Words on the Headwords menu.  
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Pick List (and Word List Managers) 

 
The Pick List and the Stop List use a similar Word List Manager. The Pick List allows you to 
list words which will be picked when you make a Selective Concordance.  A Selective 
Concordance picks only the words you list and omits all others.   
 
An empty Pick List would produce an empty concordance, and the program will warn you if 
the Pick List is empty. 
 
To prepare or edit a Pick List, choose Edit Pick List from the Text menu, or press the Edit 
button next to Pick List in the Make Selective Concordance dialog. 
 
To use a Pick List, first make sure it contains the words you want, one word per line.  Then on 
the File menu choose Make Selective Concordance from Files or Make Selective 
Concordance from Clipboard. In the Selective Concordance dialog, look at Word Selection 
Method and ensure Pick List is selected. 
 
A Pick List should consist of words, one per line. Words may include the pattern-matching 
symbols (wildcards)  ?, standing for any one letter, and * , standing for any number of any 
letters. See below under 'Selecting words using patterns'.   
 
If you choose the option Treat Upper and Lower Case Separately (on the Text menu under 
Special) and then use the Pick List to make a Selective Concordance, the words picked from 
your text will be those which are a case-sensitive match with the words in the Pick List.  In this 
case, if you wanted to pick both 'a' and 'A', they would need separate enties in the Pick List. 
 
 
The Word List Managers 
 
The Pick List Manager and the Stop List Manager work identically. 
 
The Pick and Stop List Managers are text editors. As from Version 3.0 of Concordance there 
is no limit to the number of words they can contain, even on Windows 95/98/ME. 
 
As well as adding words yourself or reading words in from a file, you can use their special 
abilities to   
•  Format one word per line  
•  Re-sort the list of words, keeping duplicates  
•  Re-sort the list of words, removing duplicates 
 
When you press 'Re-sort, keeping duplicates', a window will open showing all the duplicate 
words found.  
 
The option to remove duplicates works regardless of their case - so 'This', 'this', and 'THIS' 
will be recognised as duplicates. 
 
Menu Commands 
 
Most commands on the menus are self-explanatory file and edit commands.  One or two need 
explanation: 
 
File menu: Append words from file lets you read any text file on disk and splits it up into 
one word per line.   
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View menu: Left, Right, Centre:  You can detect any leading or trailing spaces by switching 
from left to right alignment and vice-versa.  Don't ask what the use of Centre is. It's there 
because it's there. 
 
Options menu: User-defined Alphabet: Lets you choose whether to use the Alphabet 
defined in the Alphabet dialog when reading in a file and splitting words one per line.  If this 
option is on, all characters not in your chosen Alphabet will be removed entirely from words.  
This is useful for removing punctuation and other symbols from text, leaving only words.  If 
this option is off, the default alphabet (a..z, A..Z, 0..9, plus hyphen and apostrophe) is used.  
Note that the Pick and Stop Lists do not make any use of the definable word separators in the 
Alphabet dialog, only its characters. 
 
The Edit Alphabet button - if you have chosen User-defined Alphabet on the Options menu, 
you may wish to alter the Alphabet. This button simply opens the Alphabet dialog, normally 
accessible from the Text menu.   
 
 
Advanced use 
 
The Pick and Stop List Managers can be used as a miniature text analysis program on their 
own.  By reading a file of continuous text, splitting it into one word per line, and sorting it with 
duplicates removed, they can create a sorted list of the unique words in a text.  This list can 
be saved to a file if wanted. 
 

Selecting words using patterns 
 
In the Pick List you can use pattern-matching symbols (wildcards) ?, standing for any one 
letter, and *, standing for any number of any letters.   
 
You can combine these to produce powerful selection criteria: 
 

To do this:  Type 
this:  

Select all words of a certain length, e.g. words 
of 4 characters: ???? 

Select all words greater than a certain length, 
e.g. words of 4 characters and over ????*  

Select words beginning with a prefix, e.g. 
words beginning with 'un-'  un* 

Select words ending with a suffix, e.g. words 
ending in '-ing' *ing 

Select words which begin with 'un' and end 
with 'ing' un*ing 

Select all words which contain the letter 'e' *e*  
Select all words  

(this matches any word and so would produce 
the same result as a Full Concordance, but 
more slowly!) 

* 
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Pick List Files 
 
When you first open the Pick List Manager, it opens a Pick List file called Picklist.txt if 
that file exists in the same folder as the program itself. (It should do, because it was placed 
there by the installation.) Picklist.txt is a short sample file.  You can create any number 
of your own Pick List files and they do not have to be called Picklist.txt.  
 
Use the commands on the Pick List Manager's File menu to create new Pick List files or save 
a Pick List file under a different name.  If you want a different Pick List file to be loaded 
automatically when you open the Pick List Manager, use Choose Pick List File on the 
Options menu and also tick the Auto-load Pick List File option. 
 
On a shared network installation, your system administrator should give you your own copy of 
Picklist.txt. 
 
See also:  Make Selective Concordance  
 

Proximity searching 

 
A Proximity search lets you make a Selective Concordance which keeps words only if they 
are found within a certain distance of other words. 
 
To enter words for a proximity search, go to the Text menu and choose Configure Proximity 
search, or open the Make Selective Concordance dialog and press the Edit button next to 
Proximity. 
 
To make your concordance, open the Make Selective Concordance dialog if it is not already 
open (go to the File menu and choose Make Selective Concordance from Files or Make 
Selective Concordance from Clipboard.)  In the Selective Concordance dialog, look at 
Word Selection Method and ensure Proximity is selected. Then press the Make Selective 
Concordance button. 
 
You can specify up to five words to keep. For each, you must specify a number for the 
distance (for example, "within 3 words of"), and the other word which has to be present within 
that distance. 
 
The maximum distance you can specify is 20 words. 
 
Words may include the pattern-matching symbols (wildcards)  ?, standing for any one letter, 
and * , standing for any number of any letters. 
 
It is the first word of each pair, not the second, which will be kept.  However, it will be kept if 
the second word occurs within the specified distance either before or after it. 
 
An example:   
 
Say you choose to keep the word FRUIT within 5 words of TREE.   
 
If your input text contains 'the fruit of that forbidden tree', that occurrence of 
FRUIT will be kept. And if your input text also contains 'the tree is known by his 
fruit', that occurrence of FRUIT will also be kept, as it too is within 5 words of an 
occurrence of TREE (reading backwards). 
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But the two occurrences of TREE will not be kept because it is the second word in the pair.  If 
you want them to be kept, you must specify TREE within 5 words of FRUIT as well as FRUIT 
within 5 words of TREE. 
 
Hint: 
 
If Text -> Special -> Treat upper and lower case separately is selected, the words you 
enter in the Proximity search will be treated case-sensitively. 
  
See also:   
Phrase searching
Make Selective Concordance  
 
 

Phrase searching 

 
A Phrase search lets you make a Selective Concordance which keeps all instances of the 
phrases you specify, rejecting all other words. 
 
To enter phrases, go to the Text menu and choose Configure Phrase search, or open the 
Make Selective Concordance dialog and press the Edit button next to Phrases. 
 
To make your concordance, open the Make Selective Concordance dialog if it is not already 
open (go to the File menu and choose Make Selective Concordance from Files or Make 
Selective Concordance from Clipboard.)  In the Selective Concordance dialog, look at 
Word Selection Method and ensure Phrases is selected.  Then press the Make Selective 
Concordance button. 
 
You can enter up to six phrases (see below if you need more). Each phrase must be more 
than one word and can be up to five words long.  There is a separate edit box for each of the 
five words: don't enter more than one word in any individual edit box.   
 
If you enter a 'phrase' which is only one word long, it will be ignored. (To search for any 
number of single words, use the Pick List.)  A phrase where the first (leftmost) edit box is 
empty will also be ignored. 
 
Words may include the pattern-matching symbols (wildcards)  ?, standing for any one letter, 
and * , standing for any number of any letters. 
 
Phrase searching provides some of the functionality of regular expressions. Phrase searching 
is less powerful but easier to use. 
 
Example: 
 
If you make a Selective Concordance to the installed sample file Demo4.txt, selecting 
phrases, having defined the phrase  
 
the m* * 
 
the results will show the following phrases in their contexts: 
  
the Mathematicks, useful 
the Manners and 
the Mercy of 
the meantime, I 
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plus five more such phrases.   
 
(This example assumes that Text -> Special -> Treat upper and lower case separately is 
not selected.  If it is, you will see a different selection of phrases.) 
 
Hints and Tips 
•  When you make a concordance to phrases which include wildcards, the Headword display 
shows the pattern (including wildcards), and the actual phrase matched is shown in the 
Context View.  
•  It is best to choose the Centred Context View when working with phrases. 
•  If a phrase occurs split between two lines in your source text, it will not appear in full in the 
Context View if you have chosen the Context Style 'Actual Line'.  In this case you may wish to 
choose the Context Style 'Selected Length' instead. 
•  When using phrases, the option to analyse characters instead of words (Text -> Special) 
is ignored. 
•  If you define a phrase which contains the same elements as another defined phrase, then 
the order in which they are declared will affect the results.  For example, using the sample file 
Demo4.txt, try defining the two phrases 
 
the m* * 
the * of * 
 
The file happens to contain the expression 'the Mercy of the Waves'.  Here, the first pattern 
would match 'The Mercy of' and the second pattern would match 'The Mercy of the'.  The 
expression in the text will be matched only once, and will appear under whichever pattern is 
declared first in the Phrases dialog.  It follows that if you need accurate counts of phrases, 
you should declare phrases which do not 'overlap'. 
•  How to search for more than six phrases at once 
 
Concordance is limited to searching for six phrases at a time. However, a work-around is to 
use a text editor to alter your text, doing a search and replace to turn all occurrences of each 
phrase into a long compound "word". So for example the phrase "evidentiary due process" 
would become "evidentiary_due_process".  Then put your "words" into the Pick List and make 
a Selective Concordance using the Pick List. (This works because the Pick List can handle 
any number of words at once, but each must be a single word.) 
 
 
See also:   
Proximity searching
Make Selective Concordance  
 
 

Word Sampling 

 
Word sampling allows you to make a Selective Concordance which keeps only a sample of 
words from your text. 
 
To specify how to sample, go to the Text menu and choose Configure Sampling, or open 
the Make Selective Concordance dialog and press the Edit button next to Samples. 
 
To make your concordance, open the Make Selective Concordance dialog if it is not already 
open (go to the File menu and choose Make Selective Concordance from Files or Make 
Selective Concordance from Clipboard.)  In the Selective Concordance dialog, look at 
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Word Selection Method and ensure Samples is selected.  Then press the Make Selective 
Concordance button. 
 
You may sample words consecutively or randomly: 
•  If you choose to sample consecutively, specify the number of the first word to start the 
sample at, and the number of words to pick. 
•  If you choose to sample randomly, choose the number of words to pick. They will be picked 
at random from the whole of your text. 
 
If you tick 'Pseudo-random', the same sequence of 'random' numbers will be used each time 
(until you re-start the program) to decide which words to pick.  This can be useful if you want 
repeatable results.  
 
If you un-tick 'Pseudo-random', a different sequence of random numbers will be used each 
time. 
 
See also:  Make Selective Concordance  
 
 

Regular Expressions 

 
 Regular expressions are a very powerful way of matching patterns in text.  They are also 
quite hard to understand at first. 
 
You can use regular expressions as a way of picking words for a Selective Concordance. To 
enter a regular expression, go to the Text menu and choose Configure Regular expression 
search, or open the Make Selective Concordance dialog and press the Edit button next to 
Regex. 
 
To make your concordance, open the Make Selective Concordance dialog if it is not already 
open (go to the File menu and choose Make Selective Concordance from Files or Make 
Selective Concordance from Clipboard.)  In the Selective Concordance dialog, look at 
Word Selection Method and ensure Regex is selected.  Then press the Make Selective 
Concordance button. 
 
This is a long help topic. You might prefer to start with the examples here, just after the 
Introduction. 

___________________________________________________ 

Introduction 
 
Regular expressions are a widely-used method of specifying patterns of text to search for. 
Special metacharacters allow you to specify, for instance, that a particular string you are 
looking for occurs at the beginning or end of a line, or contains n recurrences of a certain 
character. 
 
To enter a Regular Expression, go to the Text menu and choose Configure Regular 
Expression search, or open the Make Selective Concordance dialog and press the Edit 
button next to Regex. 
 
Concordance allows you to choose whether to match your regular expression against single 
words which have already been identified by the program, or (more normally) against whole 
lines of input.  
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When Concordance displays the results of a regular expression search, the entire matched 
expression appears as a 'headword'.   
 
When Concordance displays the results of a regular expression search matched against 
lines, the displayed contexts are the actual line even if you have chosen contexts of variable 
length (for more on these, see Context Styles). 
 
When using regular expressions, the option to analyse characters instead of words (Text -> 
Special) is ignored. 

___________________________________________________ 
 
Some simple examples 
 
These examples, except where indicated otherwise, assume you have chosen to match 
against lines, not words. 
 
Example: 
 
[A-Z][a-z]+  matches words beginning with a capital letter. 
 
So, if you define the regular expression 
 
   the [A-Z][a-z]+ of [A-Z][a-z]+ 
 
and make a Selective Concordance to the installed sample file Demo4.txt, you will get 
these results: 
 
the Carriage of Trees 
the Country of Lilliput 
the Demands of Nature 
the Help of Ladders 
the Hogsheads of Wine 
the Laws of Hospitality 
the Promise of Honour 
 
- which, you may agree, is rather pleasing.   
 
(Note that this result could also have been achieved using a Phrase search.) 
 
More simple examples: 
 
[a-zA-Z]+ matches words of any length containing only lower- and upper-case alphabetic 
(English) letters. 
  
[a-zA-Z]+$ matches the final word in lines which have no punctuation at the end.  (If you 
are analysing verse, these would be possible enjambed lines.) 
 
[a-zA-Z\s]+ matches any number of words bounded by punctuation or a line end. 

___________________________________________________ 
 
Regular Expressions: the full story 
 
1. Simple matches 
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Any single character matches itself, unless it is a metacharacter with a special meaning 
described below. 
 
A series of characters matches that series of characters in the target string, so the pattern 
"bluh" would match "bluh'' in the target string.  
 
You can cause characters that normally function as metacharacters or escape sequences 
to be interpreted literally by 'escaping' them, that is, preceding them with a backslash "\".  For 
instance, metacharacter "^" matches beginning of string, but "\^" matches character "^", "\\" 
matches "\" and so on. 
 
Examples: 
  foobar          matches string 'foobar' 
  \^FooBarPtr     matches '^FooBarPtr' 
 
2. Character classes 
 
You can specify a character class, by enclosing a list of characters in [], which will match any 
one character from the list. 
 
If the first character after the "['' is "^'', the class matches any character not in the list. 
 
Examples: 
  foob[aeiou]r   finds strings 'foobar', 'foober' etc. but not 'foobbr', 'foobcr' etc. 
  foob[^aeiou]r  find strings 'foobbr', 'foobcr' etc. but not 'foobar', 'foober' etc. 
 
Within a list, the "-'' character is used to specify a range, so that a-z represents all characters 
between "a'' and "z'', inclusive.  
 
If you want "-'' itself to be a member of a class, put it at the start or end of the list, or escape it 
with a backslash. If you want ']' you may place it at the start of list or escape it with a 
backslash. 
 
Examples: 
[-az]      matches 'a', 'z' and '-' 
[az-]      matches 'a', 'z' and '-' 
[a\-z]     matches 'a', 'z' and '-' 
[a-z]      matches all twenty-six lower-case English characters from 'a' to 'z' 
[a-zàáèé]        matches the 26 English characters, as above, plus the four accented 
characters shown 
[\d-t]     matches any digit, '-' or 't'.  
[]-a]      matches any character from ']'..'a'. 
 
3.  Metacharacters 
 
Metacharacters are special characters which are the essence of Regular Expressions. There 
are different types of metacharacters, described below. 
 
Metacharacters - line separators 
 
  ^      start of line 
  $      end of line 
  .      any character in line 
 
Examples: 
  ^foobar     matches string 'foobar' only if it's at the beginning of line 
  foobar$     matches string 'foobar' only if it's at the end of line 
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  ^foobar$    matches string 'foobar' only if it's the only string in line 
  foob.r      matches strings like 'foobar', 'foobbr', 'foob1r' and so on 
 
Metacharacters - predefined classes 
 
  \w     an alphanumeric character (including "_") 
  \W     a non-alphanumeric 
  \d     a numeric character 
  \D     a non-numeric 
  \s     any space  
  \S     a non-space 
 
You may use \w, \d and \s within custom character classes. 
 
Note that the ability to search for a space is quite alien to what Concordance does in all other 
modes. With regular expressions, you can have spaces in headwords, or even spaces as 
'headwords'. 
 
Examples: 
  foob\dr matches strings like 'foob1r', ''foob6r' and so on but not 'foobar', 'foobbr' and so 
on 
  foob[\w\s]r matches strings like 'foobar', 'foob r', 'foobbr' and so on but not 'foob1r', 
'foob=r' and so on 
 
Metacharacters - iterators 
 
Any item of a regular expression may be followed by another type of metacharacter - an 
iterator. Using these metacharacters you can specify the number of occurences of the 
previous character, metacharacter or subexpression. 
 
  * zero or more ("greedy"), similar to {0,} 
  + one or more ("greedy"), similar to {1,} 
  ? zero or one ("greedy"), similar to {0,1} 
  {n} exactly n times ("greedy") 
  {n,} at least n times ("greedy") 
  {n,m} at least n but not more than m times ("greedy") 
  *? zero or more ("non-greedy"), similar to {0,}? 
  +? one or more ("non-greedy"), similar to {1,}? 
  ?? zero or one ("non-greedy"), similar to {0,1}? 
  {n}? exactly n times ("non-greedy") 
  {n,}? at least n times ("non-greedy") 
  {n,m}? at least n but not more than m times ("non-greedy") 
 
Digits in curly brackets of the form {n,m}, specify the minimum number of times to match the 
item n and the maximum m. The form {n} is equivalent to {n,n} and matches exactly n times. 
The form {n,} matches n or more times. There is no limit to the size of n or m, but large 
numbers will chew up more memory and slow down execution. 
 
If a curly bracket occurs in any other context, it is treated as a regular character. 
 
"Greedy" operators take as many as possible, "non-greedy" take as few as possible. For 
example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', 'b+?' returns 'b', 'b*?' returns an 
empty string, 'b{2,3}?' returns 'bb', 'b{2,3}' returns 'bbb'. 
 
 
Examples: 
foob.*r     matches strings like 'foobar',  'foobalkjdflkj9r' and 'foobr' 
foob.+r     matches strings like 'foobar', 'foobalkjdflkj9r' but not 'foobr' 
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foob.?r     matches strings like 'foobar', 'foobbr' and 'foobr' but not 'foobalkj9r' 
fooba{2}r   matches the string 'foobaar' 
fooba{2,}r  matches strings like 'foobaar', 'foobaaar', 'foobaaaar' etc. 
fooba{2,3}r matches strings like 'foobaar', or 'foobaaar'  but not 'foobaaaar' 
 
 
Metacharacters - alternatives 
 
You can specify a series of alternatives for a pattern using "|'' to separate them, so that 
fee|fie|foe will match any of "fee'', "fie'', or "foe'' in the target string (as would f(e|i|o)e). The 
first alternative includes everything from the last pattern delimiter ("('', "['', or the beginning of 
the pattern) up to the first "|'', and the last alternative contains everything from the last "|'' to 
the next pattern delimiter. For this reason, it's common practice to include alternatives in 
parentheses, to minimize confusion about where they start and end. 
 
Alternatives are tried from left to right, so the first alternative found for which the entire 
expression matches, is the one that is chosen. This means that alternatives are not 
necessarily greedy. For example: when matching foo|foot against "barefoot'', only the "foo'' 
part will match, as that is the first alternative tried, and it successfully matches the target 
string. (This might not seem important, but it is important when you are capturing matched 
text using parentheses.) 
 
Also remember that "|'' is interpreted as a literal within square brackets, so if you write 
[fee|fie|foe] you're really only matching [feio|]. 
 
Examples: 
  foo(bar|foo)  matches strings 'foobar' or 'foofoo'. 
 
Metacharacters - subexpressions 
 
The bracketing construct ( ... ) may be used to define subexpressions. 
 
Subexpressions are numbered based on the left to right order of their opening parenthesis. 
The first subexpression is numbered '1'. 
 
Examples: 
(foobar){8,10}   matches strings which contain 8, 9 or 10 instances of 'foobar' 
foob([0-9]|a+)r  matches 'foob0r', 'foob1r' , 'foobar', 'foobaar', 'foobaar' etc. 
 
Metacharacters - back-references 
 
Metacharacters \1 through \9 are interpreted as back-references. \<n> matches the 
previously-matched subexpression #<n>. 
 
Examples: 
(.)\1+ matches 'aaaa' and 'cc'.  
(.+)\1+ also matches 'abab' and '123123' 
(['"]?)(\d+)\1 matches '"13" (in double quotes), or '4' (in single quotes) or 77 (without 
quotes) etc 
 
 
 
4. Escape sequences 
 
Characters may be specified using an escape sequence syntax:  \xnn  where nn is a 
string of hexadecimal digits. 
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  \xnn       matches the character with the ANSI value nn.  
 
Example: 
  foo\x20bar   matches 'foo bar' (note space in the middle) 
 

___________________________________________________ 
 
Credits for Regular Expressions: 
 
Delphi implementation of regular expressions by Andrey V. Sorokin, St. Petersburg, Russia, 
http://anso.da.ru.  Additional examples and documentation by Kit Eason.  Based on C source 
written by Henry Spencer, University of Toronto, 1986, and donated to the public domain. 
 
See also:  Make Selective Concordance  
 
 

Make Concordances from Clipboard  
 
You can make an instant concordance of any documents you have open in other Windows 
programs, such as Word, Internet Explorer, Netscape, Acrobat Reader, Access, Excel, 
WordPad, Notepad, some SGML viewers, and many other programs - in fact, any program 
which knows how to place text on the Windows Clipboard.  You do not have to worry about 
converting from different file formats: that is done automatically. You can also accumulate text 
from any number of different Windows programs before you make your concordance. 
 
First select the text you want in the other Windows program. (Remember that in many 
Windows programs pressing Control-A is a quick way to select all text.)  Now copy it to the 
Clipboard (Control-C usually does this). Now, on Concordance's File menu, choose either 
Make Full Concordance or Make Selective Concordance. Then choose From Clipboard.  If 
there is no text currently on the Windows Clipboard, the option will be greyed out (not 
available). 
 
When you choose From Clipboard, the Make Concordance from Clipboard dialog opens.  
You will see all the text which Concordance has captured from the Clipboard.  You can copy 
further text from other programs and it will all be captured. Unlike the Windows Clipboard, 
Concordance's Clipboard Capture can hold more than one clip at a time. 
 
When you are ready, press the Make Selective Concordance or Make Full Concordance 
button. 
 
If your text is already saved in a plain text file, you can make a concordance from files instead 
of from the Clipboard. 
 
Clipboard Capture  
 
Concordance's Clipboard Capture window is actually a full text editor, so you can alter 
captured text before making a concordance. The editor can find and replace, undo, and save 
text to a file.  (You don't need to save text just to make a concordance. The ability to do so 
makes Concordance a general-purpose tool for working with text on the Windows Clipboard. 
You can gather text from numerous different programs and save it.)  
 
Clipboard Control 
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Clipboard Control lets you tell Concordance to stop watching the Clipboard (so text you copy 
while in other programs will not be captured). It also lets you choose whether new clips will be 
added to what is already captured or will overwrite it.   
 
Clipboard Control: Clip References 
 
When you make a concordance to more than one clip, you can choose to have Concordance 
automatically add references to show which clip a word came from. References will be in the 
form Clip1, Clip2, etc. To make this happen, tick Add for each clip. 
 
You can if you wish add further references manually.  For more information, see 'Combining 
Filename References with normal References' in Make Concordances from Files. 
 
If you specify a reference letter here, it will be added to the set of references to collect in the 
References dialog.  If you don't, it will be set to F (which suggests File) and will again be 
added to the set of references to collect. 
 
Concordance Control: Stop List and Pick List 
 
If you are making a Full Concordance, you can edit the Stop List by pressing Edit Stop List, 
and choose whether to use the Stop List for any concordance by ticking or unticking Use 
Stop List. 
 
If you are making a Selective Concordance, you can edit the Pick List by pressing Edit Pick 
List.   
  
About Files from the Clipboard 
 
Concordance automatically saves text from the Clipboard Capture into a file before it makes 
your concordance. As text from the Windows Clipboard does not have a filename of its own, 
Concordance creates one for you. The first time you make a concordance from the 
Clipboard, the file will be called TextFromClipboard-File1.Txt, and the corresponding 
concordance file will be TextFromClipboard-File1.Txt.Concordance.  You can use 
Rename on the File menu to change these names later if you like. 
 
Using the Preferences dialog on the Tools menu, you can control where these files are 
created.  
 
 
 

Make Concordances from Files 

 
You can make a Full Concordance or a Selective Concordance from plain text in one or more 
files.  If your text is currently displayed in another Windows program such as Word or Internet 
Explorer, you can make a concordance from the Clipboard instead. 
 
On Concordance's File menu, choose either Make Full Concordance or Make Selective 
Concordance. Then choose From Files.  The Make Concordance From Files dialog opens.  
In this dialog you build a list of one or more files that you want to make your concordance 
from. 
 
Making a List of Files to Read 
 
Press the Add Files button and use the resulting dialog to pick one or more files and add 
them to the File List. Files can be chosen from anywhere on your computer or its network 
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neighbourhood.  Once they are in the File List, you can re-arrange them by drag and drop. 
When the concordance is made, the files will be read in the order you have arranged them. 
You can click on a filename in the File List to see a preview of the first few lines of the file.    
 
Also see below: 'How many files can I use?' 
 
Making the concordance 
 
When you have the files you want, press the Make Full Concordance or Make Selective 
Concordance button.  
 
Including and excluding files from a concordance 
 
At the left of each filename is a tick box.  If you remove the tick, that file will not be included in 
a concordance. This lets you exclude files without having to remove them from the list.  Files 
which are ticked are called active files. 
 
Saving the file list 
 
Your file list is saved automatically when you make a concordance and when you close the 
Make Concordance from Files dialog. You can save it at any time by pressing the Save file 
list button.  This also lets you save different file lists under different names, which is useful for 
changing among different projects. 
 
Other buttons 
 
There are also buttons at the top of the dialog to remove a file from the current file list, to clear 
the file list, and to load any saved file list. 
 
Files which no longer exist will be removed from a file list when the list is loaded. 
 
Filename References 
 
When you make a concordance to more than one file, you can choose to have Concordance 
automatically add a reference to show which file a word came from. The reference will be the 
name of the file. To make this happen, tick Add filenames as refs.  Filename references are 
not automatically added if there is only one active file.  
 
Filename references are independent of, and additional to, the references you define in the 
References dialog on the Text menu. 
 
Combining Filename References with normal References 
 
Filename references are additional to the references you define in the References dialog on 
the Text menu, which remains the main way of controlling references. 
 
If you have already defined reference opening and closing markers in the References dialog, 
they will be used for filename references; if not, the standard reference opening and closing 
markers < and > will be used (and they will be set in the References dialog for you). 
 
If you specify a reference letter here, it will be added to the set of references to collect in the 
References dialog.  If you don't, it will be set to F (which suggests File) and will again be 
added to the set of references to collect. 
Stop List and Pick List 
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If you are making a Full Concordance, you can edit the Stop List by pressing Edit Stop List, 
and choose whether to use the Stop List for any concordance by ticking or unticking Use 
Stop List. 
 
If you are making a Selective Concordance, you can edit the Pick List by pressing Edit Pick 
List.   
 
How files are named 
 
If you have more than one file in your File List, Concordance copies them into a new single 
file before it makes your concordance. The new file is named after the first active file in your 
list of files to read. For example, if your first file was called Demo1.txt and there were 3 
further files to read, they would all be joined into a new file called 
Demo1.txtPlus3MoreFiles.txt. The corresponding concordance file would be called 
Demo1.txtPlus3MoreFiles.txt.Concordance.  Both files are placed in the same folder 
as the first active file in your list of files to read.  You can use Rename on the File menu to 
change their names later if you like. 
 
'How many files can I use?' 
 
The File List you create is stored in your Concordance.ini file. As from Version 3.0 of 
Concordance there is no limit to the size of this file, even on Windows 95/98/ME. However, 
performance may be affected if the list grows too large. 
 

Display while Loading 

 
Choosing this item on the File Menu will mean that the start of a newly-made concordance is 
displayed as soon as possible, allowing you to browse while the rest of the concordance is 
loaded.   
 
Choosing this option greatly reduces the time which it takes to see the first results when 
making a large concordance.  It does, however, increase the total time before the entire 
concordance is available for browsing.   
 
If you want to go straight to a location near the end of a concordance you are loading - i.e. 
look at occurrences of a word near the end of the alphabet - or if you want to get the whole 
concordance ready for printing or exporting as quickly as possible, you should not choose 
'Display while Loading'.  With it turned off, none of the words in the Wordlist will be displayed 
until they are all available, but the time to reach that state will be reduced. 
 
With faster computers, the quicker setting, subjectively at least, is to turn off 'Display while 
Loading'.  
 

Progress dialog 

 
The Progress Dialog shows messages indicating what happened during the making of a 
concordance. 
 
It appears automatically if needed while a concordance is being made.  It can be viewed later 
(to see again the messages from the last making of a concordance) by choosing 'Progress of 
last run' on the View menu. 
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By default the Progress dialog shows all messages, including important warnings and less 
important information such as the time taken to make a concordance.  You can choose 
instead to see only the important warnings (in which case the Progress dialog will not pop up 
to bother you unnecessarily.)  To do this, go to the Tools menu, choose Preferences, click the 
User Interface tab, and under 'Show Progress Messages and Warnings', select 'High Priority 
only'. 
 
It is worth paying close attention to any warnings which appear: 
 
Warnings about unrecognised characters: 
 
These warnings occur if you have chosen not to add unrecognised characters to the 
Alphabet. You can use this to find which characters appear in your text but are not in your 
Alphabet.  The warning will include the line number in your text so you can alter the source 
text instead if the character should not be there. 
 
Warnings about references not closed: 
 
These warnings occur if you have an opening reference marker but no closing reference 
marker on the same line.  This is an error.  The warning will include the line number in your 
text so you can fix it. See References for more information.  
 

Changing what's displayed 

 
As you view a concordance that you have made, you can alter it in several ways and see your 
changes immediately.   
 
You can change and re-arrange the headwords in the wordlist in many different ways. 
 
You can also control the way contexts are displayed. You can't edit contexts directly; you 
need to edit the source text instead. 
 
You can search for headwords or contexts you want to view. You can also view the 
Collocations for any word. 
 
All these options affect the way the concordance is displayed after it has been made, not the 
way it's made.  Changes to these options are visible immediately. 
 
By contrast, all items on the Text menu (such as Alphabet, References, Context Styles, and 
Ignore) affect the way the source text is read and so alter the way the concordance is 
constructed.  Changes to those options will take effect the next time you make a 
concordance. 
 
Concordance works on the general principle that if you have chosen to display something on 
screen, it will be included when you save, print, or export. So if you want to omit an element, 
remove it from the display first. 
 
 
 
 

Viewing the source text 
 

 51



Concordance 3.3 manual  

You can view your source text (the text from which the concordance was made) while you 
also view the Wordlist and the Contexts.   
 
The source text can be viewed in a File Viewer or a File Editor.  The Editor allows changes to 
be made to the source text, though changes will not be reflected in the concordance until you 
'Make' it again. 
 
Clicking on a line in the Context View will re-position the File Viewer or Editor to display that 
line in the original text. 
 
Double-clicking on a word in the File Viewer or Editor will re-position the Wordlist to display 
occurrences of that word, provided it is included in the Wordlist. 
 

Choosing between the Viewer and the Editor 
•  The Viewer can display files of unlimited size, but lines must not be longer than 1024 
characters. 
•  The Editor can display files of up to 16 MB, and lines may be up to 32767 characters long. 
•  The Viewer uses a modest, fixed amount of memory whatever the size of the file it 
displays.  
•  The Editor loads the whole file into memory, and therefore requires a large amount of 
memory when editing a large file. 
 
Centred contexts 
 
Contexts can be viewed centred on the headword. This is the default view when a 
concordance is loaded.  To switch to the left-aligned view, use the speedbuttons on the 
toolbar or the tabs which are down the right-hand edge of the context view. These functions 
are also available on the Contexts Menu. 
 
See The Context View for an introduction to Contexts. 
 
The tabs and the Contexts Menu also allow you to hide contexts altogether, or to view an 
Index. Whichever setting you have chosen, it will be used when printing or exporting as 
HTML.   
 
If you have chosen to hide contexts, you have in effect a simple wordlist, with or without 
frequencies of occurrence, which is a useful alternative to a full concordance. 
 
All this refers to context views: they can be altered as you look at the concordance.  There's a 
distinction between context views and context styles, which are chosen before you make a 
concordance.  Each choice of context view works with each choice of context style to give 
many combinations of ways of choosing and viewing contexts. 
 
You can make the program fit columns to the width of their contents automatically.  
 

Left-aligned contexts 

 
Contexts can be viewed left-aligned, as opposed to centred on the headword, which is the 
default view when a concordance is loaded.  To switch between the left-aligned and the 
centred views, use the speedbuttons on the toolbar or the tabs which are down the right-hand 
edge of the context view. These functions are also available on the Contexts Menu. 
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See The Context View for an introduction to Contexts. 
 
The tabs and the Contexts Menu also allow you to hide contexts altogether, or to view an 
Index. Whichever setting you have chosen, it will be used when printing or exporting as 
HTML.   
 
If you have chosen to hide contexts, you have in effect a simple wordlist, with or without 
frequencies of occurrence, which is a useful alternative to a full concordance. 
 
All this refers to context views: they can be altered as you look at the concordance.  There's a 
distinction between context views and context styles, which are chosen before you make a 
concordance.  Each choice of context view works with each choice of context style to give 
many combinations of ways of choosing and viewing contexts. 
 

Indexes 

 
An Index is a concordance without the contexts: that is, a wordlist where each word is 
accompanied by some kind of pointer to all its occurrences, but no surrounding illustrative 
text.  It is similar to the index at the back of a book. 
 
To view an index, make a concordance in the usual way and then choose Index from the 
Context Tabs (down the right-hand edge of the program's window), or choose 'As Index' on 
the Contexts menu. 
 
If you are viewing an index, you will get an index when you print your concordance, save your 
concordance as text or as HTML, or make a Web Concordance. 
 
An index can contain line numbers, or references which you have defined using 
Concordance's reference system, or both. 
 
To make an index which uses the page numbers of an existing document, insert references 
into your text like this: 
 
  <P Page 1> at the top of page 1 
<P Page 2> at the top of page 2 
 
and so on. Then tell Concordance to collect reference category P.  See the help topic on 
references. 
 
Page references in a Word document 
 
In Microsoft Word, you can use a macro to insert page references automatically. An example 
is here. 
 

Sorting 

 
Both the Headwords and the Contexts can be sorted in many different ways. 
 
To select a different sort, do any of the following: 
•  click on a column header  
•  click on the sort labels in the status bar  
•  go to the Headwords menu or the Contexts menu and choose 'Sort by'  
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•  use the pop-up menus (right-click when in the wordlist or context views).  
 
Headwords can be sorted in any of the following ways:  
•  by alphabetical word order, ascending and descending  
•  by alphabetical string order, ascending and descending 
(see below for difference between word and string sorts, and important information on 
punctuation and accented and non-Western characters)  
•  by length of word, ascending and descending  
•  by frequency of the words' occurrences, ascending and descending  
•  by word endings (reading the word from end to start - sometimes called a reverse sort)  
•  by order of their first occurrence 
 
Lemmatising is a special way of sorting headwords, allowing you to arrange related words in 
the order you desire. 
 
Contexts can be sorted in any of the following ways:  
•  by alphabetical order, ascending and descending  
•  by length of context, ascending and descending  
•  by order of the contexts' occurrences in the source text, ascending and descending  
•  by any reference category which you have defined 
 
In addition, centred contexts can be sorted  
•  by the words which are 1, 2, 3, and 4 words before the headword   
•  by the words which are 1, 2, 3, and 4 words after the headword   
•  by the string before the headword  
•  by the string after the headword 
 
(see below for difference between word and string sorts, and important information on 
accented and non-Western characters) 
 
Sorting contexts by words before and after headword 
 
Sorting by words before and after the headword applies to the Centred Context View and 
choosing one of these sorts will switch to the Centred view if it is not currently displayed. 
 
Also, sorting by words before and after the headword is done using the contexts which you 
have currently selected.  For example, take the case where you have made a concordance to 
verse and chosen the actual line as context for each word.  You then choose to sort contexts 
by the words which are (say) one word to the left of the headword.  In the case of a word 
which comes at the start of a verse line, there is no word to its left in your chosen context and 
it will not take part in the sorting: that is, the program does not take account of words which 
are not in your chosen context.  If you wanted to alter this behaviour, you would go to 
Context Styles on the Text menu and choose contexts of selected length so that each word, 
even if at the start of a line, was preceded by a set number of words of context.  Then re-
make your concordance. 
 
How sorting works 
 
Sorts take effect cumulatively. For example, if you sort headwords by descending alphabetical 
order and then by frequency of occurrence, a run of words which all have the same frequency 
of occurrence will still be arranged in descending alphabetical order.  Cumulative sorting is 
not always easy to understand, so there is an extra help page about it here. 
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When a concordance is loaded, headwords are always sorted by ascending alphabetic string 
order, and contexts by ascending order of occurrence. You can therefore revert to this 
arrangement by choosing Revert on the File menu, which reloads the concordance from disk. 
 
The Centred Context View and the Left-Aligned Context View can each have its own sort, so 
switching back and forth between the two does not alter the sort you have chosen for either.  
 
As usual in Concordance, the sort you have chosen for the on-screen display will be used 
when you output results (i.e. save a concordance as a text or HTML file or a Web 
Concordance or print it). 

Word sorts and String sorts treat special characters differently 
 
A word sort treats hyphens and apostrophes differently from other symbols that are not 
alphanumeric, in order to ensure that words such as "to-morrow" and "tomorrow" stay 
together.  A string sort, on the other hand, gives equal weight to every character when 
sorting.   
 
A word sort also treats 'international' characters (as Microsoft calls them, meaning non-
American ones) more intelligently than a string sort.  With a string sort, a word like À appears 
at the end of the Wordlist after ?.  Changing to a word sort will make it appear next to ? 
instead. 
 
The Wordlist View uses a string sort when a concordance is first loaded. This will often 
provide a quick check on anomalies, for example by bringing words with leading apostrophes 
to the top of the list. Such words can be edited or deleted as required.  If you then switch from 
the string sort to the word sort, a word such as 'Tis (with a leading apostrophe) will be moved 
from near the top of the list to a place beside Tis (with no leading apostrophe). 

Cumulative Sorting 

 
Sorts in Concordance take effect cumulatively. This is not always easy to understand, so a 
fuller explanation follows. 
 
The main help page about sorting introduces this idea: "For example, if you sort headwords 
by descending alphabetical order and then by frequency of occurrence, a run of words which 
all have the same frequency of occurrence will still be arranged in descending alphabetical 
order."  We could add, however, that after the second sort is applied, the list as a whole is 
ordered by frequency of occurrence, not by descending alphabetical order: it cannot be 
ordered by both, since one cannot have two mutually contradictory sort criteria applying at the 
same time. However, if we now consider any part of the list (a sub-list, so to speak) 
consisting of a run of items that all have the same frequency of occurrence, they will be 
ordered not at random but according to the previously-applied sort criterion, descending 
alphabetical order. 
 
Let's take a familiar example by considering what happens when we first load a concordance. 
Contexts are initially sorted by their line number (strictly speaking, by order of occurrence 
ascending, which means that even if the same word occurs several times in the same line, all 
instances of the word will appear in their original order). Now apply another context sort, say 
'by word after headword'. Look for a run of instances where the word after the headword is 
the same several times in succession (the new sort has, of course, brought any such 
examples adjacent to each other). Notice these few instances, considered as a sub-list, are 
themselves still arranged according to their order of occurrence: this is easily if loosely seen 
by looking at the line number. This is how cumulative sorting works.  
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Go one step further, and sort the contexts by word before headword. Now find an example 
where the word before the headword is the same several times in succession. This sub-list 
will still be ordered by the word after the headword. Further, if there is now a run of words 
where not only the word before the headword is the same but also the word after the 
headword is the same, that run of words after the headword will be ordered by the order of 
occurrence (the first of the three sorts applied). Therefore three sorts have been applied 
cumulatively.  
 
To sum up, prior sorts apply only to sub-sections of the list with equal values under the 
current sort. 
 

Lemmatisation 

 
What is it? 
 
Lemmatising means grouping related words together under a single headword. Concordance 
includes a Lemmatiser which allows you to define groups of related words and then apply 
your groupings to words displayed in the Wordlist. 
 
For example, you could choose to gather the words am, was, are, is, were, and been 
together under the word be.  To use linguistic terminology, the variants taken together form 
the lemma of the lexeme be. 
 
You can choose to lemmatise any groups of words which interest you, not just ones which are 
linguistically or grammatically related. For example, if you are investigating some aspect of 
democracy, you could choose to gather vote, population, election, etc., under the word 
democracy.  You can also use it to group alternative spellings of the same word, or plural 
forms with singular, or anything else you like. 
 
Concordance will of course allow you to move words around in the wordlist 'by hand', by 
drag and drop or cut and paste. But using the Lemmatiser makes it much quicker to achieve 
complex re-arrangements of words. 
 
Choosing your words to group 
 
You define the words you want to gather together in the Lemmatiser. Open the Lemmatiser 
by choosing it on the Headwords menu or by pressing Shift+Control+L. 
 
Each entry in the Lemmatiser should normally be a single word.  That is because the 
Headword list, which is to be lemmatised, normally contains single words; consequently, if an 
entry in the lemmatiser has more than one word, it will never match any entry in the 
Headword list.  The exception to this is when you make a Selective Concordance using 
phrases: you can then use phrases in the lemmatiser too.  
 
The Lemmatiser works like an outliner or tree view. The controls let you add words and indent 
or outdent them.  A word at the first level of indentation, with a book icon beside it, is one 
under which you want to gather other words, which you add at the second level of indentation. 
Second-level words have a plus-sign icon.   
 
You can also indent words to the third level or more. These have a minus sign and take no 
part in the lemmatisation. This allows you to disable sections of your lemmatisation scheme 
without actually deleting the words. 
The Sort button sorts words in the Lemmatiser (not the Wordlist). 
 
When you have defined and arranged some words, choose Save or Save As on the 
Lemmatiser's File menu to save your lemma file. 
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Making it happen 
 
Whenever a concordance is displayed, you can lemmatise its Wordlist by pressing the 
Lemmatise button. 
 
Lemmatising the Wordlist is just a special case of sorting it.  You are telling the program 
that some words are not to be treated alphabetically but placed where you wish.  
Consequently, switching to any other sort order in the Wordlist undoes the lemmatisation. 
 
As lemmatising a list is slower than ordinary sorting, it is best to apply any basic sorts which 
you wish first, and then to lemmatise your Wordlist last.  Speed is more influenced by the 
number of headwords (i.e. the size of the concordance) than by the number of words in the 
Lemmatiser. 
 
When nothing happens 
 
Lemmatising sorts child words beneath their parent. Consequently, if a particular parent word 
is not present in your text, and hence not present in the Wordlist, the lemmatiser will not move 
its children, since there is no parent to move them to. If this causes you a problem, you might 
choose to solve it by adding a single instance of the parent word to your source text. 
 
Other features 
 
You can click on any word in the Lemmatiser to make the Wordlist scroll to show it, if it is 
there.  
 
There is an incremental search in the Lemmatiser.  Start typing any word to make the 
Lemmatiser scroll to find it. 
 
Avoiding duplicates  
 
A word must not appear again as a child of itself. 
 
A word may appear again if it is not a child of itself. But this can lead to unwanted results. 
Consider the following. In the Lemmatiser you might quite reasonably define  
 
lay 
   --- + laid 
 
lie 
   --- + lay 
 
since 'laid' is the past tense of the verb to lay, and 'lay' is the past tense of the verb to lie. This 
example actually appears in the default lemma file. Having 'lay' appear twice causes no 
problems in the Lemmatiser, since it is not a child of itself. But it can appear only once in the 
Wordlist.  How is that occurrence of lay in the Wordlist to be handled - is it to have laid placed 
below it, or is it to be placed below lie?  You can't have both.  What Concordance will 
actually do, if the words are in alphabetical order, is first to move laid after lay, then move lay 
after lie, leaving laid orphaned in the position where lay was.  This is probably undesirable. 
 
Since human language is not a wholly rational construct, there is no general remedy for this 
issue except vigilance. You might wish to edit your text to distinguish between lay1 and lay2. 
 
Note too that if you want to lemmatise am, was, and were under be, but be is not present in 
the text, then am, was, and were will not be moved.   
 

 57



Concordance 3.3 manual  

Manipulating the tree 
 
You can drag and drop a single word or a parent with all its children. You can't drop a parent 
onto one of its own children. 
 
You can cut, copy, and paste words using the standard Windows shortcut keys: Control+X, 
Control+C, Control+V. 
 
If you hold the cursor very near the top or bottom of the lemma list, it will scroll automatically.  
This is particularly useful when dragging words to a place far away in the list. 
 
If you drag a word to a parent which is not expanded and wait a moment, the parent will 
automatically expand to make its children visible. 
 
You can cancel a drag operation by moving the cursor out of the lemma list before releasing 
the mouse button. 
 
As you drag a word, the status line at the foot of the Lemmatiser changes to show where the 
word would go if you dropped it. You can get different results by dropping on another word, or 
on the indentation lines beside a word. 
 
Managing lemma files 
 
When you first open the Lemmatiser, it opens a lemma file called Default.lemma if that file 
exists in the same folder as the program itself. (It should do, because it was placed there by 
the installation.) Default.lemma is a short sample file.  You can create any number of your 
own lemma files using the Lemmatiser, and they can be called whatever you like. If you want 
a different lemma file to be loaded automatically whenever you open the Lemmatiser, go to 
the Lemmatiser's File menu, tick the Auto-load Lemma File option, then choose Open and 
select the lemma file of your choice. 
 
On a shared network installation, your system administrator should give you your own copy of 
Default.lemma. 
 
Sharing Lemma lists 
 
If you prepare a lemma list for a special purpose, please consider sharing it with other users 
of Concordance. Send it to me and I will make it available on the Concordance website. 
 
Advanced use 
 
As well as dragging and dropping words to re-arrange them within the Lemmatiser, you can 
drag words from the Wordlist or the Scratchpad and drop them into the Lemmatiser. 
 
You can prepare a lemma list by making a concordance to a text, saving the headword list 
(without contexts or frequencies) as a text file, opening that file with the Lemmatiser, and 
adding indentation as you wish.  To save a headword list without contexts or frequencies, just 
turn off the display of both before saving (on the Headwords menu, un-tick 'Show 
Frequencies', and on the Contexts menu, choose 'None'). 
 
A lemma file can also be edited with the supplied Multiple Document Editor or any editor able 
to handle plain text.  The file format is simply one word on each line, with a tab to indicate 
indentation.  You could prepare a lemma file with another program such as Word if you 
wanted (save it as plain text). 
 
If you wanted, you could prepare a file with the Pick or Stop List Manager and then use it in 
the Lemmatiser, or vice versa. But the Pick and Stop List Managers ignore indentation.  
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Hence a file prepared with them and then used in the Lemmatiser will need indentation 
added, and a file made with the Lemmatiser and then opened in the Pick or Stop List 
Manager and saved there will have its indentation removed. 
 
Finally, there is nothing to stop you opening an ordinary text file with the Lemmatiser if you 
wish. It would then have multiple words on each line instead of one, and you could use the 
Lemmatiser as an outliner or 'ideas processor'.   (The resulting file wouldn't be much good for 
lemmatising headwords, though.) 

Searching 

 
The Search Menu allows searching for strings and words in both the Wordlist View and the 
Context View. 
 
The Wordlist View also supports incremental searching: when that view is active, just start 
typing a word and the view will re-position itself to the nearest match. 

Language and Font Control 
 
The Language and Font Control helps you use languages other than English. It lets you 
select character sets and keyboard layouts and apply those settings throughout the program.  
 
It can be used to alter character sets and keyboard at any time, but is particularly useful when 
the Alphabet Editor is also displayed. 
 
The interaction in Windows between languages, fonts, their available character sets, and 
keyboard layouts is complex and can often be confusing. The Language and Font Control 
brings these elements together where their interaction can be seen more easily. 
 
What to do 
 
To work with different languages, the three minimum steps are: 
 
1. Select a font and character set which supports your chosen language 
2. Apply it throughout the program 
3. Make sure you have appropriate settings for your Alphabet 
 

Step 1: Select a font and character set 
You can use the Select Language control as a shortcut, or get fuller control with the Change 
Font and/or Character Set button. 
 
Select Language 
 
This drop-down list has two purposes: 
•  It shows all the available languages which your version of Windows supports.   
•  It is a quick way of selecting an appropriate character set. This will be shown in Current 
Font and Character Set below it.  When you have chosen the right font and character set, you 
can press the Apply Font and Character Set throughout program button.
 
There are more details on Select Language below. 
 
Current Font and Character Set 
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This shows the name and character set of the currently selected font. The Select Language 
drop-down list (above) lets you change the character set, and the Change Font and/or 
Character Set button (below) gives you fuller control over both font and character set. When 
you have chosen the right font and character set, you can go to Step 2. 
 
Change Font and/or Character Set 
 
Press this button to get fuller control over your choice of font. You can also see what 
language scripts are available in any font. A script is the term Windows uses in its Font 
dialog for a character set.  You can use the Font dialog to change to another script if you 
wish, as an alternative to using the Select Language drop-down list.  There are more details 
on Fonts below. 
 

Step 2: Apply Font and Character Set throughout program 
When you press this button, the font and character set (language script) you have chosen are 
applied to all parts of the program where your text is entered and displayed.  Concordance's 
messages and captions remain in the UK English character set. 
 
Several windows in Concordance allow you to set their fonts independently.  These include 
the Wordlist view, the Context views, and the Pick and Stop List managers.  Pressing Apply 
Font and Character Set throughout program will override font settings in these windows.  
Hence it is easiest to use Apply Font and Character Set throughout program to change 
languages and scripts (character sets), and then to apply any cosmetic changes (font colour, 
size, etc.) directly to the Wordlist and Context views, etc.  This same sequence will be applied 
to restore your font choices whenever you re-start the program. 
 

Step 3: Check Alphabet 
Concordance gives you full control over your alphabet and recognises only those characters 
you include in it. So, in order to work with a chosen language, you must include its special 
characters in your Alphabet. For more information, see the help on the Alphabet dialog.  The 
Alphabet dialog is opened from the Text menu. 
 
To include characters in your Alphabet, you can do one of two things: 
    
•  have Concordance add all characters automatically to the Alphabet as they are found 
when reading your texts; 
•  for fuller control, you can add individual characters to the Alphabet yourself. 
 
To add characters automatically, open the Alphabet dialog. Under 'Characters not in 
Alphabet, when found in text', choose 'Add to Alphabet'. 
 
To add individual characters yourself, enter them in the Alphabet dialog directly, or use the 
Scratchpad here in the Langauge and Font Control. Details immediately below: 
 
Character Set Details and Scratchpad 
 
This control is for information and does not affect settings elsewhere in the program. 
•  It shows all the characters in your chosen font and language script  
•  It lets you type characters at the keyboard to test a keyboard layout  
•  It lets you copy selected characters directly to your Alphabet 
 
Press the Show All button to show all the alphabetic characters in that font and character set.  
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Press the Clear button to clear the edit window.   
 
To copy characters directly to the Alphabet, select characters using the mouse or keyboard, 
then press the Copy to Alphabet button. 
 
Click the right mouse button for a pop-up menu.  The copy command on the menu copies 
selected characters to the Windows Clipboard, so they can be pasted elsewhere. It does not 
copy them directly to the Alphabet. 

Current Keyboard 
 
Press the Switch Keyboard button to switch amongst the keyboard layouts (also known as 
Input Locales, or input languages) which are installed in Windows.  If only a single keyboard 
layout is installed, nothing will happen. To install more keyboard layouts, use Regional and 
Language Options in Control Panel for Windows Vista, XP and NT4.0.  In Concordance's 
Language and Font Control, the button 'Windows Regional Settings' takes you there.  In 
Windows 98, unfortunately, you need to use the Keyboard applet in Control Panel instead. 
 
Windows also allows you to switch between installed keyboard layouts using a hot key. The 
Switch Keyboard button in the Language and Font Control should be used instead because 
its effects are immediate throughout the program.  In Windows 98, pressing this button sets 
the input language for Concordance. In Windows Vista, XP, and NT, it sets the input 
language system-wide. 
 
Examples and Further Details 
 
Example: Working with Greek text 
 
To work with Greek text,  choose 'Greek' from the Language drop-down list. Characters in the 
Character Display will be rendered at once in the Greek character set. When you press the 
Apply button, any text displayed in other parts of the prorgam will be rendered in the Greek 
character set.  Provided the text was prepared using a Greek character set, it will now be 
correctly displayed. 
 
To type in Greek text, tell Windows to use a Greek keyboard layout by pressing the Switch 
Keyboard button until Greek is selected (assuming it is available as an installed Input Locale). 
 
Mixing languages 
 
Your alphabet can mix characters from different languages as long as they are contained in 
the same character set.  Windows character sets such as Cyrillic, Greek, and others actually 
contain all the Western characters as well; hence Greek can be mixed with Western 
characters by choosing the Greek set. Similarly Cyrillic with Western by choosing the Cyrillic. 
Greek and Cyrillic, however, reside in different sets. 
 
 
Select Language - further details  
 
The Select Language drop-down list shows all the languages which are installed in your 
version of Windows.  If a language you want to use is not present, consult your Windows 
documentation.  Note also that the presence of certain languages in the list does not mean 
that Concordance will work correctly with them. At present Concordance supports the 
Western languages, with limited support for the mid-Eastern and Asian.   
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Support for non-Western languages depends to a large extent on which version of Windows 
you use, and is much superior in Windows 2000. 
 
Fonts - further details  
 
Not all fonts have a variety of language scripts. As you change fonts, the character set you 
have chosen (based on your choice of language) will remain in force. If necessary, Windows 
will substitute a different actual font for the logical font you have chosen so as to optimise 
what is displayed.  When this happens, the appearance of the font changes but Windows 
does not alter its displayed name, which can be misleading. 
 
See also:  
Alphabet
Languages, locales, and keyboard layouts - terminology  
 

Changing character set 
 
The font dialog which can be invoked from the Language and Font Control allows you to 
change amongst character sets. Using the Apply button in the Language and Font Control 
you can then apply those changes to all parts of the program. 
 
You can see what scripts are available in any font. A script is the term Windows uses in its 
Font dialog for a character set.  You can use the Font dialog to change to another script if you 
wish, as an alternative to using the Language drop-down list. 
 
See also Language and Font Control  
 

Collocations 

 
A word's collocates are those words it appears next to or near to.  Collocations which occur 
with high frequency are powerful indicators of a pattern of meaning in a text. They are also 
useful for studying phraseology and idiom. 
 
Concordance lets you view collocation lists for any headword in the Wordlist View. It shows 
the collocates of the headword with all words occurring up to four words before and four after 
the headword. 
 
To view the collocations for a word 
 
Highlight the word you want in the Wordlist View. Then choose Collocations from the 
Headwords menu. Or right-click anywhere in the Wordlist View to bring up the pop-up menu, 
then choose Collocations. 
 
Collocations depend on selected contexts 
 
Note that collocations are based on the selected context that you have chosen.  For 
example, if you have made a concordance where each word is given a context of three words 
before and after the headword, no collocations will be shown for the fourth word to the right 
and left of the headword, since there is no fourth word to the right or left of any headword in 
the contexts you have chosen. 
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To take another example, if your concordance is to verse and you have chosen the verse line 
(actual line) as context for each word, a word occurring at the start of a line will have no 
collocates to its left.   
 
This means you could choose to limit your study of collocations to those occurring (say) within 
a line of verse rather than across line-breaks.  To avoid limiting collocations in this way, you 
need only ensure that you make your concordance with a Context Type of Selected Length 
and at least 4 words before and after the headword.  See Context Styles on the Text menu.  
 
Sorting 
 
When Collocations are first displayed they are sorted in descending frequency order. Click on 
the frequency column header to re-sort the view, toggling between ascending and descending 
frequency order. Click on the word column header to re-sort the view, toggling between 
ascending and descending alphabetic order. 
 
Export 
 
Press the Export button to send the data in all the Collocation Lists to the editor. You can then 
save them to a file, print them, or copy them to the Windows Clipboard for use in another 
program as you wish. 
 
Collocation Display 
 
Drag the bottom right-hand corner of the Collocations Form to re-size the view if it cannot all 
be conveniently seen on your screen.  Each list will re-size itself automatically as you alter the 
size of the main form, provided  'Auto-resize' is ticked.  
 
You can alter the split of the view between the left and right collocations by dragging the 
maroon splitter. 
 
There are also splitters between each of the four lists of right collocations, and between each 
of the four left collocations. These let you adjust the size of any single list. 
 
Orientation 
 
Click the Orientation button to alter the arrangement of the eight Collocation Lists on the 
screen. They can be all vertical or in two rows, right above left.   
 
Re-arranging Columns 
 
You can re-arrange the columns in a Collocation List by dragging a column header to move 
the whole column to the left or right of an adjacent column.   
 
Re-sizing Columns 
 
Columns in a Collocation List can be re-sized by dragging the divider between two column 
headers. 
 
If you double-click on the divider between two column headers, the column will re-size itself 
automatically to fit its contents. 
 

Percentages 
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Choose Show Percentages on the Headwords Menu to show the occurrences of each 
headword as a percentage of the total number of words kept from the source text. If you have 
chosen options that select words from the source text, instead of retaining every word, then 
percentages are relative to the words selected, not to the text as a whole.   
 
As with all statistics, you should satisfy yourself that you know how they have been derived, 
and that they match what you would expect, before you rely on them. It is always a good idea 
to test your settings by using a few very small files to begin with. 
 
If percentages are showing when you choose to Print, Print Preview, Save as Text or as 
HTML, or to build a Web Concordance, the percentages will be shown in the output. 
 
After you edit the Wordlist, statistics, including the frequencies of occurrence of each 
headword, are re-calculated automatically in the background if your computer supports it.  
You can invoke a full re-calculation at any time by choosing Recalculate Statistics on the 
View menu or typing Control+R. 
 

Gridlines 

 
Gridlines, in both the Wordlist View and the Context Views, can be turned on or off by 
choosing the appropriate items on the Headwords and Contexts menus. 
 
Gridlines are for ease of viewing on screen and do not appear when the concordance is 
printed.  You can, however, choose to print boxes around contexts using Page Setup.  For 
HTML output, a similar effect is available using Tables in HTML Setup. 
 
On some computers with certain versions of Windows, gridlines can be drawn untidily from 
time to time, on top of words instead of between them.  See Frequently Asked Questions and 
look for 'A messed-up screen'. 
 
If gridlines do not appear when you start the program even though 'Show Gridlines' is ticked, 
your computer may have a very old version of the Windows Common Controls. A 
consequence is that clicking on a line in the Centred Contexts view will not open the full text 
display. You can make gridlines appear by turning off 'Show Gridlines' and then turning it on 
again.  The permanent solution is to update your version of the Windows Common Controls.  
 

Fonts 

 
Fonts can be specified separately for the Wordlist View, the Scratchpad,  and the two Context 
Views, centred and left-aligned.  To add bold, italic, or underline effects, choose the buttons 
on the toolbar. To make other changes to fonts, such as font face, size, and colour, choose 
Font on the Headwords and the Contexts Menus. 
 
The fonts and font attributes you have chosen will automatically be used when you choose 
Print or Print Preview, and will also be used when you save a concordance as HTML or build 
a Web Concordance. 

 

Choice of Fonts 
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There are certain limitations on the choice of fonts.  Print Preview requires that you choose a 
proportionally-spaced font.  The File Viewer and File Editor use fixed-pitch (monospace) fonts 
such as Courier New.  
 
In HTML, formatting text in columns may be done either by using tables or by using the so-
called 'pre-formatted' attribute - <pre> in HTML.  The latter makes sense for columns only if a 
fixed-pitch font is used. If you choose this way of formatting a Web Concordance and have a 
proportionally-spaced font selected in the Context View, you will be warned when you are 
about to build the Web Concordance. 
 

Fonts, Languages, and character sets 
 
Concordance's Language and Font Control makes it easy to choose fonts and character sets 
for particular languages.   Pressing Apply Font and Character Set throughout program in 
that dialog will override font settings in those windows which allow their fonts to be set 
independently, such as the Wordlist view, the Context views, the Pick and Stop List 
managers, etc. 
 
Hence it is easiest to use the Language and Font Control and press Apply Font and 
Character Set throughout program to change languages and scripts (character sets), and 
then to apply any cosmetic changes (font colour, size, etc.) directly to the Wordlist and 
Context views, etc.  This same sequence will be applied to restore your font choices 
whenever you re-start the program.  
 

Editing a concordance 

 
You can alter the Wordlist directly in a number of different ways.  To alter contexts, however, 
you need to change your source text and re-make the concordance. See these topics: 
 
Altering the Wordlist
 
On not Editing Contexts
 
Editing a concordance is best seen as a last step before printing or exporting. After all, any 
changes you make this way will be undone if you re-make the concordance. If you find 
yourself making extensive changes, it may be better to try to get the effect you want by editing 
the source text or by altering the options on the Text menu which affect the way the 
concordance is made.  

Altering the Wordlist 
 
You can alter the wordlist by re-arranging the headwords in it and by editing and deleting 
them.  You can also show all duplicate words separately instead of merged together. 
 
Re-arranging headwords 
 
Sorting is the primary means of arranging words - it's fundamental to the usefulness of any 
concordance or wordlist - and many sorting options are available. 
 
Besides sorting, Drag and Drop or the Scratchpad can be used to re-arrange words 
individually. 
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Lemmatising is a special case of sorting, allowing you to arrange related words in the order 
you desire. 
 
Editing and deleting headwords 
 
Many ways of selecting words are available on the Headwords Menu. When you select 
words, those not selected disappear from the list of headwords.   
 
To delete a word, highlight the word and press the Del key or choose Delete Headword from 
the Edit Menu.  To delete many words at once, choose Multi-select on the Edit menu, 
highlight the words, then press the Del key.  See the help on Multi-select in Copying a list of 
Headwords. 
 
You can edit individual headwords - but read this first and proceed with caution! 
 
To change the case of words, choose the Change Case item on the Headwords menu. 
 
See also: On not Editing Contexts
 

Show duplicate words separately 

 
Concordance normally aggregates (gathers together) all instances of each word it finds in 
your text (that is, all tokens of each type). Each word is displayed once in the Wordlist, with a 
count of the number of times it occurs. So, for example: 
 
ABATED 1 
ABLE  6 
 
and so on.  You can change this by choosing Show duplicate words separately on the 
Headwords menu. Then, each occurrence of each word will have a separate entry in the 
Wordlist, like this: 
 
ABATED 1 
ABLE  1 
ABLE  1 
ABLE  1 
ABLE  1 
ABLE  1 
ABLE  1 
 
You do not need to re-make your concordance to show duplicate words separately. You can 
change from showing words aggregated to showing them separately, and back again, any 
time your concordance is displayed. 
 
If you combine Treat upper and lower case separately with 'Show duplicate words separately' 
and then sort the Wordlist by order of occurrence, you will get an exact list of the words in 
your text in the order they originally appeared. This can sometimes be useful. 
 
Warning: if your concordance is large, showing duplicate words separately will result in an 
enormous number of entries in the Wordlist.  This slows Windows down a lot, will try your 
patience, and may possibly exceed your computer's memory resources.  

Selecting words 
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Choose 'Select Words' on the Headwords menu to select amongst the words present in the 
Wordlist View by a number of criteria.   
 
The words you select will remain in the Wordlist View and others will be removed from it.  
Only those which remain will be printed, saved, or exported as HTML. 
 
If you want to undo the effect of removing some words, choose Revert on the File Menu. This 
re-loads the last saved version of the concordance. That will be the original version if it has 
not been altered and saved since it was made. 
 
You can re-create a full version of a concordance at any time by choosing Make Full 
Concordance on the File Menu. 
 
Making a Selective Concordance is an alternative way of selecting words as the source text is 
being read, rather than while the words are displayed. Afterwards, you can further select 
using Select Words on the Headwords menu. 

Selecting words using patterns 
 
From the Headwords menu, choose Select Words Matching or Select Words not Matching.  
You will be asked to enter a word which may include the pattern-matching symbols 
(wildcards) ?, standing for any one letter, and *, standing for any number of any letters.   
 
You can combine these to produce powerful selection criteria: 

To do this:  Type this:  
Select all words of a certain length, 
e.g. words of 4 characters: ???? 

Select all words greater than a certain 
length, e.g. words of 4 characters and 
over 

????*  

Select words beginning with a prefix, 
e.g. words beginning with 'un-'  un* 

Select words ending with a suffix, e.g. 
words ending in '-ing' *ing 

Select words which begin with 'un' and 
end with 'ing' un*ing 

Select words which begin with 'un' and 
contain 't' 

- first select by 
typing un*  

- then select 
again by typing 
*t*  

Select all words which contain the 
letter 'e' *e*  

Select all words  

(this keeps all the words currently in 
the Wordlist - i.e. it has no effect!) 

* 
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Editing individual Headwords 

 
You can edit individual headwords in the Wordlist View, but you should use this ability with 
caution!  This refers to in-place editing of the actual characters of the word, not deleting the 
word altogether or moving it elsewhere in the list, both of which are quite safe. 
 
Here's why:  
 
This ability is provided for making minor alterations, such as changing the capitalisation of a 
proper name before printing.  If you make more radical changes to a headword, you're likely 
to encounter problems.  Since changing a headword does not change its contexts, you will 
end up with a headword which no longer appears in its own contexts - a situation which 
makes no sense.   
 
If you also change the length of the headword, context displays will be even more incorrect. 
Finally, if you save and reload a concordance after making such changes, the results are 
undefined.  In other words, anything may happen. 
 
Still want to go ahead? Here's how: 
 
To edit an individual word, first untick the Read-only item on the Headwords menu. When 
this is ticked, it prevents individual headwords from accidental changes.  (It stops in-place 
editing of the actual characters of the headword, but doesn't prevent the headword being 
moved or deleted altogether). Then double-click the headword. An editor dialog will open to 
allow you to change the word. 
 
In versions of Concordance before 2.0.0, this function used the Windows in-place editor 
(similar to that in Windows Explorer where you can rename a file or folder by doing a very 
slow double-click).  This does not handle international characters properly. Version 2.0.0 uses 
an editor which should be language-aware. 
 
Setting the Wordlist View from read-only to editable or back again causes Windows to do lots 
of housekeeping which can take quite a while. 
 

Copying a list of Headwords 

 
You can easily copy words from the Wordlist View.   
 
Concordance works on the general principle that if you have chosen to display something on 
screen, it will be included when you save, print, or export. If you want to omit an element, 
remove it from the display first. Thus if you have chosen to display Frequencies and/or 
Percentages with your headwords, they will be included. To copy headwords alone, first turn 
off the display of Frequencies and/or Percentages using the Headwords menu. 
 
To copy all words: 
 
Right-click on the Wordlist View.  On the pop-up menu, choose Copy all words to 
Clipboard. You can then paste the words into any other Windows program, including the 
Multiple Document Editor which comes with Concordance. 
 
To copy selected words only: 
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First choose Multi-select on the Edit menu.  If there are many words in the Wordlist, there 
will be a delay while Windows does a lot of housekeeping.  Now you can highlight (select) 
more than one word in the Wordlist View, using standard Windows selection techniques - 
Shift+click, Control+click, or Shift+arrow keys. 
 
When you have finished selecting words, choose Copy to Clipboard on the Edit menu.  The 
selected words will be copied, ready for pasting into any Windows program. 
 
About Multi-select 
 
Multi-select is for copying words to the Clipboard, and also for deleting multiple words with a 
single press of the Del key.   
 
You can't use multi-select to drag and drop multiple words at once. Further, when multi-select 
is on, it becomes hard, if not impossible, to drag and drop a single word in the Wordlist View 
or to and from the Scratchpad.  Therefore it is best to keep Multi-select turned off when you 
don't need it for copying multiple words to the Clipboard. 
 
Turning Multi-select on or off causes Windows to do lots of housekeeping which can take a 
very long time with a large wordlist. 
 
Select All 
 
This command on the Edit menu selects all words for copying to the Clipboard. It works only 
when Multi-select is active. It is useful if you want to select most words, since it is quicker to 
select them all first, then deselect a few. 
 
If you really want to select all words for copying, don't bother with Multi-select, but just use the 
command on the pop-up menu (as described at the top of this help topic). 
 
Saving a word list to a file 
 
You can also save a full list of headwords directly to a file instead of to the Clipboard.  First, 
turn off the display of contexts by clicking on the tab marked 'None' at the right-hand edge of 
the screen.  Then choose 'Save as text' from the File menu.  The headword list will be saved 
to a file of your choosing.    
 
You can include or exclude frequencies and percentages along with your headword list by 
showing or hiding them (using items on the Headwords menu) before you copy to the 
Clipboard or save to a file.   
 
Similarly you can print headwords only, by turning off the other elements of the display before 
printing. 
 
See Saving a Concordance. 
 

Drag and drop 

 
You can drag words in the Wordlist View and the Scratchpad to re-arrange them, and can 
drag and drop words between these two views. 
 
You can also open an existing concordance file by dragging it from the Explorer or the 
desktop and dropping it on the program's main window or on its icon on the desktop. 
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Scratchpad 

 
The Scratchpad is a convenient way of editing the list of headwords in the Wordlist View. 
Words can be cut or copied between the Wordlist and the Scratchpad. They can also be 
dragged within each view, and dragged and dropped from one view to the other.  
 
This enables words to be placed easily in any desired order before printing or saving the 
concordance. 
 
The Scratchpad is cleared when a concordance is closed or a new one loaded.  It is not 
cleared when you hide it. 
 
To show or hide the Scratchpad, choose Show Scratchpad on the Edit menu or use the 
Show/Hide Scratchpad button on the Toolbar. You can also hide the Scratchpad by clicking 
on the word 'Scratchpad' in its header. 
You can copy the words from the Scratchpad to the Windows Clipboard, ready for pasting into 
another program. You can also save the words to a file.  Both these functions are available 
from a pop-up menu. Right-click on the main body of the Scratchpad to make the menu pop 
up. 
 
See also:  
Splitting Views
 

Changing case of words 

 
Headwords appear by default in upper case, since Concordance normalises words as they 
are read from your text.  So, for example,  'This', this', and 'THIS' will normally all be gathered 
together and counted as instances of the same word.  You can change this. 
 
When the concordance is displayed 
 
When the concordance is displayed, you can change the case of the words to lower case or 
mixed case (first letter upper case) using Change Case on the Headwords Menu.  This 
function changes the case of all the words - you can't choose which. 
 
The setting you choose will be used when the concordance is printed or exported as HTML. 
 
As the concordance is made 
 
You can also choose to avoid normalising the words altogether as the concordance is being 
made. Then, for example, 'This', this', and 'THIS' will all have separate entries in the Wordlist.  
See Treat upper and lower case separately. 
 

Limit Number of Contexts Shown 

 
You can choose not to see all the contexts for your headwords. This is useful if you want to 
include only a few examples.  On the Contexts Menu, choose Limit Number Shown and 
then type in the maximum number of contexts you wish to see.  This will limit the number of 
contexts shown on screen and also when you export, print, or save the concordance. 
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If you have chosen to limit numbers, a tick appears beside Limit Number Shown on the 
Contexts Menu and the maximum number will be shown in the leftmost header of the Context 
View, for example "(Max 5)". 
 
To stop limiting the number of contexts shown, select Limit Number Shown on the Contexts 
Menu again. The tick beside this menu item will disappear. 
 
The Wordlist View continues to show the total number of occurrences of a headword (i.e. the 
total number of contexts) even if you have limited the numbers shown.   Deleting context lines 
is another way to control what contexts you see and will affect the number that can be shown. 
 
If you limit the number of contexts shown and then choose 'Save Concordance As...' from the 
File menu, the concordance will be saved with only the limited number of contexts. 
 
See also:  Deleting context lines  

Delete Context Line 

 
You can delete any context line you do not want to keep. 
 
A Context View (centred or left-aligned) must be the focused (active) view and a context line 
must be selected (highlighted) before you can delete it.   
 
To delete a line, press the Del key, or choose Delete Line from the Contexts Menu, or right-
click on the Context View for a pop-up menu. 
 
It is easier to select lines for deletion if you first choose Don't View Text on the View menu. 
This stops the viewer or editor opening each time you click on a context line. 
 
After they are deleted, context lines don't appear in the Context Views, nor when you export 
or print. Deleted lines remain deleted until you undelete them or until you re-make the 
concordance.  If you choose 'Save Concordance As...' from the File menu, deleted lines will 
still be available for undeleting after the concordance has been saved. 
 
If there are any deleted context lines for the current headword, the fourth panel from the left 
on the Status Bar shows the number of deleted lines, followed by  the number of remaining 
lines in square brackets.  
 
The Wordlist View continues to show the total number of occurrences of a headword (i.e. the 
total number of context lines) after you have deleted context lines.  If you have also limited the 
number of contexts to display, this too will affect the number of contexts shown. 
 
See also: 
Undelete Context Lines
Limit the number of contexts to display   
 

Undelete Context Lines  
 
You can undelete all previously deleted context lines for the currently selected headword.  
Choose Undelete Lines from the Contexts menu, or right-click on a Context View for a pop-
up menu. 
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This function is not available if there are no deleted context lines for the currently selected 
headword.  If there are deleted lines, the fourth panel from the left on the Status Bar will show 
how many. 
 
To undelete every deleted line in a whole concordance, you can visit all headwords with 
deleted lines and choose this function, but it may be quicker to re-make the concordance. 
 
See also Delete Context Line  

On not Editing Contexts 

 
You can delete context lines and undelete them. 
 
You can't, however, directly edit contexts in the Context Views. This is because the same 
context or part-context belongs to many different words in the source text and one word's 
context overlaps with another's.  Although contexts look like a little window onto the source 
text, in fact each context is specially selected for each instance of each headword, and editing 
one would not affect all other occurrences, or partly overlapping occurrences, of the same text 
elsewhere. 
 
If you find something in a context which is definitely not what's wanted, you probably need to 
edit the source text. You can do so without leaving Concordance by selecting View Text in 
Editor on the View menu. Then re-make the concordance to see the effect of your changes. 
 

Fit Columns to Contents 

 
You can make the Context View fit the width of its columns to their contents automatically.  
This is useful as context lines can often be too long for your screen to display.  It is 
particularly of use with the Centred Contexts display, as this has multiple columns. 
 
There are three options: 
•  Don't auto-fit - keeps the column widths you set manually by dragging column dividers 
•  Partial auto-fit - fits the narrower columns automatically to their contents, but not the wider 
ones (the contexts before and after the headword) 
•  Full auto-fit - fits all columns to their contents. 
 
There are other things you can do with columns to get a display that suits you better. See 
Columns  
 

Getting information 

 
You can get information about the loaded concordance and about other topics with any of the 
following: 
 

 Properties
 

 Word Length Chart
 

 Collocations
 

 Statistics
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 Memory Usage

 
 Character Table  

Properties 

 
The Properties form shows information about the concordance which is currently loaded, 
including the number of lines, words, characters, and sentences in the source text, the type-
token ratio of the text, and the average number of words per sentence. 
 
To show the Properties form, click on the Properties button on the toolbar or on the button 
labelled 'Tokens' in the Status Bar, or choose Properties from the View Menu or a pop-up 
menu. 
 
Types and Tokens 
 
Types are word-forms and tokens are occurrences of word-forms.  So, for example, in the 
sentence 'The cat sat on the mat', there are two tokens of the type 'the' and one token each of 
the types 'cat', 'sat', 'on', and 'mat'. 
 
The ratio of types to tokens is a measure often used in quantitative stylistic analysis. 
 
The Properties form shows figures for types, tokens, and the type-token ratio for the 
concordance as it was when loaded, and also as it currently is. If you have deleted words 
from the headword list, the figures will differ.  
 

Word length chart 
 
Choose Word Length Chart on the View Menu to see a graph of the frequencies by length of 
all words in the source text. The graph reflects the words currently displayed in the Wordlist 
View, so you can view a new graph after selecting words to see the effect of the selection on 
frequencies. 
 
The Chart's X-axis shows word length in letters.  The Y-axis shows the numbers of such 
words.   
 
The labels at the top of each bar on the chart show the numbers of words (as on the Y-axis) 
but can be switched to show the percentage of the whole text which such words represent.  
Switching is done using the button labelled 'Number/Percent'. 
 
The white box at the right of the chart also shows how many words there are of length 1, 
length 2, length 3, and so on. 
 

 Hold down the left mouse button and drag the mouse towards the bottom right corner to 
zoom in on a selected part of the chart. 
 

 Do the same towards the top right corner to undo the zoom. 
 

 Hold down the right mouse button and move to re-position the chart. 
 

 You can print the chart as required. 
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The Word Length Chart does not display any data if no concordance is loaded. 
 
You can paste the Word Length Chart to another Windows program which can accept 
pictures, such as Microsoft Word.  To copy, hold the Alt key and press the Print Screen key.  
Then paste into Word. 
 

Statistics 

 
Statistics about the source text are available by choosing Properties. 
 
Detailed statistics on word frequency distribution are shown in the Word Length Chart. 
 
After you edit the Wordlist, statistics, including the frequencies of occurrence of each 
headword, are re-calculated automatically in the background if your computer supports it.  
You can invoke a full re-calculation at any time by choosing Recalculate Statistics on the 
View menu or typing Control+R. 
 
As with all statistics, you should satisfy yourself that you know how they have been derived, 
and that they match what you would expect, before you rely on them. It is always a good idea 
to test your settings by using a few very small files to begin with. Don't rely on 'the computer', 
any more than you rely blindly on a calculator: do your own sanity checks. 
 

Memory usage 

 
Choose Memory Usage on the View Menu to see a summary of memory in use and 
available on your computer. 
 
Physical memory means RAM and virtual memory means RAM plus the page file on disk. 
 
The size of the concordances you can make, and the speed with which they are made, 
depends to a considerable extent on available memory. If you have little available memory 
before making a concordance, it is worth trying to increase it by closing other programs. 
 
The way free memory (RAM) is reported varies from one version of Windows to another, and 
is nearly useless under Windows 95/98.  A low figure for free RAM on these versions of 
Windows need not always be a cause for concern. 
 

Character table 

 
The Character Table enables you to look up the character sets contained in different fonts 
and copy individual characters if required. 
 
The Character Table is a reference tool.  It does not alter the behaviour of the program. 
 
To copy a character, highlight it and press the 'Copy char' button.  This copies the character 
to the Windows Clipboard. It is then ready for pasting into other programs or other parts of 
Concordance. Remember that not all characters appear in every font. 
 
See also:  
Alphabet
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Fonts
Language and Font Control
Character sets, Main Reference  
 

Saving, Printing, and Exporting 

 
 Saving a concordance

 
 Selecting what to include

 
 Printing

 
 Page setup

 
 HTML Setup

 
 Saving and restoring settings

 
See also: Building Web Concordances
 

Selecting elements to include 

 
Before you do any of the following operations, you can choose which elements of your 
concordance you want to include: 
•  print your concordance   
•  save it as a text file  
•  save it as a HTML file   
•  build a Web Concordance 
 
Concordance works on the general principle that if you have chosen to display something on 
screen, it will be included when you do any of the above. So if you want to omit an element, 
remove it from the display first. 
 

Words 
 
To select words, choose Select Words on the Headwords menu.  Words which do not match 
a selection will be removed from the Wordlist and will not be included in the printed or 
exported concordance. 
 

Contexts 
 
Choose whether you want context lines to be left-aligned or centred on the headword. The 
view you choose will be used in the printed or exported concordance. 
 
If you want a wordlist on its own without any contexts, turn off the display of contexts by 
choosing None on the Contexts menu or clicking the None tab at the right-hand edge. If you 
want an index, click the Index tab. 
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Other elements 
 
You can choose whether or not to include: 
•  Frequencies  
•  Percentages  
•  Line numbers  
•  References  
•  Reference Categories.   
 
Those elements which are displayed on the screen will be included.    
 
If you make a Web Concordance, there has to be a reference on which to create an HTML 
link from the concordance frame to the original text. If you have created references of your 
own, they will be used for the text of the link. If you haven't, line numbers will be used, and so 
displayed in the Web Concordance, even if you have turned off the display of line numbers in 
the Context Views. 
 
You can display word frequencies and/or percentages in the Wordlist Frame in a Web 
Concordance. (They will also appear in the Concordance Frame.) This more closely 
resembles the display in the program itself.  Note that frequencies and percentages must also 
be visible (displayed) in the Wordlist if they are to appear at all in the Web Concordance. See 
HTML Setup. 
 
 

Fonts 
 
The fonts and colours which you have set in the Wordlist View and the Context View will be 
used where the output device supports them. 
 

Saving a concordance 

 

As a concordance 
 
When you make a concordance it is already saved on disk by the time it is displayed.  There 
is no need to save it again before exiting the program unless you have made changes to the 
wordlist (its contents and/or its order) and want to save those changes.   
 
To save a concordance, choose Save Concordance As from the File Menu.  You can save it 
under a new name or replace the existing concordance file. 
 
Concordance works on the general principle that if you have chosen to display something on 
screen, it will be included when you save (or print or export). So if you want to omit an 
element, remove it from the display first. 
 
You can have any number of different concordances made from the same source text and 
saved on disk. Bear in mind, though, that a full concordance is many times larger than the 
source text it derives from. Concordances can use a lot of disk space. 
 
Concordance files have the extension .Concordance added to the name of the source text. 
You can use Find Files on the Tools Menu to find all the .Concordance files on your disk.  
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These files are created by the program.  You can delete them when the program is not 
running, but you should not edit them yourself. 
 

As text 
 
Choose Save as Text on the File menu to save the loaded concordance as a plain text 
(ASCII) file.  The concordance will be saved using the viewing options which are currently 
chosen.  For example, if word frequencies, word percentages, centred contexts, and 
references are visible, they will be included in the text file. 
 
As another example, if you wanted to save only a list of headwords by itself, you would turn 
off the display of contexts (choose 'None' in the tabs down the right-hand edge of the program 
window), and then choose Save as Text.  (For a quick way to get a list of headwords, see 
Copying a list of Headwords.) 
 

As HTML 
 
Choose Save as HTML on the File menu to write a single HTML file made from the loaded 
concordance.  The concordance will be saved using the viewing options which are currently 
chosen.  For example, if word frequencies, word percentages, centred contexts, and 
references are visible, they will be included in the HTML file.  HTML Setup offers further 
options to control the way the HTML is generated and the appearance of the result. See also 
HTML Details
 

As a Web Concordance 
 
See Building Web Concordances. 
 
Note that in a Web Concordance, there has to be a reference on which to create an HTML 
link from the concordance frame to the original text. If you have created references of your 
own, they will be used for the text of the link. If you haven't, line numbers will be used, and so 
displayed in the Web Concordance, even if you have turned off the display of line numbers in 
the Context Views. 
 

As a PDF file 
 
PDF files are Adobe Portable Document Format files for use with Acrobat Reader. 
Concordance cannot produce PDF files directly but you can do so using another program. 
Instructions are here. 
 
See also Saving and restoring settings  
 
 

Renaming or moving a concordance 

 
Rename on the File menu allows you to rename text files and their associated concordance 
files easily in one operation. It also helps if you have to move a concordance to a different 
folder or distribute it to different computers. 
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Each concordance file keeps an internal note of the text file which was its source.  Hence if 
you rename a text file using another tool such as Windows Explorer and later reload the 
concordance, it will not be able to find its source text. The same applies if you move a 
concordance and its source text to a different folder.  (You could of course make the 
concordance again.)  Using Rename avoids this problem. 
 
Renaming 
 
This is useful with concordances which have been given names automatically by the 
program.  Such concordances are those made from Clipboard text and those made from 
multiple files, which have names like TextFromClipboard-File1.Txt.Concordance 
and Demo1.txtPlus3MoreFiles.txt.Concordance.  You may prefer a more descriptive 
name! 
 
Moving files to another location 
 
First, copy or move your concordance file and its source text to the new location.  Then start 
Concordance, choose Rename on the File menu, and select the source text file in its new 
location.  Type a new name.  The source text file and its concordance will both be renamed, 
and the concordance will know where to find its source text. 
 
Constraints 
 
Renaming a concordance file requires a temporary copy to be made. Hence there has to be 
enough disk space for two copies of the concordance file to exist during the renaming 
process. If there is not enough, you will be informed, and the renaming will not occur.  (The 
temporary file is automatically deleted after a successful renaming.) 
 
You cannot rename a concordance or its source text while they are open. If you try, you will 
be prompted to choose Close on the File menu first.  
 

Exporting to a PDF file 

 
If necessary, you can produce output from Concordance in the form of a PDF (Portable 
Document Format) file for use with Adobe Acrobat. The best way to do this is to obtain 
software to install in Windows that lets you create PDF files by 'printing' from any document. 
 
If you do not have such software, there is a free alternative. It is powerful but not easy to use 
or install. Hence it is probably worth obtaining only if you intend to use it repeatedly.  I cannot 
offer advice or support for this beyond what appears below. 
 
First you need a copy of GhostScript and its associated utilities.  GhostScript is a very 
sophisticated free program which enables you to view, convert, and print PostScript files.  
(PostScript is a Page Description Language used by high-quality printers.)  GhostScript is 
available from http://www.cs.wisc.edu/~ghost/ 
 
Step 1 
 
Download and install GhostScript and its accompanying programs including GSView, the 
PostScript viewer for Windows.  Find out how to start and use these tools. This is probably 
not for the faint-hearted! 
 
Step 2 
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Add a new dummy printer to your system.  GhostScript works with PostScript files, so if we 
tell Windows we want to use a PostScript-capable printer, Windows will produce PostScript 
output for us.  Go to Windows Control Panel, Printers, and choose Add Printer.  Choose any 
printer with the PS suffix - for example, the Apple LaserWriter 12/640 PS.   Connect the 
printer to the port called FILE:   - as we don't actually have this printer, we're not going to print 
to it, but capture the PostScript output to a file on disk instead. 
 
Step 3 
 
Make your concordance.  Choose Printer Setup on the File Menu to select the new PostScript 
printer.  Then choose Print to open the Print Preview dialog. Preview your printing as usual. 
When you press the Print button, you'll be asked to enter the name of a file on disk. Choose 
any name - include the path where you want the file to be stored, and add the extension .PRN 
to the name. For example, C:\My Documents\Myfile.prn. 
 
Step 4 
 
You have now finished with Concordance. Start GSView and use it to open the PRN file you 
just made.  GSView will use GhostScript to display it on screen.  Now choose Print from 
GSView's File menu.  Ghostscript uses its own printing devices, not the printers you have 
installed in Windows, so scroll through its list of devices and select the one called pdfwrite.  
This is the driver which can create an Adobe PDF file.  Select the pages you want to convert 
to PDF, press OK, and then choose a filename for your PDF file. 
 
Step 5 
 
When GhostScript has finished converting the PostScript file to a PDF file, you are ready to 
use it with Acrobat Reader or any PDF viewer. 
 

Saving and restoring settings 

 
Concordance automatically saves many of the settings and options which you choose and 
restores them the next time the program is run. 
 
Remember that options which are right for one project may be quite wrong for another.  If you 
get very unexpected results when you make a new concordance, check in particular that you 
have suitable settings in these dialogs (all on the Text menu): 
•  Alphabet   
•  References  
•  Ignore
 
 
Technical details about stored settings 
 
All settings and options are stored in a file called Concordance.Ini which is normally kept 
in the Windows directory.  (If you need to keep it elsewhere, a Windows Registry setting can 
be changed: see this topic.)  
 
If you want to restore all default settings, you can delete or rename this file when 
Concordance is not running.  It will be re-created with default options. 
 
Concordance.Ini is in standard Windows .ini file format.  If you are familiar with .ini files, 
you can edit Concordance.Ini as necessary, using a plain text editor, or view it if you 

 79



Concordance 3.3 manual  

suspect some settings may be wrong or the file may be corrupt.  Do this when Concordance 
is not running.  
 
If you want to switch between different projects with very different settings, you can keep 
copies of their .Ini files under different names.  Then, when the program is not running, 
copy the .Ini file containing the settings you want so that it overwrites the default  .Ini file. 
 

Page Setup 

 
Page Setup can be reached from the File Menu and also from the Print Preview screen.  
After making changes to Page Setup, you can press the Preview button in the Print Preview 
screen to see the effect. 
 

Text Layout 
 
You can choose whether the printed pages will have boxes drawn around contexts to make 
them stand out. You can add printed borders to the sides and/or top and bottom of the page. 
 
You can also set the amount of space reserved for a column on the right where references, if 
any, will be printed.  The larger your reserved column, the further to the left your references 
will appear (since you are reserving more space at the right of the page). 
 

Margins 
 
You can set the left, right, top, and bottom margins of the printed page in inches. 
 

Headers and Footers 
 
You can enter text to be used in headers and footers on the printed page, and optional format 
specifiers which give further control over the alignment and content of headers and footers: 
 

Alignment  
&l Left Align 
&r Right Align 
&c Centre Align 

 
Content  

&F File name and path  
&f File name only  
&d Short date  
&t Short time  
&D Long date  
&T Long time  
&I Title 
&p Page number 
&& Ampersand (&)  

 
Examples: 
 
&cMy Concordance  - displays "My Concordance", centred 
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&lMy Concordance&c&d&r&f    - displays "My Concordance" at the left, the date centred, 
and the filename at the right. 
 
See also Saving and restoring settings
 

Printing and Print Preview 

 
To print a concordance, first make sure that you display and/or select the elements you want 
to be printed and turn off the display of elements you don't want to include in the printing. 
Then choose Print from the File menu or press the Print button on the Toolbar. 
 

Print Preview 
 
When you choose Print, the Print Preview form opens. You must preview your printing by 
pressing the Preview button before you print. 
 
The Preview can be re-sized and zoomed. It can be re-positioned quickly to show any page.  
You can also call Page Setup from the Print Preview form. 
 
A large concordance can take a long time to preview and this can also use a large amount of 
memory.  If your computer will not allow you to preview and print this way, you can try other 
ways: 
•  Save your concordance as text, then open that file and print it with a word processor 
•  Save your concordance as HTML, then print it with a web browser. 
 
See Saving a concordance for more detail. 
 

What is a Web Concordance? 

 
A Web Concordance is a computer-generated concordance which has been turned into web 
pages. That is, it has been translated into HTML and split into a number of files suitable for 
use with a web browser. It can be browsed on the computer where it was created, and if 
desired can be placed on a web server and made available on an intranet or on the Internet.   
 
This program allows you to make Web Concordances of your own. 
You must have registered the program before you are permitted to make a Web 
Concordance available to anyone else. 
 
The original Web Concordances, which were created by the author of this program, are at 
http://www.dundee.ac.uk/english/wics/wics.htm .  At that site you can also find fuller 
documentation covering a brief history of concordances, the issues surrounding 
concordances on the Web, and a study of ways to implement web concordances. 
 
Why put a concordance on the Web? 
 
Concordances can be thought of as naturally hyperlinked text - perhaps the first ever example 
of hypertext - since every entry in a concordance comes with a reference which is a pointer to 
a particular location in another text, the source text of the original work.  As such, 
concordances are natural candidates for implementation in HTML.   
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They are also well suited to the Web,  which solves some of the problems of printed 
concordances and offers some further advantages: 
•  Printed concordances can be cumbersome, and are always expensive, often to the point 
where they are not viable as commercial publications. The web makes it possible to create 
specialised concordances at low cost. 
•  Web Concordances are accessible to many users simultaneously and hence suitable for 
class-based activity and student-centred learning. 
•  Editorial and software expertise is not demanded of users, who are presented with a ready-
to-use concordance instead of having to construct their own, and with a browser interface 
which is already familiar.  Thus two of the important advantages of the printed book, its ready-
made nature and its familiar usability, are brought to computer concordancing.   
•  Web Concordances supplement a basic concordance with a vocabulary list and a full 
version of the original literary text, all hypertextually linked for ease of reference. 
 
 
See also:  
What is a Concordance?
Building Web Concordances
HTML Setup
HTML Details

Building Web Concordances 

 
If you're not familiar with Web Concordances and their advantages, see What is a Web 
Concordance?
 
Making the Web Concordance 
 
To make a Web Concordance, first make your concordance as usual, or load one you made 
earlier. See Getting Started if you need help.  When your concordance is displayed, just 
choose Build Web Concordance on the File menu. The program will turn your concordance 
into a number of related HTML files and then ask you if you want to load the results into your 
web browser to view straight away. 
 
All the HTML files are placed in a folder of their own. This makes it easier to move or delete 
them all at once. The folder is named after the original text plus the extension 
.WebConcordance. It is a sub-folder of the one where your source text (and its 
concordance) are located. 
 
Refining a Web Concordance 
 
There are two ways to gain further control over the way your Web Concordance is created: 
•  Select the elements you want to include.  
•  Use HTML Setup for fine control over the way the Web Concordance files are created.  
 
See also HTML Details and Managing large files for HTML
 
Publishing a Web Concordance 
 
Remember that you must be using the registered version of the program before you are 
allowed to publish anything. 'Publish' here means place any files on a web server, even if 
only a few internal users can see them.  
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To publish a Web Concordance, copy all the .HTM files created by the program from their 
own folder to a directory on your web server. The file which starts the Web Concordance is 
always called framconc.htm and this is the file you should make a link to in order to load 
the whole Web Concordance into a web browser. 
 
If you chose to have links made using images rather than JavaScript buttons or plain text (see 
HTML Setup), you should also copy the .GIF files which you will find in the same folder as the 
rest of the Web Concordance. These files are the images used for links.  If you don't like the 
supplied images, you could substitute your own. 
 
You should review the help file which comes with your Web Concordance (help.htm) and 
adapt it if necessary. It should accurately reflect what users see when they use your Web 
Concordance, so you may need to make changes to reflect the choices you made when 
building the Web Concordance. 
 

HTML Setup 

 
HTML Setup on the File menu lets you choose options to control the way in which 
Concordance makes web pages. This applies both when saving a concordance as a single 
HTML file (web page) and when building a Web Concordance (a linked series of web pages). 
 
Using the Editable Sections page, you can directly enter or edit HTML which will be added in 
the appropriate places whenever an HTML file is created.  The reserved words %source and 
%title have special meanings in certain Editable Sections - see HTML Details. 
 
Even if you do not want to edit any HTML, you can still control the appearance of your Web 
Concordance. Using the Settings page, choose the following options. 
 
All HTML Concordances 
These options apply both to Web Concordances and to concordances saved as single HTML 
files using 'Save as HTML' on the File menu.  
 
Format Text: Contexts and references can be formatted either using HTML tables or using the 
HTML <pre> tag for pre-formatted text.  Pre-formatted text tends to load faster than tables in 
a web browser, but gives less control over appearance and may require the use of fixed-pitch 
fonts to preserve alignment of references. 
 
Column for references: If you choose pre-formatted text, you can specify the column where 
references should begin.  You will probably want to set this just beyond the length of the 
longest context line in your concordance so that all references are neatly aligned. 
 
Table border width:  If you choose tables, you can specify the width of the visual border they 
have.  A border width of zero is allowed: this makes the table borders and cells invisible but 
still formats your text neatly within the invisible cells. 
 
Web Concordances only 
The following options affect Web Concordances only. 
 
Frame style:  Choose between two pre-defined screen layouts (HTML framesets) for a Web 
Concordance.  You can further refine these as the HTML itself appears in the Editable 
Sections.  A basic guide to HTML Frames is available. 
 
Link style:  Choose a style for navigational links within a Web Concordance. Available styles 
are: JavaScript buttons; HTML links made on plain text; or HTML links made on images 
supplied with the program. 
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Source Text Format: For Web Concordances, a new copy of your source text file must be 
created which contains the HTML links to make the Web Concordance work.  (This does not 
affect the file with your original text.)   Your source text will be converted to HTML as required, 
but if it was already in HTML you should choose accordingly here. 
 
Wordlist Frame:  By turning on these options you can display word frequencies and/or 
percentages in the Wordlist Frame in a Web Concordance.  This more closely resembles the 
display in the program itself.  Note that frequencies and percentages must also be visible 
(displayed) in the Wordlist if they are to appear at all in the Web Concordance. (They will also 
appear in the Concordance Frame.) 
 
See also: 
What is a Web Concordance?
Saving and restoring settings
HTML Details
Managing large files for HTML
 

HTML Details 

 
Editable Sections 
 
Using the Editable Sections page of the HTML Setup dialog (on the File menu), you can 
directly enter or edit HTML which will be added in the appropriate places whenever an HTML 
file is created.   
 
There are two reserved words, %source and %title, which you may use in certain Editable 
Sections and which have special meanings as follows: 
 
%source : In the Framesets, %source will be replaced by the actual name of the file 
containing the HTML version of your source text.  This saves you having to alter the filename 
manually for each different project and ensures that all the HTML files in your Web 
Concordance frames are correctly linked to each other automatically. 
  
%title : In the 'Start of Header' section, %title will be replaced by the actual title 
for your Web Concordance which you have entered in the Concordance Title section.  This 
saves you having to specify your HTML title in more than one place. 
 
Controlling HTML Generation 
 
When you are working with Web Concordances or HTML files written by Concordance, you 
may find you want to alter some aspect of the way the program generates HTML. 
 
If you look at the HTML which Concordance generates, using a text editor or an HTML editor 
which allows you to examine the HTML directly, you'll see some of it is in upper case and 
some in lower case: 
•  HTML tags in upper case are fully under your control. They are part of the Editable 
Sections in the HTML Setup dialog. You can change the HTML to anything you like (including 
non-valid HTML) and Concordance's HTML generator will insert your sections in its 
generated HTML output. 
 
For example, the HTML which the program adds by default before a headword in a context is 
<B><FONT COLOR="RED">. It is in upper case to remind you it can be changed to anything 
else you want, or even omitted entirely. It's a good idea to maintain the convention and use 
upper case throughout your own changes to the Editable Sections. 
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•  HTML tags in lower case are built into the program and can't be altered by changing 
anything in the Editable Sections.  Bear in mind, though, that many of them can still be 
modified by selecting different options in the Settings section of HTML Setup, or by altering 
what's displayed on screen before you start HTML output.  If that is not sufficient, you'll have 
to edit the generated HTML yourself. 
 
If you are still using Microsoft Internet Explorer 5.0 and find your frame borders are invisible, 
see Frequently Asked Questions. 
 
See also: 
Building Web Concordances
HTML Setup
Managing large files for HTML
 

Converting HTML entities (special characters) 

 
HTML entities are the formal name for special characters in HTML, such as  
    
&Eacute; 
 
which, when displayed in a web browser, shows the character É (upper-case E with acute 
accent), or  
 
&aelig; 
 
which produces æ (the ae ligature). 
 
HTML entities are required for correct results on web pages, but the normal Windows (ANSI) 
characters are required in other Windows programs. Therefore conversion is needed when 
going from a Windows program such as Concordance to a web page such as a Web 
Concordance 
 
Concordance gives you full control over conversion from HTML entities to ANSI characters 
when a source text is read, and over conversion from ANSI characters to HTML entities when 
a concordance is exported as HTML. 
•  In the Preferences dialog (on the Tools menu) you can choose Convert HTML entities 
found in input and Convert to HTML entities during output.   
 
The default state of Convert HTML entities found in input is true, meaning that unless you 
have un-ticked this option, HTML entities found in your input texts will be converted to their 
ANSI equivalents, provided the HTML entity and its ANSI translation are found in the 
translation files (see below). 
 
The default state of Convert to HTML entities during output is also true, meaning that 
unless you have un-ticked this option, ANSI characters will be converted to their HTML 
equivalents when you save a concordance as HTML, provided the ANSI character and its 
HTML entity translation are found in the translation files (see below). 
Note: If you are using a non-Western language, you will probably want to turn off this 
option, or else define your own translations (as explained next). 
 
Installed with the program are two files Latin1toHTML.ini and HTMLtoLatin1.ini 
which define the translations between ANSI and HTML characters.  You can edit these files 
with a plain text editor such as the Multiple Document Editor which is part of Concordance.   
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You can add extra HTML entities and their corresponding ANSI characters, or you can 
change the translation of existing HTML entities.  Athough you cannot at present change the 
names of these files, they need not contain translations to and from the Latin-1 character set. 
 
If these translation files are moved, deleted, or re-named, the conversions will not take place.  
 

Managing large files for HTML 

 
When you build a Web Concordance, the program displays your source (original) text as part 
of the Web Concordance, with links into the text so that you can display a passage in the full-
text original by clicking on a line in the concordance. 
 
In order to do this, Concordance makes a copy of your source text and turns it into HTML. 
(Your original file is not altered.)  Just as the source text from which you made the 
concordance is in a single file, so the HTML version will by default be all in one file.  However, 
a really large HTML file can slow down a web browser or even overload it altogether. And the 
larger the file, the longer it will take to load across the Web if you publish your Web 
Concordance. 
 
The solution is to let the program split the HTML version of your source text into multiple 
smaller files. Chunks of around 300 to 500 lines, or 20KB to 40KB, can make a good 
compromise. But the points at which to split the file need to be chosen intelligently by you so 
as to avoid breaks in undesirable places. 
 
To define the points at which you would like your text to be split when making the HTML 
version, do this: 
 
1. Load your source text into the Multiple Document Editor 
 
2. Choose a location where it would make good sense to split the text 
 
3. Move the caret to column 1 on a blank line (create a new blank line if necessary) 
 
4. Choose Insert File Division Marker from the Edit menu 
 
5. Repeat steps 2 to 4 as often as required to define further chunks of text 
 
6. Save your file. 
 
You can now make a concordance and build a Web Concordance from it. 
 
Whenever you insert a File Division Marker, a row of characters like this will be inserted into 
your text: 
 
§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§§ 
 
When you turn a concordance into a Web Concordance, the program's HTML generator will 
start a new file at each of these points. 
 
The supplied sample file Demo4.txt (in the Sample Files folder) shows an example of using a 
File Division Marker.  
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HTML: An Elementary Introduction 

 
HTML is the language of the Web.  Hence Web Concordances are constructed in HTML. 
 
If you are happy with the control over the layout of Web Concordances which the program 
provides, you should never need to use HTML directly.  If you want to fine-tune things, you 
will need to know some HTML. A good HTML editor will make it much easier.   
 
If you know no HTML at all at present, what follows may help you just enough to get started. 
 

HTML Markup 
 
An HTML document consists of text to be displayed, plus markup to control the way it is 
displayed. 
 
The elements of HTML markup are called tags. HTML tags usually, but not always, come in 
pairs, an opening tag and a closing tag. 
 
Tags are enclosed in the 'greater than' and 'less than' symbols, "<"  ">" 
 
The opening tag of a pair of tags looks like this: <TAG>. 
 
The closing tag of a pair looks like this: </TAG>. Notice the slash. 
 

Structure of an HTML document 
 
The simplest HTML document looks something like this: 
 
<HTML> 
<Head> 
<Title>Type the title of your page here</Title> 
</Head> 
 
<Body> 
 
The main body of your page goes here 
 
</Body> 
</HTML> 
 
 
Further tags are used to control the way the text in the body of the document is displayed.  
For example, if you type   
 
This should be <B>emphasized</B> more than usual 
 
the browser will display  
  
This should be emphasized more than usual 
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There are many other constructs available in HTML, such as tables and lists.  The most 
important element, however, is the link (or hyperlink).  It is links which enable navigation in 
web pages. 
 
A simple link looks like this: 
 
<A href="destination">An interesting place</A> 
 
The browser will show this link as An interesting place and if you click on it (in a browser), the 
browser will locate and load the thing described by "destination". 
 
There are many books and websites which will let you learn more about HTML. 

HTML Frames 

 
Web Concordances are normally laid out using frames. This is a brief introduction to frames in 
HTML.  
 
Frames are a way of splitting the window of a web browser into several smaller windows.  
Web Concordances use frames in order to present the wordlist, the concordance, and the 
source text at the same time.  There are two pre-defined frame styles available in 
Concordance, but if you understand frames you can easily alter them as you please using 
HTML Setup. 
 
As some browsers do not support frames, you should always include a no-frames section 
along with your frames, even if it does no more than offer a brief apology. See below for an 
example. 
 
There are two key elements in creating frames. First you write an HTML file using the 
<frameset> tag to define how you want to split up the browser window into sections. Then you 
must supply some contents for each of the sections; each comes from a different HTML file, 
and you specify the names of those files with the <frame> tag. 
 
The <frameset> tag can define either rows or columns, depending on which option is chosen. 
If you write <Frameset rows="25%,25%,*">, you will split the browser window into three rows, 
the first two each occupying 25% of the browser's height, and the third row (marked with *) 
occupying the rest. 
 
A command of <frameset cols="25%,25%,*"> does exactly the same thing, except in this 
example, columns are defined instead of rows. 
 
You may create multiple columns and rows by nesting the <frameset> tags. Here is an 
example: 
 

<HTML> 
<Head> 
<Title>Frames Example</Title> 
</Head> 
<Frameset rows="20%,*"> 
<Frame src="toprow.htm" name="title_area"> 
<Frameset cols="20%,*"> 
<Frame src="leftcol.htm" name="menu_area"> 
<Frame src="display.htm" name="display_area"> 
</Frameset> 
</Frameset> 
<Noframes> 
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Text you place here will be seen only by those who are using a browser that does not 
support frames.  
 
</Noframes> 
</HTML> 
 

On a frames-capable browser, this example would produce a display with a title row at the 
top, a menu column at the left, and a large display area at the lower right.  
 
A set of frames like these would allow the user to choose from the menu frame amongst 
different pages. Each page chosen would be displayed in the display area, while the menu 
remained on screen. The links in the menu frame (i.e. in the file leftcol.htm) would be similar 
to this: 
 
<A href="choice.htm" Target="display_area">Make this choice!</A> 
 
When using links with frames, you have to specify a target, as above, to tell the browser 
which frame you want the linked file to be loaded into. The target uses the names for each 
frame which you defined in the frameset. 
 
To summarise: The first page sets up the frame system and ought also to provide for a non-
frame version of its contents. All subsidiary pages use the frame system that is set up in the 
first page. 
 
There is plenty more to learn about frames. See any book on HTML or look on the Web. 
 
If you are using Microsoft Internet Explorer 5.0 and find your frame borders are invisible, see 
Frequently Asked Questions. 
 
Acknowledgment: this help topic is modelled on material by Paul Lutus, creator of 
Arachnophilia, a useful HTML editor, available from http://www.arachnoid.com  
 

Program controls 

 
 

 The Main Window
 Pop-up menus
 The Wordlist View
 The Context Views
 Splitting Views
 Columns
 Languages and Character sets
 The Toolbar
 The Status Bar
 Navigating with the Keyboard
 Keyboard Commands  
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Pop-up menus 

 
You can right-click in the Wordlist View, the Scratchpad, and the Context Views to see pop-up 
menus which give quick access to some frequently-used functions for those views. 
 
The Lemmatiser also has a pop-up menu.  
 

The Wordlist View 
 
The Wordlist View shows all headwords in the concordance and can optionally show their 
frequencies of occurrence and the percentages of those frequencies.  Words can be sorted in 
various different ways, re-arranged individually, deleted, or saved and exported. 
 
Clicking on a word in the Wordlist View will display the contexts of all its occurrences in the 
Context View. You can also view the Collocations for any word. 
 
A Scratchpad enables easy editing and arranging of words in the Wordlist View using cut and 
paste and drag and drop. You can also edit words or delete them directly from the Wordlist 
View. 
 
You can click on a column header in the Wordlist View as an easy way to change sort orders.  
You can re-size and re-arrange columns and fit them to their contents. 
 
The Wordlist View supports incremental searching: just start typing a word and the view will 
re-position to show the nearest match.  Other search functions are on the Search Menu. 
 
When you save, print, or export a concordance, the headwords and their ordering will be 
those currently in the Wordlist View.  This allows word-by-word tailoring of a concordance. 
Concordance works on the general principle that if you have chosen to display something on 
screen, it will be included when you save, print, or export. So if you want to omit an element, 
remove it from the display first.  For example, if you don't want percentages and frequencies 
in a print-out, turn off the display of percentages and frequencies before you print. 
 
See also:  
Splitting Views
 

The Context View 
 
The Context View shows a context for every occurrence of the headword currently highlighted 
in the Wordlist View.  The Context View has four display options: 
•  Contexts centred on headwords  
•  Contexts left-aligned  
•  Index display (references with no contexts)  
•  No display 
 
Use the Context Tabs down the right-hand edge to switch amongst these four. 
 
Clicking on a context line will open the Viewer or Editor positioned to show that line in the full 
source text, so allowing you to browse as far as you like beyond the word's immediate 
context. 
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The source-text Viewer and Editor are concordance-aware. Double-clicking on any word in 
them will re-position the Wordlist View to display that headword. 
 
Clicking on the Context Header in the Context View is a quick way to choose a different sort 
order for contexts. You can re-size and re-arrange columns and fit them to their contents. 
 
The Context Views will not scroll to show columns containing more than 255 characters, 
although any further text is still there and will be correctly preserved when you save, print, or 
export the concordance.  This is one reason why you should make sure the lines in your file 
are of human-readable length. See Input text file format. 
 
See also:  
Splitting Views
 

Splitting the Screen between Views 

 
You can alter the split of the screen between the Wordlist View and the Context Views. Let 
the cursor hover over the join between the views; when the cursor changes into the vertical 
split cursor, drag the splitter left or right to the desired position. 
 
If the Scratchpad is on screen, the splitter will be to its left if the last split shrank the Wordlist 
View (moved its right edge leftwards), and to its right if the last split enlarged the Wordlist 
View.  To move the splitter from one side of the Scratchpad to the other, hide the Scratchpad, 
enlarge or shrink the Wordlist View using the splitter, and then show the Scratchpad again. 
•  You can also re-size and re-arrange columns and fit them to their contents.  
 

Columns 

 
Re-arranging Columns 
 
You can re-arrange the columns in the Wordlist View, the Context Views, and the Collocation 
Lists by dragging a column header to move the whole column to the left or right of an adjacent 
column.  Changes to the order of the columns are on-screen only and do not affect what is 
printed. 
 
Re-sizing Columns 
 
Columns in the Wordlist View, the Context Views and the Collocation Lists can be re-sized by 
dragging the divider between two column headers. 
 
If you double-click on the divider between two column headers, the column will re-size itself 
automatically to fit its contents. 
 
The Context Views can be set to re-size themselves to their contents automatically whenever 
the contents change.  To do this, go to the Contexts Menu, choose Fit Columns to 
Contents, and choose one of the options. 
 
Fitting Columns to their Contents 
 
See this topic. 
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Sorting 
 
Clicking on a column header is a quick way of choosing a different sort order for that view. 
 
Hiding and showing columns 
 
Various columns can be hidden or shown as required.  In the Wordlist View, these are: 
•  Frequencies  
•  Percentages 
 
and in the Context Views, they are: 
•  Line Numbers  
•  References 
 
To show or hide these columns, choose the appropriate item on the Headwords or Contexts 
menus. 
 
You can also change the split of the screen between views.  
 

The Context Tabs 
 
Choose the tabs to switch between context views: contexts centred on the headword, left-
aligned contexts, the index display (references with no contexts), or no display. 
 
The context view that you choose will be displayed immediately.  When you chose to print or 
save a concordance as text or HTML, the context view which is currently displayed will be 
used for output.   
 
If you choose to display 'None' before printing or exporting, then no contexts will be printed or 
exported. 
 

The Toolbar 
 
The buttons on the toolbar offer quick access to commonly-used functions.  If you let the 
cursor hover over a button, a flying hint will give a brief explanation of its purpose. 
 
The clickable graphic of the Main Window explains each button. 
 
If you click on a blank part of the Toolbar, it will change its position from horizontal 
(underneath the menu bar) to vertical (down the left side of the window) or vice-versa.  
 

The Status Bar 
 
The Status Bar shows information about the number of word types and tokens in the currently 
loaded concordance, as well as the sort orders which are in force for the Wordlist View and 
the Context View. 
 
You can click on a raised panel in the bottom half of the status bar to see further information 
or to change the currently selected sort. 
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The bottom right-hand corner of the Status Bar is a resize handle which you can drag to re-
size the main window.  
 

Navigating with the Keyboard 

 
When a concordance is displayed you can navigate amongst the Wordlist and Context Views 
and the source text viewer (or editor) using the keyboard instead of the mouse. 
 
To move the highlight from one word to another in the Wordlist View, use the up or down 
arrow keys. 
 
To display the contexts for the highlighted word, press the Enter key. 
 
To move to the Context Views, press the Tab key. This activates the Context Tabs at the 
right-hand edge of the program's window. Use the up or down arrows to move amongst the 
three views: Centred, Left-aligned, and None (for no contexts).   
 
Press the Enter key to enter the context view of your choice. Use the up and down arrows to 
alter the highlighted context in the context view.  Press Enter to display the source text viewer 
or editor positioned to show the highlighted context. 
 
Move the cursor in the source text viewer or editor using the standard cursor-movement keys. 
Press Control-Enter while the cursor is in a word to make the Wordlist View re-position to 
show that word. 
 
It's all a bit quicker with the mouse, assuming you are able to use one! 
 
See also: Keyboard Commands  
 

Keyboard Commands 

 
See also: Navigating with the Keyboard
 
Function Keys in the main program 

F1 Invokes Context-sensitive Help 
F3 Repeats the last find operation 
F4 Go to line (headword number) in Wordlist View 
Alt+F4 Exits the program 
F5 Makes Full Concordance from files 
F6 Makes Selective Concordance from files 
F7 Opens existing concordance 
F8 Makes Full Concordance from Clipboard text (i.e. from other Windows programs) 
F9 Makes Selective Concordance from Clipboard text (i.e. from other Windows programs) 

 
Editor: Movement Keys 

Up Moves the caret up by one line 
Shift+Up Moves the caret up by one line, extending the selection 
Down Moves the caret down by one line 
Shift+Down Moves the caret down by one line, extending the selection 
Left Moves the caret left by one character 
Shift+Left Moves the caret left by one character, extending the selection 
Ctrl+Left Moves the caret left by one word 
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Ctrl+Shift+Left Moves the caret left by one word, extending the selection 
Right Moves the caret right by one character 
Shift+Right Moves the caret right by one character, extending the selection 
Ctrl+Right Moves the caret right by one word 
Ctrl+Shift+Right Moves the caret right by one word, extending the selection 
PgDn Moves the caret down by one page 
Shift+PgDn Moves the caret down by one page, extending the selection 
Ctrl+PgDn Moves the caret to the start of the last line in the window 
Ctrl+Shift+PgDn Moves the caret to the start of the last line in the window, extending the 
selection 
PgUp Moves the caret up by one page 
Shift+PgUp Moves the caret up by one page, extending the selection 
Ctrl+PgUp Moves the caret to the start of the first line of the window 
Ctrl+Shift+PgUp Moves the caret to the start of the first line of the window, extending the 
selection 
Home Moves the caret to the start of the line 
Shift+Home Moves the caret to the start of the line, extending the selection 
Ctrl+Home Moves the caret to the start of the file 
Ctrl+Shift+Home Moves the caret to the start of the file, extending the selection 
End Moves the caret to the end of the line 
Shift+End Moves the caret to the end of the line, extending the selection 
Ctrl+End Moves the caret to the end of the file 
Ctrl+Shift+End Moves the caret to the end of the file, extending the selection 

 
Editor: Control Keys 

Ctrl+C Copies selected text to the clipboard 
Ctrl+V Pastes data from the clipboard into the current window 
Ctrl+X Cuts selected text to the clipboard 
Ctrl+Z Undoes the last edit action 
Shift+Ctrl+Z Redoes the last edit action 

 
Editor: Other Keys 

Enter Inserts a newline 
BackSpace Deletes the character to the left of the caret 
Del Deletes the current character. Or, if text is selected, deletes the selection. 
Shift+Del Deletes selected text after copying it to the clipboard 
Ins Toggles the current window between Insert and Overwrite modes 
Shift+Ins Pastes text from the clipboard into the current window 
Ctrl+Ins Copies selected text to the clipboard 
Ctrl+Shift+0-9 Set the position of marker (0-9) to the current caret position 
Ctrl+0-9 Move to the previously set marker (0-9)   

 
 

Resource Gauges 
 
The Resource Gauges show the percentage of free memory resources and disk space. On 
Windows 95/98, only the resource gauge for disk space appears. 
 
The Resource Gauges are hidden by default and can be shown by choosing Show Resource 
Gauges item on the View menu. They will appear automatically if resources run low. 
 
You should keep an eye on resources when working with very large concordances. The 
Resource Gauges' free segments turn from green to yellow to red as resources diminish. 
 
The left-hand gauge gives a general indication of free memory (RAM) as a percentage.  The 
way this is reported varies from one version of Windows to another (and is so unreliable 
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under Windows 95/98 that the left-hand gauge is not used at all.) A low figure need not 
always be a cause for concern. 
 
The right-hand gauge shows the percentage of free disk space on the default drive or the 
drive where you last made a concordance.  If you run out of disk space, you won't be able to 
do anything much until you remove some files, so take this one seriously! 

Reopen most recently used files 

 
The Reopen item on the File menu offers a list of the most recently used concordance files.  
It provides a quick way of re-opening those files.  
 
The list can be cleared if you wish: an additional menu item to do so appears when the list is 
not empty. 
 
The Reopen item does not appear when it has no files to display. 
 

Open Concordance 

 
Choose Open Concordance on the File Menu to open (load) an existing concordance file. 
 
Concordance files are created and maintained by the program.  They have the extension 
.Concordance. Don't open them with another application.  You can delete them when you 
no longer need them. 
 
You can re-make a concordance as often as you like. 
 
You can rename a concordance and its source text in one operation. 
 
You can speed up loading of a concordance - see Display while Loading
 

Revert 
 
Choose Revert on the File Menu to re-load the displayed concordance from disk. This is like 
abandoning changes in a word processor: if you have altered the wordlist by selecting or 
moving words, Revert will re-load the previously saved version, discarding the latest changes. 
 

Close 

 
Choose Close on the File Menu to close (unload) the displayed concordance. 
 
The displayed concordance will be closed automatically if you Make a new concordance. 
 

Exit 
 
Choose Exit on the File menu to end the program.  
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Open dialog box 

 
Use the Open dialog box to open a file. This may be an existing concordance, a file from 
which to make a new concordance, or another kind of file, depending on what you're doing. 
 
Look In  Lists the current directory. Use the drop down list to select a different drive or 
directory. 
Files  Displays the files in the current directory that match the wildcards in File Name or the 
file type in Files Of Type. You can display a list of files (default) or you can show details for 
each file. 
File Name  Enter the name of the file you want to load or wildcards to use as filters in the 
Files list box. 
Files of Type  Choose the type of file you want to open; the default file type is Concordance 
file (.Concordance) when opening an existing concordance and Text file (.Txt) when 
opening a file from which to make a new concordance. All files in the current directory of the 
selected type appear in the Files list box. 
Up One Level Click this button to move up one directory level from the current directory. 
Create New Folder Click this button to create a new subdirectory in the current directory. 
List Click this button to view a list of files and directories in the current directory. 
Details Click this button to view a list of files and directories along with time stamp, size, and 
attribute information. 
 

Save As dialog box 

 
Use the Save As dialog box to save a file in a new location. If the file name already exists, 
Concordance asks if you want to replace the existing file. 
 
Save In  Lists the current directory. Use the drop down list to select a different drive or 
directory. 
File Name Enter a name for the file you are saving. 
Files Displays the files in the current directory that match the file type in the Save File as 
Type combo box. 
Save As Type Choose a file extension; the default is .Concordance. All files in the current 
directory of the selected type appear in the Files list box. Note that saving a file with a 
different extension does not change the format of the file. 
Up One Level Click this button to move up one directory level from the current directory. 
Create New Folder Click this button to create a new subdirectory in the current directory. 
List Click this button to view a list of files and directories in the current directory. 
Details Click this button to view a list of files and directories along with time stamp, size, and 
attribute information. 
 

Printer Setup dialog box 

 
Here you can change printer options and select a printer from a list. To display this dialog 
box, click Printer Setup from the File menu. 
 
For more information about setting printer options, see your Windows documentation. 
 

Name Select a printer from the list box. 
Portrait Prints text across the narrowest side of the paper (e.g. 8.5" x 11"). 
Landscape Prints text along the widest side of the paper (e.g. 11" x 8.5"). 
Paper Size Specify the paper size. 
Paper Source Specify the paper tray or paper feeding method your printer uses. 
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Properties Displays the Printer properties page for the currently selected printer. 
 

The Make Full Concordance button 
 
The Make Full Concordance button on the Toolbar makes a new full concordance from files.  
 

The Make Selective Concordance button 
 
The Make Selective Concordance button on the Toolbar makes a new selective concordance 
from files. 
 

The Open button 
 
The Open button on the Toolbar lets you choose an existing concordance to open.  
 

The Save button 
 
The Save button on the Toolbar lets you save an altered concordance to disk.   
 

The Print button 
 
The Print button on the Toolbar opens the Print Preview form which lets you preview and then 
print the concordance.  
 

The Cut button 
 
The Cut button on the Toolbar cuts a highlighted word from the Wordlist to the Scratchpad.  
 

The Scratchpad button 
 
The Scratchpad button on the Toolbar shows and hides the Scratchpad which is useful for 
editing the Wordlist.  
 

The Paste button 
 
The Paste button on the Toolbar pastes a word from the Scratchpad back into the Wordlist.  
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The Left-align button 
 
The Left-align button on the Toolbar selects contexts where lines of text are aligned to the left 
of the Context view.  
 

The Centre button 
 
The Centre button on the Toolbar selects contexts where the lines are aligned centred on the 
headword.  
 

The Bold button 
 
The Bold button on the Toolbar makes the font bold in whichever list view (Wordlist or Context 
view) is active.  
 

The Italic button 
 
The Italic button on the Toolbar makes the font italicised in whichever list view (Wordlist or 
Context view) is active. 
 

The Underline button 
 
The Underline button on the Toolbar makes the font underlined in whichever list view 
(Wordlist or Context view) is active.  
 

The Word Length Chart button 
 
The Word Length Chart button on the Toolbar shows the Word Length Chart, giving statistics 
about word lengths in the concordance which is currrently loaded.  
 

The Properties button 
 
The Properties button on the Toolbar shows the Properties Box, giving details about the 
concordance which is currrently loaded.  
 

The Stop button 
 
The Stop button on the Toolbar stops the current process if it is lengthy, such as loading a 
large concordance.  
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Tools 

 
These tools are built into Concordance: 
 

 Multiple Document Editor

 Multiple File Browser

 Character Table

 Web Browser

 Filter a File

 Unix to PC File Converter

 OEM to ANSI File Converter  
 

Preferences 

The Preferences dialog on the Tools menu lets you alter various user preferences. 

There are three tabbed pages, Making Concordances, User Interface, and File Locations. 

The Making Concordances page has these options: 
•  Load Alphabet with each concordance file 
 
You can choose whether the Alphabet stored with each concordance is re-loaded whenever 
the concordance itself is re-loaded.  Re-loading an Alphabet is useful if you want to 
continue work on a previously-made concordance, but it will overwrite whatever Alphabet is 
currently in force, and this can cause unexpected results. Remember that the Pick and Stop 
List Managers may be using the user-defined Alphabet too, if you have so chosen. 
•  Choose leader character (between word and number of occurrences) 
 
You can choose the character that is used for padding between a headword and its number 
of occurrences when you save or print a concordance, like this: 
 
   THE........... 10 
 
By default this character is the full stop ('period' in American). You can change it to a space 
to make it invisible, or to any other character. 
•  Choose index separator 
 
You can choose the character that is used to separate entries in an index when exported or 
printed.  By default this is the semi-colon. 
•  Convert HTML entities found in input  and  Convert to HTML entities during output 
- these have their own help topic. 

 

The User interface page has these options: 

•  Hot Tracking in Wordlist 
 
When this option is on, leaving the cursor hovering over a word in the Wordlist will cause it 
to become the selected item after a short delay, even though you do not click on it.  When 
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this option is off, the selected item in the wordlist will change only when you click on it (or 
use the up or down arrow keys). 
 
This option was permanently on in Version 2. It is now off by default. 
 

•  Show Progress Messages and Warnings 

Previous versions of Concordance showed all progress messages while a concordance 
was being made.  Instead of 'All' you can now choose 'High Priority only' to suppress the 
Progress dialog unless significant warnings occur. 

The File Locations page has these options: 
 
You can choose where files will be placed when concordances are made from Clipboard 
text. They can be created in a folder of your choice, or else in the current folder. (The 
current folder is set by Windows and depends on what you were doing before you started 
Concordance, though you can re-set it here.) 
 
This applies only to Concordances made from the Clipboard, since Concordance has to 
make up names for such texts and there is no 'natural' place to put them.  Concordances 
made from files on your disk are always placed in the same folder as the first active file.  
See Make Concordance from Files and Make Concordances from Clipboard for more detail. 
 

 
 

Multiple document editor 

 
The multiple document editor supplied with Concordance is a text editor which can display 
and edit multiple files of up to 16MB in size.  It uses the standard Windows Multiple Document 
Interface (MDI).  Each line may be up to 32767 characters long. 
 
A concordance-aware version of the editor opens automatically for viewing and editing the 
source text when you click on any context line in the Context Views and when you have 
selected View text in Editor from the View Menu.  The editor automatically displays the line 
in the source text which you click on in the Context View. 
 
If you double-click (or press Control-Enter) on a word in the editor when it is displaying your 
source text, the Wordlist View will re-position itself to display that word, provided it exists in 
the Wordlist.  In this way you can browse through your source text in the editor and 
immediately see the concordance for any word of interest. You can even edit the source text 
and then continue to view the concordance for any other word.  Changes you make by editing 
the source text will be reflected in the concordance after you next choose Make a 
Concordance. 
 
The editor window can be re-sized by dragging its bottom right-hand corner. 
 
You can also start a stand-alone copy of the editor from the Tools Menu.  See also File 
Viewer and Keyboard Commands. 
 

Bookmarks 
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Bookmarks provide a means of moving quickly from place to place within a file. Assume that 
you are primarily interested in two sections of a text file that are widely separated, and want to 
be able to move between the two of them quickly. This can be accomplished by setting a 
bookmark at the beginning of each section, then jumping between them. 
 
To set a bookmark using the default key assignments, press <ShiftCtrlN>, where N is a 
number in the range 0 to 9. The current position of the caret is marked as bookmark N. To 
return to that spot later, press <CtrlN>, where N is the number used to set the bookmark. 
 

Tabs in the Multiple Document Editor 
 
Tab characters in the text stream are expanded to spaces (visually). The number of spaces 
used is a function of the contents of the line and the current tab size, which can be changed 
using Options | Tabs | Tab Size. The default tab size is 8.  
 
Using Options | Tabs you can choose between Fixed Tabs, Real Tabs, and Smart Tabs. 
 
If the tab type is set to Real, pressing <Tab> inserts a "real" tab character into the text stream. 
If the tab type is set to Fixed, pressing <Tab> inserts enough spaces to move the caret to the 
next tab stop. (This is called "fixed tabs" because the position of existing text will not change if 
the tab size is later changed, as it does if real tabs are used.) If the tab type is set to Smart, 
spaces are also inserted into the text stream, but the positions of the tab stops are a function 
of the positions of the words in the previous line. The following illustrates the positions of the 
tab stops when the tab type is set to Smart: 
 
previous line: This is a sample line demonstrating smart tabs.  
current line: x    x  x x      x    x             x     x             
 
The default setting is Real tabs. 
 

File Viewer 

 
Concordance has a built-in file viewer which can display text files of unlimited size.  Each 
line, however, must be no longer than 1024 characters.  (The Editor provides an alternative.) 
 
A concordance-aware version of the file viewer opens automatically for viewing your source 
text when you click on any context line in the Context Views and when you have selected 
View text in Viewer from the View Menu.  The viewer automatically displays the line in the 
source text which you click on in the Context View. 
 
If you double-click (or press Control-Enter) on a word in the viewer when it is displaying your 
source text, the Wordlist View will re-position itself to display that word, provided it exists in 
the Wordlist.  In this way you can browse through your source text in the editor and 
immediately see the concordance for any word of interest. 
 
You can also start a stand-alone copy of the File Viewer from the Tools Menu. 
 
The viewer window can be re-sized by dragging its bottom right-hand corner. 
 
The File Viewer and File Editor use fixed-pitch (monospace) fonts such as Courier New.  
 
See also: 
Multiple Document Editor
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Bookmarks 
 
Bookmarks provide a means of moving quickly from place to place within a file. Assume that 
you are primarily interested in two sections of a text file that are widely separated, and want to 
be able to move between the two of them quickly. This can be accomplished by setting a 
bookmark at the beginning of each section, then jumping between them. 
 
To set a bookmark using the default key assignments, press <ShiftCtrlN>, where N is a 
number in the range 0 to 9. The current position of the caret is marked as bookmark N. To 
return to that spot later, press <CtrlN>, where N is the number used to set the bookmark. 
 

Tab Expansion 
 
The File Viewer is designed to expand tab characters automatically to spaces when text is 
displayed on screen. This behaviour, which is enabled by default, is controlled by choosing 
Options | Tab Expansion.  If it is active, tabs are expanded. If it is inactive, tabs are treated as 
ordinary characters (their appearance on the screen depends on the font). 
 
The distance between tab stops depends on the current tab size, which you can change using 
Options | Tab Size. The default setting is 8. Changing the tab size redraws the File Viewer's 
window to reflect the change  
 

Find Files 

 
Choose Find Files on the Tools menu to call up the standard Windows Find Files dialog.   
 
This lets you search your computer for files. 
 

Web Browser 

 
Choose Web Browser on the Tools Menu to start the Web browser on your computer and go 
to the home page you have configured. 
 
If this function fails, check that the computer has a correctly configured web browser and that 
it is registered with Windows to handle HTML files. 
 
You will automatically be offered the choice of starting your web browser after choosing Build 
Web Concordance or Save as HTML on the File Menu.  In this case the newly-built Web 
Concordance or HTML file will be displayed in your browser. 
 
If you make a large concordance and turn it into HTML, it may be bigger than your web 
browser can handle.  If you save a large concordance as a single HTML file, be prepared for 
a long wait when you load it into your web browser. Typically the web browser loads your 
whole HTML file and then appears to lock up for some time - in fact it is building HTML links 
at this stage.  I have seen this take as long as five minutes. 
 
Web Concordances allow you to overcome this problem by splitting files.  
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If you have chosen to format your HTML concordance with tables, the web browser has to 
load your whole HTML file before it can display anything.  Your browser may appear to lock 
up for a long time when the concordance is almost fully loaded - in fact, it is working out the 
appearance of the table.  To avoid these long delays, go to HTML Setup and choose to 
format your concordance with <pre> instead of with tables. 
 

Email the author 

 
Choose Email the author on the Help menu to send e-mail to the author of Concordance. 
 
Or use this link:  R.J.C.Watt@dundee.ac.uk  
 
This function calls your mail program (which may be part of your web browser) with a 
<mailto:> argument. If it fails, check that your computer has a correctly-installed mail program 
(or web browser that is capable of sending e-mail). 
 
I don't guarantee to be able to reply to every e-mail I receive, particularly those which ask 
questions already answered in this help file. But all e-mail is read and considered carefully. 
 
Concordance is the work of one person, not a company. It is supported on a best-effort 
basis, i.e. as time permits, and purchasing the program does not confer a right to support.  I 
do my best, though. 
 
Please read Feedback and Support before sending e-mail. 
 

Filter a file 

 
 
Filter a File lets you strip unwanted text or markup out of a file. 
 
It lets you use Concordance's text processing power to make a new version of your text file 
instead of making a concordance. 
 
You could use it, for example, to strip all the HTML (web) mark-up out of a file, leaving only 
plain text; or to strip out references, comments, and other mark-up which you may have 
added for use with Concordance. 
 
It can also be useful for understanding how Concordance is treating your text if you are 
having problems choosing the correct options. 
 
Any warnings or other messages when filtering the file are shown in the Progress dialog.  
When the new filtered file has been created, it is displayed in the File Viewer. 
 
Example: Stripping HTML  
 
To remove all HTML (web) markup from a file, leaving only the text content, go to the Text 
menu, choose Ignore, and for Skip Markers 1, enter < as the opening marker and > as the 
closing marker.  Then choose Filter a File.   
 
In this case, the same result could be achieved by opening the References dialog on the Text 
menu, defining  <  as the opening reference marker and  >  as the closing reference marker, 
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then choosing Filter a File.  This is because Filter a File, like Concordance's usual text 
processing, strips out anything between reference markers. 
 
To remove HTML entities (special characters) as well as HTML markup between angle 
brackets, tick Convert HTML entities found in input in the Preferences dialog before 
filtering your file. 
 

Details 
 
Here in detail is what Filter a File does. 
 
It reads your input file and writes a new output file (named automatically by adding the 
extension .Filtered to the name of your input file), performing the following actions: 
 
1. Warns of long lines in the input  
 
2. If you have ticked Convert HTML entities found in input in the Preferences dialog, HTML 
entities will be translated to ANSI characters where those are defined in your file 
HTMLtoLatin1.ini.  (Step 9 below, if selected, will undo this, so there is no point in 
selecting both for filtering a file.) 
 
3. Removes any text you have defined in the Ignore dialog on the Text menu (that is, text 
between skip markers or text from selected positions on the line, or both)  
 
4. Removes any control characters found in the file  
 
5. Trims any leading and trailing spaces in each line  
 
6. Removes characters not defined in your Alphabet, unless you have chosen the option in 
the Alphabet dialog which causes such characters to be added automatically to your 
alphabet. For more information, see the Alphabet dialog on the Text menu. 
 
7. Translates OEM (DOS) characters to ANSI (Windows) characters if you have selected that 
option in the Alphabet dialog on the Text menu 
 
8. Removes any text found between reference opening markers and reference closing 
markers, if any are defined in the References dialog on the Text menu. 
 
9. If you have ticked Convert to HTML entities during output in the Preferences dialog, 
ANSI characters will be translated to HTML entities where those are defined in your file 
Latin1toHTML.ini.  (Step 2 above, if selected, will do the reverse of this, so there is no 
point in selecting both for filtering a file.) 

Unix to PC File Converter 

 
This tool can be started from the Tools Menu and is also a stand-alone program. It converts 
text files from Unix to PC format and vice-versa by translating the characters used to mark 
line endings.  See Input Text File Format for more details on Unix versus PC files. 
 
The File Converter is particularly useful if the text you want to make a concordance from is all 
on a single line because it was prepared on a Unix system.  You should convert such a file, 
then make your concordance from the converted version. 
 
Concordances can be made from Macintosh files without any conversion. 
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OEM to ANSI File Converter 

 
This tool can be started from the Tools Menu and is also a stand-alone program. It converts 
text files from OEM to ANSI character sets and vice-versa. 
 
This is an advanced tool.  You should probably ignore it until you have tried making a few 
concordances to your text.  
 
It is useful if the text you want to make a concordance from was prepared on a DOS system 
and special (extended) characters are displaying incorrectly in Windows.  You can convert 
such a file, then make your concordance from the converted version. 
 
You can achieve the same effect without actually converting your source text, since 
Concordance can do the conversion on the fly as it reads your text.  You can turn on this 
option in the Alphabet dialog on the Text menu.  Try this before going to the trouble of making 
a permanently converted version of your file with the File Converter. 
 
Caution! 
 
Because of complex differences between character sets, the effects of conversion are not 
always reversible.  That is, going from one character set to another and back again can 
produce a file with different characters from the original. 
 
Be sure to take a backup copy before converting. 
 

Frequently Asked Questions 

 
- and, more usefully, frequently given answers! 
 
Use these links to go to different questions and answers: 
 
Getting Started
Using text
Big Files
How many input files can I have?
 
How do I ... 
...show which part of the text a word comes from?
...have numbers in references?
...change the order in which references are displayed?
...suppress quotation marks?
...show compound words?
...exclude words from another text?
...find the words that are common to several texts?
...get the sort order I want?
...stop lines being too long?
...make smaller concordance files?
...group parts of speech together?
...save headwords and frequencies only?
...match line numbers in Concordance with Word?
...set the line number with which to begin a concordance?
...limit the number of words of context before and after the headword?
...search for words beginning with capital letters?
...sort capital letters separately from lower case?
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...add multiple files in the correct order?

...search for more than six phrases at once?

...move my registered copy of Concordance to a new computer?
 
Using different languages and accented characters
Copying results from Concordance
Using Concordance output with other programs
A Messed-up screen
Can't click on centred contexts
Web Concordances

_______________________________________ 

Getting Started 
Question: What is the easiest way to buy Concordance? 

Answer:  On-line, with a credit card, at the Concordance website See How to Buy for more 
information. 

Question: Is it safe to use my credit card on the Internet? 

Answer:  If you follow the secure link on the online registration page, nobody can intercept 
your credit card information. It is handled by machine and the process is much safer than 
letting your credit card out of your sight in a shop or restaurant. But if you are not convinced, 
you can place your order by phone. Full details are available at the online ordering site. 

Question: I do not have a credit card. Can I register Concordance? 

Answer: Certainly. Please see How to Buy for more information. 

____________________________________________________ 
Back to Top

Using text 
 

Question: Do I have to type in the text I want to use with Concordance? 

Answer:  No, Concordance can use any plain text file on any disk that Windows knows 
about - which may include disks on other computers in your network neighbourhood.  It can 
also use text which you have open in any other Windows program that can copy text to the 
Windows Clipboard. Most can. 

If you want to use text from a website on the other side of the world, just display the page in 
your web browser, select and Copy it, then make a concordance from the Clipboard. Or, if 
you prefer, you can save the web page to a file on your disk first.  If you want to use a word 
processor file, you can again use the Clipboard, or if you prefer, save the file as plain text 
(often called ASCII text) first. 

Question: How do I make a concordance from a Microsoft Word file? 

Answer:   There are two ways to use a MS Word file: 

1. With your file displayed in Word, press Control-A, then Control-C.  This copies all the text to 
the Windows Clipboard. Then in Concordance use 'Make Full Concordance... from 
Clipboard'.  

2. In Microsoft Word, save your file as 'Plain text' (in Word 2002; choose the option to insert 
line breaks) or 'Text Only with Line Breaks' (in older versions of Word). Close Word, then in 
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Concordance choose 'Make Full Concordance ... from Files' and open the text file you saved 
from Word.   

Big Files 
 

Question: How big a file can Concordance handle? 

Answer:  As big as you like, more or less, provided you have enough free space on your 
disk. Remember that a full concordance can easily be ten or twenty times as big as the text it 
is made from. So if you want to handle very big texts, make sure you have lots of free disk 
space and prepare for a long wait!  Or reduce the size of your concordance (see below, 'How 
do I get Concordance to make smaller files?'). 

Back to Top

How many input files can I have? 
 

Question: I am using multiple input files. How many files can I use? 

Answer:  The File List you create is stored in your Concordance.ini file.  From Version 3.0, 
Concordance should be able to handle really large .ini files, even on Windows 95/98, which 
normally limits them to 64K.  So you should be able to have a very large number of files in 
your File List. 

Back to Top

How do I ... 

...show which part of the text a word comes from? 
 
Question: My text comprises several different documents (or authors, or pages, or sections). 
How do I distinguish between them in the finished concordance? 
Answer: Use references. They are one of the most powerful aspects of the program. 

...have numbers in references? 
Question: Why are there no numerals in my references? 
I've set up references in my text such as 'Page 1 line 5'. But the numerals don't appear in the 
concordance and all my references just say 'Page line'. 
 
Answer: You must add the numerals 0 to 9 to your alphabet. You can edit the Alphabet 
yourself, or you can tell Concordance to add characters automatically to your Alphabet as it 
reads your text.  If you do neither of these things, then characters in your source text which 
are not in your user-defined alphabet will be removed entirely from your concordance, even if 
they occur inside reference markers. 
 
Back to Top
 

...change the order in which references are displayed? 
 
Question:  My reference categories are P,B,S and L. I'd like them to appear in that order 
since I've set them up with commas so that they should read (for example) Measure for 
Measure, Act II, the Duke, Line 186.  In the References dialog I entered the categories in the 
correct order, but when I made the concordance it displayed them in the wrong order (LPBS).  
Is there some way to change this?  
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Answer:    Concordance will use the order in which it first encounters reference categories. 
Try arranging things so that a P reference is the very first one encountered in your text, 
followed by a B reference, etc.  If necessary, include an empty P reference to get you started. 
An empty reference looks like this:  <P > 
 
Back to Top

...suppress quotation marks? 
 
Question: How do I stop any word that has a quotation mark in front of it (e.g. 'Ah, 'But, 
'Can) showing up at the top of the headword list with the quotation mark attached to it? 
 
Answer:  Switch the Wordlist sort from 'Alphabetic Ascending (string)' to 'Alphabetic 
Ascending (word)'.  The words will be sorted as if the quotation marks were not there, so 'Ah 
will appear next to Ah. 
 
If, on the other hand, you don't want a separate entry for 'Ah (that is, if you don't want the 
quotation marks to appear at all) you need to remove the quotation marks from your Alphabet  
-- remember the Alphabet is user-defined -- and also choose not to have them added back 
into the Alphabet automatically. To do this, open the Alphabet dialog on the Text menu, edit 
the quotation mark out of the Alphabet, then for 'Characters not in Alphabet, when found in 
text' choose 'Ignore' instead of 'Add to Alphabet'. 
 
This will mean all quotation marks are stripped from around words.  
 
You may still have a problem if your text has two different entities -- the apostrophe to indicate 
an elision (possessive), and the single quote to indicate speech -- encoded using the same 
symbol. Either it is in your Alphabet or it is out: you can't have it both ways. This is a very 
common cause of difficulty in text analysis and the only cure is to use unambiguous symbols 
in your text. For example, use double speech marks for quotations, and save apostrophes for 
possessives and elisions. 

...show compound words? 
 
Question: How do I get Concordance to show compound words?  
 
Answer:  Include the character which joins the parts of the compound word (usually a hyphen 
in English) in your user-defined Alphabet, and make sure that character is not included as a 
Word Separator in the Alphabet dialog.  Concordance will recognise the compound words 
automatically. 
 
If you want to split compound words up into their separate parts, add the hyphen to your Word 
Separators.  This would turn to-morrow into to and morrow. 
 
If you want to join compound words into a single word (for example, turning to-morrow into 
tomorrow), omit the hyphen from both the Alphabet and the Word Separators, and make 
sure you have not chosen to add characters automatically to the Alphabet. 
 
If you want to-morrow and tomorrow to be sorted next to each other, as if the hyphen was 
not there, change the Wordlist sort from 'Alphabetic ascending (string)' to 'Alphabetic 
ascending (word)'. 
 
If you have words split by hyphens at the ends of lines, the program will not re-assemble 
them. 
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See also this topic. 
 
Back to Top
 

...exclude words from another text? 
 
Question:  How do I make a list of all the unique words in a text file EXCLUDING (against) all 
the words of another text file?  To put it another way, can I compare two texts to see which 
words are in one text and not in the other? 
 
Answer:   First, make a concordance to your second file (the one containing the words you 
want to exclude).  When the wordlist is displayed, right-click on it and choose 'Copy all words 
to Clipboard'.  Then open the Stop List and choose Paste to paste in all your words.  Then 
make a concordance to your first file using the Stop List.  This concordance will contain all the 
words which are in the first file except for those which are also in the second file. 
 
You can extend this general approach as you wish. If you use the Pick List instead of the Stop 
List, you can make a list of all the words in one file which are also in another. 
 
Going one step further, you could make a single concordance to a series of texts except for 
the last text, then use that list of words as input when making a concordance to the last text.  
Using the Pick List, this would show those words in the last text which occur in at least one of 
the earlier texts. Using the Stop List, this would show those words in the last text which have 
never been used before. 

...find the words common to several texts? 
 
Question:  How do I make a list of all the words that are common to several texts, with their 
frequencies in each text? 
 
Answer:  Let's assume you have five texts. Make separate full concordances to each of your 
texts one at a time. Save the wordlist, with frequencies, from each one to a separate new file. 
Now make a full concordance to those five new files (the ones containing the wordlists with 
frequencies). When making this new concordance, in the Make Full Concordance dialog, 
under Filename References, tick "Add filenames as refs." 
 
Your new concordance has all the information you need.  Sort the headword list first by 
alphabet, then by frequency.  Now all words with frequency 5 are words that occur in all 5 
texts; all with frequency 4 in only 4 texts, etc.  Clicking on a headword will make the context 
view display the number of occurrences of that word in each individual text, with a reference 
to identify the text. 
 
This approach -- making a concordance to concordances, in effect -- is sometimes quite 
useful; but like recursion in maths and programming, it can take a little while to think out. 

...get the sort order I want? 
 
Question:  How do I apply more than one sort order?  For example, I'd like to sort contexts 
by the word before and the word after the headword at the same time. 
 
Answer:   Sorts take effect cumulatively.  So you can first sort contexts by the word after the 
headword, then sort them again by the word before the headword.  The result will be that 
contexts which are equal on the primary (i.e. current) sort criterion (word before headword) 
will be arranged in order of the secondary (i.e. previous) sort criterion (word after headword).  
There is a fuller explanation of cumulative sorting here. 
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Back to Top
 

...stop lines being too long? 
 
Question:  How can I stop files from my word processor having extremely long lines when 
viewed in Concordance? 
 
I am converting my word processor files by saving them as plain (ASCII) text for use with 
Concordance. But when I click on a line in Context, and the Text View opens, that line in 
Text View goes on almost forever, as if the right margin had been extended much too far.   
 
Answer:  Most word processors treat each paragraph as a single long line. That way, they 
can wrap lines whenever necessary to your chosen margins.  You need to choose a 
conversion which respects line-breaks.  In Microsoft Word, save your file as 'Text only with 
line breaks' instead of 'Text only'.  (In Word 2002, an option to save a file as text with line 
breaks does not appear when you choose 'Save as...''  Instead, you can choose to save as 
Plain Text; an additional dialog will then appear which allows you to select an option to 'insert 
line breaks'.)  
  
If your word processor really cannot do something like this, you can open the saved ASCII file 
with a plain text editor, such as the one which comes with Concordance, and add the line 
breaks (carriage returns) that you want. 
 
Back to Top
 

...make smaller concordance files? 
 
Question: How do I get Concordance to make smaller files?  I am making a concordance to 
a big text and the concordance file is huge. 
 
Answer:  Here are some suggestions: 
•  Employ a stop list, as cutting out (say) a dozen high-frequency words can halve the final 
size of the concordance.  
•  Use contexts of selected length and go for very short contexts, such as only one word 
before and after the headword.  You can even choose zero words before and after. 
•  If your file is still too big, make a Selective Concordance instead of a Full one. 
 
Back to Top
 

...group parts of speech together? 
 
Question: How can I find a way to group together all instances of prepositions, determiners, 
and pronouns in a text in order to see how significant the grammatical texture is as a subset 
of the total lexis? 
 
Answer:  Prepare a lemma file with every preposition you can think of as a child of the same 
parent.  In the same lemma file, make another entry for conjunctions - again enter all the 
conjunctions, and make them all the child of one parent.  Do the same for any other 
categories of interest. 
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As for the choice of parent, you could use a very common preposition, conjunction, etc, but of 
course if it happens not to occur in a text, no lemmatisation will get done.  So it is better to 
choose a dummy entry as the parent: a word which will never occur naturally in your files. For 
example: 
 
Conjunclist 
  -- and 
  -- but 
 
ArticleList 
-- a  
-- the 
 
and so on. 
 
Add each of the dummy parent words (conjunclist, articlelist, etc) to each file you are going to  
analyse. Then make your concordance and lemmatise it. This brings all the words of each 
category together.   
 
Now the clever bit.  Adding those dummy words to each of your texts makes the statistics 
(e.g. word percentages) slightly wrong.  So with the concordance displayed and lemmatised, 
carefully delete each dummy word from the headword list, then choose 'Recalculate statistics' 
on the View menu. 
 
Back to Top
 

...save headwords and frequencies only? 
 
Question: How can I export just the headwords and their corresponding frequencies to a file, 
without the concordance contexts?  
 
Answer:   Just turn off the display of contexts before you export.  To do this, click 'None' at 
the bottom-right corner of the context display, or go to the Contexts menu and choose 'None'. 
 
Concordance works on the general principle that if you turn off the display of some element, 
it is not included when you export. 
 
Another way is to right-click on the Headwords display, then choose 'Copy all words to 
Clipboard' from the pop-up menu.  Then you can paste the headwords and frrequencies into 
any other Windows program. 
 
For more information, see this help topic: 'Selecting elements to include'. 
 
Back to Top
 

...match line numbers in Concordance with Word? 
 
Question: I don't seem to be able to get my line numbers in Concordance to match the line 
numbers in MS Word. Can it be done?  
 
Answer:   Yes. After you have used Word to add automatic line numbers (File | Page Setup | 
Layout | Line Numbers), get Word to save a copy of the file as 'MS-DOS text with line breaks' 
instead of a Word document.  Then close the file in Word and make a concordance to that 
file.  Concordance shows the correct line numbers as in Word. 
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For this purpose, don't use Concordance's ability to grab text by copying from Word via the 
clipboard.  This way, the line numbers will seldom match, since the places where Word wraps 
the lines within a paragraph depend on so many variable factors - your chosen margins at 
that point in the Word document, the style and size of font, etc. None of that information has 
meaning outside of Word and doesn't get transmitted via the clipboard.  Hence Concordance 
won't know exactly where Word wrapped 
each line. (Hmmm...) 
 
Back to Top
 

...start my concordance at a line number ? 
 
Question:  Can I concord together two separate sections of a text while omitting the rest, and 
still reference all words with their correct line numbers?  I have marked up my text with line 
number references, like this: <L xxxx>. 
 
Answer:   Yes. Add a new reference, with any old content, at the start of the section you want 
to include. E.g. <S section>  Then set the S reference empty at the end of what you want, e.g. 
<S >.  This can be repeated as often as you like, with <S section> coming again later in the 
text.  Then make a Selective Concordance selecting text by reference, picking all text where 
reference category S has the value 'section'.  You can of course also have the L references, 
for line numbers, collected and displayed. 
 
Another approach is to make a Selective Concordance using sampling of consecutive words. 
This, however, requires you to specify the word numbers, rather than the line numbers, with 
which to stop and start selecting.  You can use Concordance itself to establish the word 
number of your starting point, to save you counting manually: this is done by showing 
duplicate words separately (see the Headwords menu) and sorting in order of occurrence. 
 
 
Back to Top
 

...limit the number of words of context before and after the headword? 
 
Question:  How can I set or limit the number of words before and after the search word? 
 
Answer:    Choose Context Styles on the Text menu, then switch Context Type from 'actual 
line' to 'selected length' and choose a length. 
 
 

...search for words beginning with capital letters? 
 
Question:  Is it possible to search for certain words beginning with CAPITAL letters only?  
 
Answer:   Yes. You need a Regular Expression Search.  
 
To enter a regular expression, go to the Text menu and choose Configure Regular 
Expression search, or open the Make Selective Concordance dialog and press the Edit button 
next to Regex. 
 
A Regular Expression which will find words beginning with capital letters is 
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    [A-Z][a-z]+ 
 
-- assuming your desired alphabet is the Roman A to Z, of course. 
 
You can read more about this in the Help topic on Regular Expressions. 
 
Back to Top
 

...sort capital letters separately from lower case? 
 
Question: Can one distinguish capitals and lower case in the sort? 
 
Answer:  Yes: on the Text menu, choose Special, then 'Treat upper and lower case 
separately.'  When the concordance is displayed, apply the sort you want. 

...add multiple files in the correct order? 
 
Question:  Is there a way to input files for concordancing in the sequence that one finds -- 
e.g., chapter 1 before chapter 2 before chapter 3, etc., instead  of in the reverse order?  
 
Answer:  If you select multiple files (control-click) in the Choose Input Files dialog which 
opens when you press Add Files (and which is standard Windows) it does, annoyingly, add 
them backwards. Complaints to Mr. Gates, I believe. You can overcome this by adding the 
last one first and working up the list instead of down it.  The approved Windows method, 
however, is to press the Details button in the Choose Input Files dialog, then click on the 
Name column header while holding the shift key. This sorts files in reverse name order. Then 
when you select multiple files with control-click, they end up in the right order again.  
 
If your files do end up in the wrong order in Concordance's Make Concordance from Files 
list, they can be re-arranged by dragging and dropping, though obviously that's a nuisance if 
you have a lot of files. 
 
Once you have the files in the order you want, Concordance will use that order to 
concatenate and concord them. 
 

...search for more than six phrases at once? 
 
Question: How can I search for more than 6 phrases at once? Concordance limits the 
phrase search to 6 items at a time. 
 
Answer:  A work-around is to use a text editor to alter your text, doing a search and replace 
to turn all occurrences of each phrase into a long compound "word". So for example the 
phrase "evidentiary due process" would become "evidentiary_due_process".  Then put your 
"words" into the Pick List and make a Selective Concordance using the Pick List. (This works 
because the Pick List can handle any number of words at once, but each must be a single 
word.) 
 

...move my registered copy of Concordance to a new computer? 
 
Question: I have got a new computer. How do I move my registered copy from the old 
computer to the new?  
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Answer:  See this help topic and scroll to the section 'Moving to a new computer'. 
 

Back to Top

Using different languages and accented characters 
Question: My non-English characters are not showing up in my concordance. 

Answer: On the Text menu, choose Alphabet. Add the characters you want to your user-
defined Alphabet, or tick the box to have Concordance add them automatically when making 
the concordance.  

Question: I went into Text, Alphabet and added the accented characters I need, but they are 
still not recognised.  

Answer:  Your texts may have been prepared in ASCII (the old DOS character set) instead of 
ANSI (the Windows character set).  In the Alphabet dialog, try ticking the box 'Translate OEM 
characters to ANSI'. 

If you look carefully at the Progress dialog which appears while the concordance is being 
made, you can see just which characters are being found in your source text but have not 
been added to your Alphabet. 

Question: Why can't I sort words with accented characters? 

My text has words with accented characters. I have declared them in the alphabet and they 
appear correctly in the Wordlist. But a word like À appears at the end of the Wordlist after ?.  
How do I make it appear next to ? instead? 

Answer:  Change the Wordlist sort from 'Alphabetic ascending (string)' to 'Alphabetic 
ascending (word)'. 

Question:  Why does the Stop List remove some characters from words when it reads in a 
file I created?  For example, 'NËT' is in my file but it becomes 'N' and 'T' on separate lines. 

Answer: The Stop List and the Pick List can use either a default English Alphabet or your 
user-defined Alphabet.  On the Options menu of the Stop List or Pick List Manager, choose 
'User-defined Alphabet' and then press 'Edit Alphabet' to add the characters you want. 

Question: I am using a non-Western language. Everything displays fine in Concordance, but 
when I make a Web Concordance or HTML file, the wrong characters appear (I get garbled 
special European characters). Why? 

Answer:  Go to Tools > Preferences > Miscellaneous and un-check 'Convert to HTML entities 
during output'. There is also a page here in the help system that may be useful. 

Question: I have tried pressing 'Switch Keyboard' in the Language and Font Control. Why 
doesn't my computer respond? 

Answer:  If you have an older version of Windows, you perhaps haven't yet installed the 
Windows support for any extra languages other than your usual language.  In Windows 98, go 
to Windows Control Panel, choose Keyboard, then look at the Language tab. (In Windows 
NT, go to Windows Control Panel, choose Regional Settings, then look at Input Locales). It 
will list the installed languages.  If a language you want is not installed, you can press the Add 
button to install it.  However, this is a mere convenience, not a necessity. For example, if you 
install French as an additional language to English, it will allow you to turn your keyboard into 
a French layout (AZERTY instead of QWERTY, etc.).  But Concordance will still handle 
French texts without that. 
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Back to Top
 

Copying results from Concordance 
 
Question: I want to copy a few result screens with a headword, contexts, and references, not 
the whole concordance.  Is there a way to do this? 
 
Answer: Just make a Selective Concordance, picking only the words you want.  Then you 
can print the results, or save them as text or as HTML. 
 
Before doing this, you might wish to rename your full concordance or move it to another 
folder, to prevent it being over-written when you make a Selective Concordance to the same 
text.   
 
 
Question: Is there a way to copy the headword list on the left of the screen? 
 
Answer:  Three alternative ways: 
•  Right-click on the Wordlist and, from the pop-up menu, choose 'Copy all words to 
Clipboard'.  Then paste them into any other program of your choice. 
•  On the Edit menu, turn on Multi-select. Select all the words you want, and then choose 
'Copy to Clipboard'. 
•  You can also save a list of headwords to a file. First, turn off the display of contexts by 
clicking on the tab marked 'None' at the right-hand edge of the screen.  Then choose 'Save as 
text' from the File menu.  The headword list will be saved to a file of your choosing.    
 
You can include or exclude frequencies and percentages along with your headword list by 
showing or hiding them (using items on the Headwords menu) before you copy to the 
Clipboard or save to a file.   
 
Similarly you can print headwords only, by turning off the other elements of the display before 
printing. 
 

Back to Top

Using Concordance output with other programs 
Question: How can I use a wordlist from Concordance with Excel, the Microsoft 
spreadsheet? 

Answer:  Here's how to do it in Excel 2000: 

1. Save the wordlist in Concordance - turn off the display of contexts and then choose File -> 
Save as Text. (Some users find they get even better results by choosing Save as HTML 
instead.) 

2. Use Excel to open the file you just saved. Excel will start its Text Import Wizard. In Step 1 
of the Wizard, choose the Delimited file type.  In Step 2 of the Wizard, select the delimiter 
'Other' and enter a full stop ('period' in American) for that delimiter.  Also tick the box 'Treat 
consecutive delimiters as one'.  

If you want to import a whole concordance (including contexts), not just a list of headwords, it 
is probably best to choose the Fixed Width rather than the Delimited file type. 
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Question: Is it possible to paste the Word Length Chart to Microsoft Word? 

Answer:  Yes, the same way as for any Windows program.  Copy the chart by holding the Alt 
key and pressing the Print Screen key.  Then paste into Word. 

Back to Top

A Messed-up screen 
Question: Why does the Wordlist display on my computer sometimes get messed up, with 
gridlines on top of the words instead of between them, after I select words individually with the 
tickboxes or use the Lemmatiser? 

Answer:  All drawing on the screen is done by Windows, not by Concordance, which merely 
asks Windows to draw standard Windows elements.  So this problem is not under my control.  
It often occurs after lemmatising the headword list. 

Re-loading the concordance usually cures the problem. If you don't want to do that, you can 
try turning off Show Gridlines (on the Headwords menu), switching the Wordlist to a larger 
font, and then reverting to the original font size.  Some combination of these actions often 
helps. You can also check that you have the latest version of the Windows Common Controls, 
and the latest drivers for your video (graphics) card.  This may or may not be a permanent 
cure for the problem! 

Back to Top

Can't click on centred contexts 
Question: Why does nothing happen (instead of the text view opening) when I click on a line 
in the centred context view? 

Answer:  Your computer has a very old version of the Windows Common Controls. If your 
version is too old, the symptoms include the following: (1) when you click on a line in 
Concordance's centred context view, nothing happens; (2) when you start Concordance, 
there are no gridlines visible in the Headword list or the context views, even though you have 
selected Show Gridlines on both the Headwords and the Contexts menus.  See Windows 
Common Controls for full information on how to update your computer. 

Back to Top
 

Web Concordances 
 
Question: Why does my Web Concordance have buttons in the top frame with numbers 
instead of letters on them? 
 
Answer:  If you have sorted your wordlist by frequency, the navigator frame lets you jump to 
words of a particular frequency instead of words beginning with a particular letter.  It looks 
strange at first, but makes sense if you think about it. 
 
Question: Why does my web browser seem to freeze when I load a concordance that I have 
turned into HTML? 
 
Answer:  If you make a large concordance and turn it into HTML, you may have a fairly long 
wait when you load it into your web browser. If you have chosen to format your HTML 
concordance with tables, the web browser has to load your whole HTML file before it can 
display anything.  Your browser may appear  to lock up for a long time when the concordance 
is almost fully loaded - in fact, it is working out the appearance of the table.  To avoid these 
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long delays, go to HTML Setup and choose to format your concordance with <pre> instead of 
with tables. 
 
Web Concordances allow you to overcome slow loading problems by splitting files.  
 
Question: Why do my Web Concordances have invisible frame borders when viewed with 
Microsoft Internet Explorer 5.0?  
 
Answer:  Because Microsoft kept doing things to make Netscape look bad...  To be specific, 
Internet Explorer 5.0 treats the border size specifier in the <FRAMESET> tag differently from 
previous versions and from Netscape.  
 
To make your frame borders re-appear, just omit the border size specifier. So, instead of 
 
<FRAMESET BORDER=3 BORDERCOLOR=""BLUE"" ROWS=""50%, 50%""> 
 
use 
 
<FRAMESET BORDERCOLOR=""BLUE"" ROWS=""50%, 50%""> 
 
This is now the default in Concordance, but if you have upgraded to a new version of the 
program, the border sizes will be stored as one of your preferences, and you will have to edit 
the Editable Sections in HTML Setup. 
 
Back to Top
 

Feedback and Support 
 
Feedback 
 
Feedback is always appreciated.  Sugestions for features to be included in later versions of 
the program are very welcome.   
 
I also greatly value hearing from users about the purposes for which they are using 
Concordance. This helps me judge how to develop the program, what is already good about 
it, and what needs improving. 
 
Please send all comments and suggestions, even though they may seem insignificant, to the 
address below. 
 
Support 
 
This program is the work of one person, not a company. Support is on a 'best effort' basis.  
That means I'll always do what I can, but I don't guarantee to be able to help. If that is the bad 
news, the good news is that your questions and comments go straight to the person who 
wrote the whole program, instead of to some person who knows nothing except how to 
answer a telephone and read from a script. 
 
Registered users have priority when it comes to support. That means if you have paid for 
the program, I will answer you before I answer someone who hasn't! 
 
Please look in the help file before asking questions about the way the program works 
or how to use it.  Remember that context-sensitive help is available in the program by 
pressing F1 at any time.  
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All support is via e-mail.  I read and carefully consider all e-mail received, but at busy times I 
may not always be able to respond as fully as I'd like. My address is below. 
 
Reporting Bugs 
 
Please see Troubleshooting and its linked help topics before reporting a bug. 
 
When reporting problems, please include the following information: 
 
1. Is the problem reproducible?  If so, how? 
2. What version of Windows are you running?  For example, Windows Vista, Windows XP, 
etc. 
3. What version of Concordance are you running?  Select About from the Help menu, then 
click on the Version Info button.  Please include the entire version number in your problem 
report. 
4. If a dialog box with an error message was displayed, please include the full text of the 
dialog box, including the text in the title bar. 
5.   Include a copy of the file Concordance.Ini from your Windows directory. Take a copy 
of the file straight after a run of Concordance which manifests the problem. For more 
information on concordance.ini, see Saving and restoring settings and Alternative 
location for .ini file. 
6.   If the problem occurs while making a concordance, do the following:  
(i)  include the text file from which you made the concordance, or the portion of it which 
causes the problem; 
(ii) choose Progress of Last Run from the View menu, press the button to copy its contents 
to the Clipboard, then paste it into your message. 
7.   If it is easier to illustrate the problem rather than explain it, consider including a screen 
shot, or a URL where I can view one. 
 
Concordance is Copyright © R.J.C. Watt 1999 - 2009 
 
Please send all comments, questions, feedback and bug reports to: 
R.J.C.Watt@dundee.ac.uk    
 

Technical Topics 

 

  Input Text File Format

  Performance and speed issues

  Troubleshooting

  Error Messages

  Character Sets

  System Requirements

  Installing, Upgrading, and Uninstalling

  Saving and Restoring settings

  Older versions of Windows  
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Performance and speed issues 

 
Speed issues 
•  Often, the most time-consuming thing Concordance has to do is not making a large 
concordance but loading it into the Wordlist View after it is made.  This is entirely owing to the 
performance limitations of the standard Windows Listview.  Any complaints to Microsoft 
please! 
 
See Display while Loading for ways to reduce the time taken to load a concordance before it 
can be worked with. 
•  Setting the Wordlist View from read-only to editable or back again causes Windows to do 
lots of housekeeping which can take quite a while. 
•  Choosing contexts for each headword which are many words long will greatly increase the 
size of the concordance, take longer to make, use more disk space and memory, and make 
the concordance slower to load. 
•  Concordances are made faster if you choose contexts which are the actual line, not a 
selected number of words, provided the lines in your text are of human-readable length. 
•  If your concordance results in a huge concordance file, you need to limit the length of 
contexts. The best way to do this depends on whether your text has short lines (say, up to a 
dozen words per line, like a book) or longer ones.   If your text has short lines, choosing 
Actual Line for your context will be enough to ensure things don't get too big (this is also best 
for speed).  If your text has long lines, choose Selected Length for your contexts and limit the 
length to a few words before and after the headword. 
•  A large input file which is all on one line will be very slow to process and will produce very 
cumbersome results. See Input text file format  
•  Depending on the network, you may find it is much slower to make concordances to texts 
on network disks.  This is because Concordance uses Windows disk caching services which 
Windows cannot provide for remote (network) drives.  If you encounter this, the solution is to 
move your source texts to a local hard disk and make concordances there. 
•  Contexts of Selected Length are slower to make than contexts which are the Actual Line. If 
you need Contexts of Selected Length, you can minimise the slowdown by choosing short 
contexts (for example, just two or three words before and after the headword). 
 
 
Memory issues 
 
Viewing the source text in the editor uses considerably more memory than viewing it in the 
browser. 
 
Turn on the Resource Gauges to monitor the amount of free memory. 
 
The Viewer versus the Editor - pros and cons 
•  The Viewer can display files of unlimited size, but lines must not be longer than 1024 
characters. 
•  The Editor can display files of up to 16 MB, and lines may be up to 32767 characters long. 
•  The Viewer uses a modest, fixed amount of memory whatever the size of the file it 
displays.  
•  The Editor loads the whole file into memory, and therefore requires a large amount of 
memory when editing a large file. 
 
 
 
 

 119



Concordance 3.3 manual  

Web Concordances - Browser performance 
 
If you make a large concordance and turn it into HTML, it may be bigger than your web 
browser can handle.  If you save a large concordance as a single HTML file, be prepared for 
a fairly long wait when you load it into your web browser. Typically the web browser loads 
your whole HTML file and then appears to lock up for some time - in fact it is building HTML 
links at this stage.  I have seen this take as long as five minutes. 
 
Web Concordances allow you to overcome this problem by splitting files.  
 
If you have chosen to format your HTML concordance with tables, the web browser has to 
load your whole HTML file before it can display anything.  Your browser may appear to lock 
up for a long time when the concordance is almost fully loaded - in fact, it is working out the 
appearance of the table.  To avoid these long delays, go to HTML Setup and choose to 
format your concordance with <pre> instead of with tables. 

Troubleshooting 

 
Remember that the options and settings which are right for one source text may be quite 
wrong for another.  If you get very unexpected results when you make a new concordance, 
check the following. 
 
If the headwords in your concordance are not what you expected, make sure you have 
suitable settings in these dialogs (all on the Text menu): 
•  Alphabet 
•  References  
•  Ignore
 
Many of these settings have complex interactions which affect the output.  If you are not sure 
what is going on, change one setting at a time, re-make your concordance, and note what is 
different about the results.  This is the best way to work towards getting exactly the 
concordance you want. Remember that context-sensitive help is available by pressing the F1 
key. 
 
If your get strange characters in your concordance, see Character Sets. 
 
If characters are missing from your concordance, check your alphabet: remember that 
characters in your source text which are not in your user-defined alphabet will be removed 
entirely from your concordance, unless you have chosen to have them automatically added.  
They will be removed even if they occur inside reference markers. Note too that if numerals 
are not in your alphabet, you must add them (manually or automatically) if your text or your 
references contain numerals which you want to keep. 
 
If you are using a Stop List and you get no output, check you have not put an asterisk as a 
'word' in the Stop List: it matches everything and so stops all words being kept. 
 
If your concordance has contexts which are not what you expected, start by checking 
settings in the Context Styles dialog on the Text menu. If that does not help, make sure your 
source text is in the right format. 
 
If Concordance is taking a long time to do something, see Performance Issues. 
 
If you get I/O Error messages, see Error Messages. 
 
If you can't make a concordance, or can't print one, make sure you have not run out of disk 
space or memory. Use Windows Explorer to check for free disk space. Turn on 
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Concordance's Resource Gauges to keep a watch on free memory, or choose Memory 
Usage from the Help menu. 
 
If a problem persists, try deleting the file Concordance.Ini which is in your Windows folder. 
You should do this while the program is not running.  This will cause the program to forget 
your recent settings.For more information on concordance.ini, see Saving and restoring 
settings and Alternative location for .ini file. 
 
If the buttons on the toolbar do not have a correct appearance, or if you cannot re-arrange 
column headers by dragging them, see Windows Common Controls Library. 
 
If you are sure your problem is caused by a bug in the program, see Feedback and Support. 
 
See also: Technical Topics  
 

Error Messages 

 
Most error messages in the program try to be self-explanatory. 
 
I/O Errors are errors while doing Input or Output - that is, while the program is reading or 
writing files. If you get an I/O error, it should have an explanatory message such as 'File is in 
use by another program' or 'Disk is full'.  Correct the problem and try again.  If you still get 
persistent I/O errors after correcting such problems, you should stop the program and re-start 
it. Then check that all options on the Text menu, such as your user-defined alphabet, are still 
set sensibly.  If necessary, re-make the concordance which was giving trouble. 
 
Another possible cause of I/O errors is when your concordance no longer reflects your source 
text if you have edited the source text since making the concordance.   You should stop the 
program, re-start it, and re-make your concordance so that it reflects the most recent version 
of your source text. 
 
Remember you should not edit .Concordance files directly as these are managed by the 
program. 
 
If troubles persist, try deleting the file Concordance.Ini which is in your Windows folder. 
You should do this while the program is not running. This is the file which stores your current 
settings. Ini files can occasionally become corrupt. After deleting it you will need to re-enter 
your settings, particularly the options on the Text menu.  (If you are familiar with Ini files you 
could try fixing it with a text editor while Concordance is not running.)  For more information 
on concordance.ini, see Saving and restoring settings and Alternative location for .ini file. 
 
See also :  Troubleshooting  
 

Character Sets, Main Reference 

 
Computer character sets are a Tower of Babel.  It is not necessary to understand all the 
complexities in order to use Concordance, and it is a good idea to avoid the complications as 
far as possible. But if you are having difficulties with strange characters or while working with 
different languages, the following reference information should shed some light. 
 
Remember that Concordance is not a Unicode program. Because it is written to work on all 
versions of Windows, it uses the ANSI (Windows) character set. Unicode files need 
conversion before they can be used. 
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ASCII Character Set   
MS Windows ANSI Character Set
Extended Character Sets   
Extended Character Set (ECS) on the PC
Entering Extended Characters with Alt-Num
Unicode: A Universal Character Set   
The ISO-Latin-1 Character set: European Characters on Web Pages   
•  Character sets according to Microsoft   
•  Languages, locales, and keyboard layouts - terminology
 
Acknowledgments: Some of the reference information on character sets is derived from 
materials originated by Hewlett-Packard and subsequently placed in the public domain.  
Information about Microsoft systems is derived from Microsoft publications. 
 

ASCII Character Set 
 
The ASCII character set defines 128 characters (0 to 127 decimal). This character set is a 
subset of many other character sets with 256 characters, including the ANSI character set  of 
MS Windows and the IBM PC Extended Character Set of DOS, and the ISO Latin-1  
character set used by Web browsers.  
 

The Control Characters    
 
The first 32 values are non-printing control characters, such as Return and Line feed. You 
can generate these characters on the keyboard by holding down the Control key while you 
strike another key. As they are generally of use only to programmers, they are not listed here. 
  
Printing Characters   
 
The ASCII characters you can see on screen and paper are listed below. Their numerical 
values are given in decimal and in hexadecimal: the latter is useful to identify a character 
using the File Viewer in hex mode. 
 
Char    Dec    Hex    Description 
 
SP       32      20      Space  
!        33      21      Exclamation mark  
"        34      22      Quotation mark (&quot; in HTML)  
#        35      23      Cross hatch (number sign)  
$        36      24      Dollar sign  
%        37      25      Percent sign  
&        38      26      Ampersand  
'        39      27      Closing single quote (apostrophe)  
(        40      28      Opening parentheses  
)        41      29      Closing parentheses  
*        42      2a      Asterisk (star, multiply)  
+        43      2b      Plus  
,        44      2c      Comma  
-        45      2d      Hypen, dash, minus  
.        46      2e      Period  
/        47      2f      Slant (forward slash, divide)  
0        48      30      Zero             
1        49      31      One  
2        50      32      Two  
3        51      33      Three  
4        52      34      Four  
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5        53      35      Five   
6        54      36      Six  
7        55      37      Seven  
8        56      38      Eight   
9        57      39      Nine  
:        58      3a      Colon  
;        59      3b      Semicolon  
<        60      3c      Less than sign (&lt; in HTML)  
=        61      3d      Equals sign  
>        62      3e      Greater than sign (&gt; in HTML)  
?        63      3f      Question mark  
@        64      40      At-sign  
A        65      41      Uppercase A  
B        66      42      Uppercase B  
C        67      43      Uppercase C  
D        68      44      Uppercase D  
E        69      45      Uppercase E  
F        70      46      Uppercase F  
G        71      47      Uppercase G  
H        72      48      Uppercase H  
I        73      49      Uppercase I  
J        74      4a      Uppercase J  
K        75      4b      Uppercase K  
L        76      4c      Uppercase L  
M        77      4d      Uppercase M  
N        78      4e      Uppercase N  
O        79      4f      Uppercase O  
P        80      50      Uppercase P  
Q        81      51      Uppercase Q  
R        82      52      Uppercase R  
S        83      53      Uppercase S  
T        84      54      Uppercase T  
U        85      55      Uppercase U  
V        86      56      Uppercase V  
W        87      57      Uppercase W  
X        88      58      Uppercase X  
Y        89      59      Uppercase Y  
Z        90      5a      Uppercase Z  
[        91      5b      Opening square bracket  
\        92      5c      Reverse slant (Backslash)  
]        93      5d      Closing square bracket  
^        94      5e      Caret (Circumflex)  
_        95      5f      Underscore  
`        96      60      Opening single quote  
a        97      61      Lowercase a  
b        98      62      Lowercase b  
c        99      63      Lowercase c  
d        100     64      Lowercase d  
e        101     65      Lowercase e  
f        102     66      Lowercase f  
g        103     67      Lowercase g  
h        104     68      Lowercase h  
i        105     69      Lowercase i  
j        106     6a      Lowercase j  
k        107     6b      Lowercase k  
l        108     6c      Lowercase l  
m        109     6d      Lowercase m  
n        110     6e      Lowercase n  
o        111     6f      Lowercase o  
p        112     70      Lowercase p  
q        113     71      Lowercase q  
r        114     72      Lowercase r  
s        115     73      Lowercase s  
t        116     74      Lowercase t  
u        117     75      Lowercase u  
v        118     76      Lowercase v  
w        119     77      Lowercase w  
x        120     78      Lowercase x  
y        121     79      Lowercase y  
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z        122     7a      Lowercase z  
{        123     7b      Opening curly brace  
|        124     7c      Vertical line  
}        125     7d      Closing curly brace  
~        126     7e      Tilde (approximate)  
DEL      127     7f      Delete (rubout), cross-hatch box  
  
 

ANSI Character Set 
 
Windows uses the ANSI Character Set   
 
Windows 3.x and Windows 95 support the ANSI character set, which includes 256 characters, 
numbered 0 to 255. Values 0 to 127 are the same as in the ASCII character set.  Values 128 
to 255 are similar to the ISO Latin-1 character set, but there are extensions and 
incompatibilities.   
 
You can enter any ANSI character into a Windows application. If you see it on the keyboard, 
just press it. Even if it isn't on your keyboard, you can still enter it using a special Alt-Num  key 
sequence.   
 
Unfortunately, this ANSI character set is incompatible with the ECS character set  used by 
DOS. For example, the British pound symbol is code 163 in ANSI, but code 156 in ECS. 
Worse still, ANSI does not include many of the ECS symbols, particularly the line drawing 
characters. If you try to display a DOS document in Windows, Windows attempts to convert 
the ECS characters to ANSI. Any character that does not convert is replaced by an arbitrary 
graphic. Therefore a round-trip conversion from DOS to Windows and back will not re-create 
the original document.   
 
Windows NT uses the 16-bit Unicode character set, which covers scripts in use by major 
living languages, including the far east, plus dead languages which are in widespread 
scholarly use. Windows 95 still uses the 8-bit ANSI character set, but is a transition toward 
Unicode (32-bit OLE uses Unicode and Cairo includes some Unicode as well).  
 

Extended Character Sets 

 
Extended characters are those which are not in the standard ASCII character set, which uses 
7-bit characters and thus has values 0 to 127. ASCII Codes 0 to 31 and 127 are non-printing 
control characters, while codes 32 to 126 match the keys on a US keyboard ("a", "A", etc.).   
 
Using 8 Bits Gives You an Extra 96 Characters   
 
Since computers store characters in 8-bits, many uses have been found for the extra 128 
values, most commonly for European characters such as A with Grave accent (À). Actually, 
only 96 of the codes are used -- values 128 to 159 are not assigned Graphics, just as 0 to 31 
are reserved for non-printing control characters.   
 
 
UNIX Character Sets   
 
UNIX is based on Teletype technology, so it frequently restricts you to 7-bit characters. When 
UNIX follows the lead of any CRT, it is the DEC VT-100, as in line drawing characters.   
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DOS Uses All 8-Bits, Some Twice Over   
 
DOS uses the 8-bit IBM PC Extended Character Set (ECS). DOS follows the lead of IBM in 
using the concept of Code Pages, which provide Graphics for the non-printing control 
character codes as well (happy faces and other dingbats).   
 
Microsoft Windows 3.1 uses the 8-bit ANSI Character Set, which is incompatible with the 
DOS character set, but based on the ISO Latin-1  character set. DOS and Windows support 
Alt-Number for entering extended characters.   
 
To further complicate things, Asian character sets require 16 bits, so Windows NT uses 16-bit 
Unicode internally for all character values.  
 
 

ECS Extended Character Set 
 
DOS uses the IBM PC Extended Character Set, or ECS for short. The lower 128 values are 
the same as the ASCII character set, but values 128-255 map into the European characters 
differently from other character sets, including that used on Windows.   
 
One odd thing about ECS is that codes 0-31 and 128-159, which are assigned to non-printing 
control functions such as Return and Line feed, are also assigned special graphics for use in 
contexts where control functions are not needed. That is how you get happy faces and arrows 
in ECS displays and line-drawing characters as well as European characters. Here are the 
graphic symbols for character codes 1 to 31 (normally ^A, the SOH character, through ^_, the 
US character):   
 
1 = White happy face   
2 = Black happy face   
3 = Heart   
4 = Diamond   
5 = Club   
6 = Spade   
7 = Black bullet   
8 = White circle in Black square   
9 = Black outline circle   
10 = White outline circle   
11 = Male   
12 = Female   
13 = Note   
14 = Chord   
15 = Sun   
16 = Right button   
17 = Left button   
18 = Up-down arrow   
19 = Double exclam   
20 = Paragraph   
21 = Section   
22 = Thick horizontal line   
23 = Up-down arrow, down underlined   
24 = Up thin arrow   
25 = Down thin arrow   
26 = Right arrow   
27 = Left arrow   
28 = Left corner   
29 = Circle with line through   
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30 = Up button   
31 = Down button   
 

Entering Extended Characters 

 
DOS and Windows allow you to create Extended Characters such as y-umlaut with the help 
of a numeric code. To enter any character from the IBM PC Extended Character (ECS), which 
is standard on DOS, hold down the Alt key  while you enter the 3-digit decimal code. For 
example, Alt-152  is y-umlaut in ECS. 
 
The situation in MS Windows is more complex. You can still use Alt  plus a 3-digit ECS code 
as in DOS, but only if the character exists in the ANSI Character Set used by Windows. 
Windows then converts the character from the ECS code to the equivalent ANSI code. For 
example, y-umlaut is entered as Alt-152 but is translated to decimal 255. Or you can enter 
the ANSI code, but must convert it to 4-digits by preceding it with a 0 (zero). Thus Alt-0255 is 
also y-umlaut.    
 
Be sure to use the Numeric Keypad when keying in an Alt-Number and remember to engage 
the Num Lock key.   
 
To find the 4-digit Windows code for a character, use the Character Map applet of the 
Accessories drawer. Select some font, such as Arial, click on the character you want, then 
note the 4-digit code displayed at the bottom of the window.   
 
 
 

Unicode Character Set 
 
Unicode is a 16-bit character set designed to cover all the world's major living languages, in 
addition to scientific symbols and dead languages that are the subject of scholarly interest. It 
eliminates the complexity of multi-byte character sets that are currently used on UNIX and 
Windows to support Asian languages. Unicode was created by a consortium of companies 
including Apple, Microsoft, HP, Digital and IBM and merged its efforts with the ISO-10646 
standard to produce a single standard in 1993. Unicode is the basis for the versions of 
Windows that follow from Windows NT: Windows 2000, XP, and Vista.  Concordance is not a 
Unicode program. Because it is written to work on all versions of Windows, it uses the ANSI 
(Windows) character set. Unicode files need conversion before they can be used. 
 
Unicode is a 16-bit character set where all characters occupy the same space. The first 256 
values are the same as the ISO-Latin character set, which is also the basis for the ANSI 
Character set used in Windows 3.1 and Windows 95. But Unicode goes on to define 34,168 
distinct coded characters. In most character sets a single value is often assigned to several 
characters. For example, in ASCII a "-" is used to represent a hyphen, a minus sign, a dash 
and a non-breaking hyphen. In Unicode each meaning is given its own code. The Unicode 
standard contains only one instance of each character and assigns it a unique name and 
code value. It also supports "combining" accent characters, which follow the base character 
that they are to modify.   
 
For more information on Unicode, visit the Unicode Web Site.   
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ISO-Latin-1 Character Set 
 
Characters in Web Pages   
 
Web pages allow you to specify European characters from the ISO Latin-1 Character Set 
(8859-1). This standard also served as the basis for the ANSI  character set of MS Windows, 
but naturally Microsoft extended and improved their version so that it doesn't exactly follow 
ISO Latin-1. Only the characters in ISO Latin-1 are guaranteed to be supported on an Internet 
Web site. When a Web browser, such as Netscape, formats a Web page on a client system, 
such as Windows, it maps the ISO Latin-1 characters as best it can into the native character 
set. It may be that some desirable characters such as the Trademark or Copyright can be 
coded into a Web page and displayed in Windows, but that is only an accident. If the 
character is not in ISO Latin-1 standard, it appears as garbage on another client system.   
 
There are two ways of specifying extended characters in an HTML document: &#xxx; and 
&name;   
 
Ampersand, Crosshatch, ISO decimal code, Semicolon   
 
For example, "a" with grave accent is decimal 224 in the ISO Latin character set. Therefore in 
HTML  "à" can be coded as &#224; where 224 is the decimal  code in the ISO Latin-1 
character set.   
 
Ampersand, Mixed-case name, Semicolon   
 
For example, "a" with grave accent (à) can be coded &agrave; in HTML.   
 
 

Character Sets according to Microsoft 
 
This information is derived from Microsoft's summary of differences in character sets and is 
acknowledged as theirs. 
 
Character Sets Used by Fonts 
 
All fonts use a character set. A character set contains punctuation marks, numerals, 
uppercase and lowercase letters, and all other printable characters. Each element of a 
character set is identified by a number.  
 
Most character sets used in Windows are supersets of the U.S. ASCII character set, which 
defines characters for the 96 numeric values from 32 through 127. There are five major 
groups of character sets:  
•  Windows   
•  Unicode™   
•  OEM (original equipment manufacturer)   
•  Symbol   
•  Vendor-specific  
 
 
Windows Character Set 
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The Windows character set is the most commonly used character set in Windows 
programming. It is essentially equivalent to the ANSI character set. The blank character is the 
first character in the Windows character set. It has a hexadecimal value of 0x20 (decimal 32). 
The last character in the Windows character set has a hexadecimal value of 0xFF (decimal 
255).  
Many fonts specify a default character. Whenever a request is made for a character that is not 
in the font, Windows provides this default character. Many fonts using the Windows character 
set specify the period (.) as the default character. TrueType fonts typically use an open box as 
the default character.  
 
Fonts use a break character called a quad to separate words and justify text. Most fonts using 
the Windows character set specify that the blank character will serve as the break character.  
 
Windows version 3.1 added 24 characters to the Windows code page, as shown in the 
following table.  
 
Character Name   Windows character code 
 
‚  base line single quote  130  
ƒ  florin    131  
„  base line double quote  132  
…  ellipsis    133  
†  dagger    134  
‡  double dagger   135  
ˆ  circumflex   136  
‰  permille    137  
Š  S Hacek   138  
‹  left single guillemet  139  
Œ  OE ligature   140  
'  left single quote   145  
'  right single quote  146  
"  left double quote   147  
"  right double quote  148  
•  bullet    149  
-  en dash    150  
¾  em dash   151  
˜  tilde    152  
™  trademark ligature  153  
š  s Hacek   154  
›  right single guillemet  155  
œ  oe ligature   156  
Ÿ  Y Dieresis   159  
 
 
It should be noted that the characters for left and right single quote were first added to the 
character set for the release of Windows version 3.0.  
 
Unicode™ Character Set 
 
The Windows ANSI character uses 8 bits to represent each character; therefore, the 
maximum number of characters that can be expressed using 8 bits is 256 (2^8). This is 
usually sufficient for Western languages, including the diacritical marks used in French, 
German, Spanish, and other languages. However, Eastern languages employ thousands of 
separate characters, which cannot be encoded by using a single-byte coding scheme. With 
the proliferation of computer commerce, double-byte coding schemes were developed so that 
characters could be represented in 8-bit, 16-bit, 24-bit, or 32-bit sequences. This requires 
complicated passing algorithms; even so, using different code sets could yield entirely 
different results on two different computers.  
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To address the problem of multiple coding schemes, the Unicode standard for data 
representation was developed. A 16-bit character coding scheme, Unicode can represent 
65,536 (2^16) characters, which is enough to include all languages in computer commerce 
today, as well as punctuation marks, mathematical symbols, and room for future expansion. 
Unicode establishes a unique code for every character to ensure that character translation is 
always accurate.  
 
OEM Character Set 
 
The OEM character set is typically used in full-screen MS-DOS® sessions for screen display. 
Characters 32 through 127 are usually the same in the OEM, U.S. ASCII, and Windows 
character sets. The other characters in the OEM character set (0 through 31 and 128 through 
255) correspond to the characters that can be displayed in a full-screen MS-DOS session. 
These characters are generally different from the Windows characters.  
 
Symbol Character Set 
 
The Symbol character set contains special characters typically used to represent 
mathematical and scientific formulas.  
 
Vendor-Specific Character Sets 
 
Many printers and other output devices provide fonts based on character sets that differ from 
the Windows and OEM sets -  for example, the Extended Binary Coded Decimal Interchange 
Code (EBCDIC) character set. To use one of these character sets, the printer driver 
translates from the Windows character set to the vendor-specific character set.  
 

Languages, Locales, and Keyboard Layouts 

 
Here are explanations of some of the Windows terminology relating to language and 
keyboard support. This material is acknowledged as Microsoft's, though I have corrected their 
spelling mistakes. 
 
A language is a natural language, such as English, French, and Japanese. A sublanguage 
is a variant of a natural language that is spoken in a specific geographical region, such as the 
English sublanguages spoken in Great Britain and the United States. Win32-based 
applications use values, called locales, to uniquely identify languages and sublanguages. 
Applications typically use locales to set the language in which input and output is processed. 
Setting the locale for the keyboard, for example, affects the character values generated by the 
keyboard. Setting the locale for the display or printer affects the glyphs displayed or printed. 
Applications set the locale for a keyboard by loading and using keyboard layouts. They set 
the locale for a display or printer by selecting a font that supports the given locale. 
 
A keyboard layout not only specifies the physical position of the keys on the keyboard but 
also determines the character values generated by pressing those keys. Each layout has an 
associated locale which identifies the current input language and determines which character 
values are generated by which keys and key combinations.  
 
In general, a Windows user can associate any input language with a given physical layout. 
For example, an English-speaking user who very occasionally works in French can set the 
input language of the keyboard to French without changing the physical layout of the 
keyboard. This means the user can enter text in French using the familiar English layout. 
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System Requirements 

 

Operating systems 
 
Concordance is for Windows Vista, XP,  NT 4.0,  98, and ME.  All program development is 
currently done on Windows XP and some functions may work differently under other versions 
of Windows.   
 
There is no native version for the Macintosh, but some users report that Concordance runs 
well on the Mac using a PC emulator, though it is likely to run much slower than on the PC.  
See Tips for Mac Users. 
 

Hardware 
 
The minimum amount of RAM required will depend on the configuration of your system. As 
with Windows in general, the more RAM, the better it will work.  Recent computers will have 
ample RAM. On very old computers, 32 MB might be regarded as a sensible minimum. 
 
The program uses around 4MB of disk space when installed.  However, making 
concordances to large texts can quickly use very large amounts of disk space and this should 
be borne in mind. 
 
Your graphics adaptor must be capable of at least 65536 colours. 
 
Windows Common Controls 
 
The program will not work correctly if you have a very old version of the Windows Common 
Controls. Please see this topic.  
 

Tips for Mac Users 

 
There is no native version of Concordance for the Mac, but Mac users run it successfully 
using PC emulator software. For example, Virtual PC running on top of Macintosh OS 9 is 
known to work well.  However, as Concordance is extensively optimised for Windows and 
the Intel processors, it does run much slower on the Mac. 
 
One minor issue is known at present when Concordance is run on the Mac with Virtual PC. 
When trying to make a concordance of multiple files which are in a folder external to Virtual 
Windows, an 'I/O Error 123' dialogue appears. This does not happen when making a 
concordance of one file. The simple solution is to copy the files to within the Windows 
system.  
 
Thanks to Peter Ruthven-Stuart for this tip.  
 
 

Installing, Upgrading, Moving, and Uninstalling 
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Installing 
 
You should have received the program in its distribution archive as a self-extracting file, or 
possibly a ZIP file.  If not, you can download it: see Getting the latest version.  
 
To install: 
 
Run the file you downloaded. You will be guided through the installation. 
 
If you received a ZIP file, you will need to unzip it before running the installation file it 
contains. If you are not familiar with ZIP files, see ZIP Files below for help. 
 

Upgrading to a later version 
 
Just download and install the new version.  In other words, follow the instructions above: the 
same procedure as for a first installation.  If you have paid for and registered the program, it 
will still be registered after you upgrade, provided you do not uninstall the existing version 
before installing the upgrade.  Upgrades are free of charge to registered users for the 
foreseeable future. 
 
Your recent settings will normally be preserved when you upgrade. If you want to be on the 
safe side, before upgrading you can make a spare copy of Concordance.Ini which you will 
find in your Windows directory. For more information on concordance.ini, see Saving and 
restoring settings and Alternative location for .ini file. 
 

Moving to a new computer 
 
If you get a new computer in the future and want to use Concordance on it, do exactly the 
same as you did when you first obtained the software: first download and install the 
unregistered version on the new computer, then apply your registration key. If you install and 
register Concordance on a new computer, you must also delete it on the old computer so 
that nobody can use it without a licence. 
 
The only files you need to transfer to the new computer, as opposed to installing afresh, are 
your own texts and concordances, and any other materials you made such as Pick and Stop 
Lists, Lemma files, etc. You also need your registration key and the instructions for 
using it that came with your registration e-mail.  
 
After Concordance is working on the new computer, it is also possible to transfer all your 
current Concordance settings if you wish.  They are all stored in the file concordance.ini in 
the Windows folder.  But in general I'd recommend not bothering to transfer this file, as it 
contains many references to file locations which may well be different on the new computer.  
By all means have a look in the file with a plain text editor to help make a judgment. For more 
information on concordance.ini, see Saving and restoring settings and Alternative 
location for .ini file. 
 

Uninstalling 
 
Caution: after you have registered your copy of the program, uninstalling it will mean 
you lose your registered copy.  Hence you should keep your registration details carefully in 
case you need to re-enter them after re-installing. 
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To uninstall, open Windows Control Panel and choose Add/Remove Programs. The program 
should appear in the list of software which Windows can automatically remove. Select the 
program and press the Add/Remove button.  The Uninstall program will do its stuff. 
 
In certain circumstances the automatic uninstaller may be unable to remove a few files.  If you 
really want to be sure you have expunged every trace of the program, you can check that the 
following things no longer exist and delete them yourself if necessary: 
•  the folder where you installed the program - usually C:\Program Files\Concordance - 
and its sub-folders; 
•  the file Concordance.Ini in your Windows directory; 
•    registry entries under the key 
HKEY_LOCAL_MACHINE\SOFTWARE\RJCW\Concordance 
 
(Don't edit the Windows registry unless you are familiar with what to do.) 
 
Zip Files 
 
You may have received the program as a ZIP file. Windows Vista and XP can handle ZIP 
files. If you are not using them, you need a program such as the following to unzip the file:  
 
WinZip (a Windows program); or  
PKUNZIP (a program which runs from the MS-DOS Command Prompt). 
 
Both are available on many download sites.  
 

Older versions of Windows  
 
Concordance will not be fully functional if your computer has a very old version of the 
Windows Common Controls (also known as the Windows Custom Controls Library.) This file 
is part of Windows.  
 
This should only affect users -- if any still exist -- of Windows 95 (v4.00.950) or Windows NT 
4.0 (without Service Pack 1 or greater) who have not installed Microsoft Internet Explorer 4.0,  
5.0, or 6.0. 
 
More detail 
 
If your version is too old, the symptoms include the following: (1) when you click on a line in 
Concordance's centred context view, nothing happens; (2) when you start Concordance, 
there are no gridlines visible in the Headword list or the context views, even though you have 
selected Show Gridlines on both the Headwords and the Contexts menus. 
 
Version 4.72 or later of the Windows Common Controls is required if Concordance is to offer 
full functionality.  This version is part of Windows 98 and Microsoft Internet Explorer 4.0.  If 
you already have either of these, or later versions, you should not need to update.   
 
If you have Windows 95 (v4.00.950) or Windows NT 4.0 (without Service Pack 1 or greater) 
and have not installed Microsoft Internet Explorer 4.0,  5.0, or 6.0, you may need to update. 
 
You can check your current version yourself as follows. Use Windows Explorer (or Find on 
your Start menu) to find the file comctl32.dll in your Windows system directory. Right-
click the file, choose Properties, then Version. If the file version is 4.72 or later, you do not 
need to upgrade. 
 

 132



Concordance 3.3 manual  

To upgrade to the latest version if required, Microsoft recommends that you install a recent 
version of Internet Explorer.  If you do not wish to do so, you can instead download and run 
the program 50Comupd.exe from Microsoft's website.   
 
50Comupd.exe is Microsoft's official update for the Windows Common Controls and will 
safely update the file comctl32.dll on your system if required, renaming the old version to 
comctl32.bak.  
 

Web links, Bibliography, Acknowledgments 
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Web Links and Bibliography 

 
This is a brief selection of further materials and resources relevant to concordancing, both 
printed and on-line. 
 
See also: Sources of Electronic Text
 
On-line materials 
•  The Concordance website.  See in particular the page 'Getting started with text analysis - 
tutorials and practical exercises' which has links to high-quality material written by users of 
Concordance. 
•  The Web Concordances.  The original Web Concordances.  Copyright (c) R.J.C. Watt 
1996-2009.   
•  (Report on) The Web Concordances, JISC Technology Applications Programme (JTAP) 
Report 025, August 1998. A report of around 12,000 words about the issues involved in 
producing electronic concordances for use on the Web. Available at 
http://www.dundee.ac.uk/english/wics/casemain.htm
  
The links below were valid in December 2008 but may have changed since. 
•  An introduction to concordancing by Willard McCarty, King's College London: 
 
The basics of concording  --  
http://www.cch.kcl.ac.uk/legacy/teaching/av1000/textanalysis/concord.html
 
Method in text-analysis -- 
http://www.cch.kcl.ac.uk/legacy/teaching/av1000/textanalysis/method.html
 
Keywords and context -- 
http://www.cch.kcl.ac.uk/legacy/teaching/av1000/textanalysis/gaskin/index.html
 
Corpus analysis of meaning - The O.J. Simpson Trial -- 
http://www.cch.kcl.ac.uk/legacy/teaching/av1000/textanalysis/oj/index.html
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Marjorie Chan, Instructions for Concordancing East Asian E-Texts using Concordance: 
http://people.cohums.ohio-state.edu/chan9/conc/concordance.htm
•  ICT4LT Module 2.4: Using concordance programs in the modern foreign languages 
classroom: http://www.ict4lt.org/en/en_mod2-4.htm Excellent, extensive, practical material 
and discussion. 
•  Tom Cobb, Is there any measurable learning from hands-on concordancing?  
http://www.er.uqam.ca/nobel/r21270/cv/Hands_on.html
  
Printed Materials 
 
T.H. Howard-Hill, Literary Concordances: a Complete Handbook for the Preparation of 
Manual and Computer Concordances (Oxford:  Pergamon Press, 1979).  The standard work 
on how to compile a concordance.  Expert scholarly discussion of editorial and compilation 
issues.  Lacks treatment of details of computer implementation. 
 
William Ingram and Kathleen Swaim, A Concordance to Milton's English Poetry  (Oxford: 
Clarendon Press, 1972). An outstanding modern example of a printed scholarly 
concordance.  A near approach to a 'variorum concordance', it succeeds in presenting the 
complexities of variant author's readings from multiple manuscripts without sacrificing 
usability. 
 
R.J.C. Watt, A Concordance to the Poetry of Philip Larkin  (Olms-Weidmann: Hildesheim-
Zurich-New York, 1995).  A full-scale modern printed concordance by the author of 
Concordance.  Arranges citations for each headword in date order, with dates given, thus 
making it easy to study the evolution of the writer's vocabulary over time. 
 
Ian Hamilton, 'I Love Concordances' (Diary), London Review of Books, vol. 18 no. 26 (22 
August 1996),  p.29. A light-hearted but knowledgeable review of two modern concordances, 
showing a good sense of the value of a concordance for the reader interested in language 
and poetic effect. 
 

Sources of Electronic Text 
 
The Web is full of electronic texts which can be used with Concordance.  If your interest is in 
classic texts, you may find these text archives particularly valuable:  
 
Project Bartleby  http://www.bartleby.com/
 
Project Gutenberg  http://www.promo.net/pg/index.html/
 
Oxford Text Archive http://ota.ahds.ac.uk
 
The On-line Books Page http://digital.library.upenn.edu/books/
 
Electronic Text Center, University of Virginia http://etext.lib.virginia.edu/collections/subjects/
 
 
You should be sure you are not infringing someone else's copyright when you use electronic 
texts. The fact that a text is available on the Internet does not guarantee that it is free of 
copyright. 
 
See also: Web Links and Bibliography  
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What's New...  and version history 
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Version 3.3 - July 2009 
 
Updates and bug fixes: 
  
New help system - Help system is now fully compatible with Windows Vista and Windows 7.  
Concordance now uses Windows HTML Help.  The contents of Help have been updated and 
revised with a few hundred changes. 
 
Windows Vista and other Windows versions - Concordance is now fully supported on 
Vista, and has also been tested without problems on Windows 7 Release Candidate.   
 
Concordance is no longer supported on Windows 95 (it may run on Windows 95, but it 
depends on which Microsoft updates happen to have been installed.) 
 
Internet Explorer 7 and 8 - Made Web Concordances compatible with Microsoft Internet 
Explorer versions 7 and 8. 
 
User interface - simplified and rationalised items on the View, Tools, and Help menus. Added 
simpler and clearer explanations to many dialogs. 'Make Fast Concordance' is now called 
'Make Selective Concordance' for clarity.  User setting for 'Show percentages' in Headword 
list is now remembered between concordances. 
 
Bugs fixed: 
•  Fixed bug which caused filenames to appear twice after saving and reloading a FileList in 
the 'Make Concordance' dialogs.  
•  Other minor bugs fixed. 
 
Version 3.2  - December 2004 
 
Various new features plus lots of bug fixes 
  
New features and improvements: 
 
XP Appearance -  Concordance now uses Windows XP appearance when running on XP 
 
Quicker and easier installation - New installer and smaller download size 
 
Navigate through source text - New navigation buttons in the text viewer let you skip 
through your source text to the next or previous occurrence of a word. Highlighted words now 
appear in the centre of the viewer or editor window. 
 
Handle split words as in Version 2.0.0 - Compatibility mode for the way words are split 
when non-word characters come in the middle of them. See this topic. 
 
New user preferences - Preferences dialog (on the Tools menu) is reorganised and has a 
new option: 
 
Show Progress Messages and Warnings - Previous versions of Concordance showed all 
progress messages while a concordance was being made.  Instead of 'All' you can now 
choose 'High Priority only' to suppress the Progress dialog unless significant warnings occur. 
 
Improvements to Help - changes and additions, including: 
- additional Frequently Asked Questions; 
 
- updated macro to add page references to Microsoft Word files
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- The help file which accompanies Web Concordances is revised and now opens in a new 
browser page by itself, instead of in the Web Concordance frameset. 
 
Pick and Stop List improvement -  In the Pick List and Stop List Managers, when you press 
'Re-sort, keeping duplicates', a window will open showing all the duplicate words found.  
 
Clearer controls   - 'Choose Lemma file', formerly on Lemmatiser's Options menu, is now 
simply 'Open' on Lemmatiser's File menu. 
 
   - 'Choose Pick List file', formerly on the Pick List's Options menu, is now simply 'Open' on 
the Pick List Manager's File menu.  Same for the Stop List. 
 
   - In the 'Make Concordance from Files' dialog, the controls to generate filename references 
are labelled in a less confusing way. Also the file list now re-sizes when the dialog is re-sized.  
 
Better warnings  - A warning is now given if the same characters are chosen for Skip 
Markers and Reference Markers. 
 
   - A warning is given when a word in the Lemmatiser appears again as a child of itself. 
Earlier versions produced an 'access violation' error. 
 
Speed   - 'Display while Loading' (on the File menu) is now turned off by default for a new 
installation.  On faster recent computers, this setting should subjectively improve performance 
when loading big concordances.  
 
  - On the Headwords menu, setting or clearing 'Read-only' is now many times quicker than 
before. 
 
Bugs fixed: 
•  Fixed bug which truncated huge texts passed via the Windows Clipboard.  
•  Fixed bug which caused program to hang when searching for the phrase  * * (two asterisk 
wildcards).   
•  Fixed bug which introduced undisplayable characters (like this: ) in Web Concordances in 
place of references in the HTML version of the source text.  
•  Fixed 'Access violation' in the Lemmatiser when a word appeared again as a child of itself.  
•  Fixed occasional corruption of .INI file by addition of many blank lines, leading to user 
settings not being correctly restored.  
•  Fixed bug whereby 'Make Full Concordance from Clipboard' could produce no output if run 
after an error had occurred during 'Make Selective Concordance from Clipboard'.  
•  Fixed bug which could cause deleted context lines to re-appear and lines not deleted to 
disappear.  
•  Fixed 'Access violation' after deleting a Headword which had had context lines deleted.  
•  Fixed bugs in display of contexts with 'Analyse characters instead of words'.  
•  Fixed minor bugs in HTML generation, e.g.  < / a > appearing in the Wordlist of a Web 
Concordance.  
•  Fixed some unwanted changes of sort order when changing views  
•  Numerous other smaller bugs fixed 

_____________________________________________________ 
 
Version 3.1 was an internal version, not released. 
 
Version 3.0  -  19 January 2002 
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Many new features and improvements: 
•  Five new ways of selecting words 
Phrases.  Find all instances of up to six phrases in your text.  More
Proximity.  Find words within a specified distance of other words. More
Samples.  Pick random or consecutive samples of words.  More
Regular Expressions.  Powerful pattern-matching.  More
References.  Select words by their speaker, page number, section, or any other references 
you define in your text.  More
•  Make Indexes 
Book-like indexing - words and a list of their locations, with no contexts.  More
•  More control over words 
Treat upper and lower case separately  - avoid normalising words to upper case when 
reading your text. More
Show duplicate words separately - display all instances of headwords in the wordlist, 
instead of aggregating them. More
Analyse characters instead of words. More
•  New ways of sorting 
Sort headwords by order of occurrence. 
Sort word endings using a string (as opposed to word) sort. 
Sort contexts by string before and string after headword.  More
•  Improved display and control 
Clicking on a context line now locates the exact word in the full-text view. 
Better control over fitting context column widths to their contents: three new menu options 
under 'Fit Columns to Contents' on the Contexts menu. 
•  New file conversion tool:  Filter a File  
Filter a File (on the Tools menu under File Conversion Tools) lets you use Concordance's 
text processing power to produce a transformed text file instead of a concordance.  More
•  User-definable HTML entity translation 
Full control over conversion between Windows characters and HTML entities during both 
input and output. More
•  Speed improvements 
Concordance now reads text faster, sorts faster, and loads concordances faster.  In 
particular, very large concordances are now loaded in time directly proportional to size 
instead of getting progressively slower with size, provided 'Display while loading' is off. 
•  New file format 
Backward compatibility: Version 3 of Concordance can read files made with earlier versions, 
with some limits on what you can do with them.  More
•  Improved language support 
Non-Latin languages are better handled, especially with Windows 2000/XP/Vista.  More 
information in special pages on the program's website, coming soon.  Language and Font 
Control is re-designed. 
•  Minor changes and bugs fixed 
  
Hot Tracking in Wordlist can now be turned on and off. It was always on in Version 2, and is 
now off by default.  More
 
Fixed bug which reported  "File not open" when adding files with long lines to the list of files to 
make a concordance from. 
 
Fixed buglet where non-concordance files could get into the recently-used list. 
 
Fixed bug which produced incorrect width in Save as Text with contexts of selected length. 
 
Made the Stop button more responsive during a lengthy sort. 
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The chosen state of the option 'User-defined alphabet' is now correctly saved in the Pick List 
and Stop List, and various other user options are now saved. 
 
Several windows now 'stay on top' by default, to prevent them becoming hidden behind the 
main window. 
 
Better control over re-sizing in the Collocations display. 
 
A large number of other minor improvements. 

_____________________________________________________ 
 
 
Version 2.0.0 - 18 December 2000 (build 135) 
 
A major revision with many new features, plus some changes to the way the program 
previously worked: 
•  Lemmatisation. Lets you group together any words you choose.  An Outliner for easy 
management of lemma lists.   More.  
•  Concordances from other Windows programs - Instantly make a concordance from text 
on the Windows Clipboard.  More
   
•  Multiple input files - The ability to make one concordance from many input files. More
   
•  Stop List - Lets you specify words to be omitted from your concordance. More
   
•  Word List Managers - for easy construction of Stop Lists and Pick Lists. This is also a 
useful general tool: it can read any plain text file, put each word on a separate line, sort them, 
and remove duplicates - a miniature Word Index program in its own right. (Limited file size 
under Windows 95/98, no limit under Windows NT4.0 and 2000.) More
   
•  Contexts - Better control over contexts, including ability to delete and undelete individual 
contexts, and to limit the number of contexts displayed (and saved, exported, printed). 
   
•  Easier Alphabet control - Characters you've omitted from your user-defined Alphabet can 
now be added automatically as your text is read. 
   
•  Better Wordlist control  - you can now copy all words from the Wordlist to the Clipboard, 
or select multiple words and copy them.  Also copy the words in the Scratchpad to the 
Windows Clipboard or save them to a file.  
   
•  Renamer - allows renaming of text files and their associated concordance files easily in 
one operation. 
   
•  Help system - Many additions, including Frequently Asked Questions . 
   
•  Web Concordance extras - Word frequencies and percentages can be added to the 
Wordlist frame in a Web Concordance.  Lemmatised wordlists can use images or indentation 
to indicate lemmatisation. 
   
•  Performance - Program uses less RAM and starts up faster. 
   
•  Better error reporting - Proper English error messages for some common errors such as 
'File in use by another program' and 'Disk full'.  
  
Minor improvements and changes:  
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•  In-place editor for Headwords now uses a language-aware editor instead of the Windows 
in-place editor.  
•  Can now copy selectively out of the Progress dialog.  
•  Can copy characters from the character set in the Language Control.  
•  Many new options on the Help menu.  
•  Added option to remove obsolete file names from Recently used file list (File -> Reopen).  
•  Numerous improvements to operation of controls in Print Preview.  
•  Made Web Concordance framesets compatible with Microsoft Internet Explorer 5.0 by 
removing border size specifier in the frameset tag. If you have upgraded to a new version of 
Concordance, the border sizes will be stored as one of your preferences, and you will have to 
edit the Editable Sections in HTML Setup if your frame borders are invisible when viewed with 
Internet Explorer 5.0. See Frequently Asked Questions.  
•  Changes to Resource Gauges to show available disk space.  
•  In Text View and Text Edit, words selected by double-click are now shown in the status bar 
using the correct character set of the chosen language.  
•  Documented a way of making a PDF file with the output from Concordance.  
•  Can use the Delete key to delete words from the Wordlist and Scratchpad, and Contexts 
from the context Views.  
•  Comma is now by default included in sense-unit punctuation for selecting contexts.  
•  A new, easier option for applying registration keys.  
•  Making a concordance with contexts of selected length should no longer produce 
occasional 'Read beyond end of file' errors.  
•  Contexts of selected length can now consist of zero words before and after the headword 
(previous minimum was one).  
•  New Preferences dialog.  
•  Can now choose whether to reload Alphabet with each reloaded concordance.  
•  Can now click on a concordance file in My Computer or Windows Explorer to start the 
program and display that concordance.  
•  Additional menu settings now saved automatically ('Display while loading', 'Fit columns to 
contexts', and all settings beginning with 'Show...' on the Headwords and Contexts menus 
except 'Show Percentages').  
•  Many other minor improvements and bug fixes. 
  
 
One Drawback of Version 2.0.0 
 
If you choose Contexts of Selected Length, Version 2.0.0 takes longer to make a 
concordance than previous versions.  You can avoid this slowdown by choosing the Actual 
Line as context for your concordance. If you need Contexts of Selected Length, you can 
minimise the slowdown by choosing short contexts (for example, just two or three words 
before and after the headword). 
 
Version 2.0.0 changes to Browser and Multiple Document Editor:  
•  MD Editor can now append files  
•  Browser is now a MDI application (can browse multiple files)  
•  Both programs can open files from the command line, e.g. *.TXT   
•  Both programs can open files by multiple-selecting in the Open dialog  
•  Both keep a list of recently-used files to re-open  
•  Bugs fixed in MD Editor:  
•  If you chose File|Open, then typed a new filename, it asked to confirm that the file does not 
exist, but then gave an error. Fixed.  
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•  Saving a file as a text file did not add the .txt extension - fixed. Same bug also fixed when 
saving a concordance as text.  
•  Both programs, plus the Unix and OEM-Ansi converters, now have intelligible English error 
messages for common errors such as 'Disk Full' or 'File in use'. 
  

_____________________________________________________ 
 
Version 1.1.3  - 11 April 1999  
 
New features: 
•  Added option to write plain text links (as third alternative to buttons and to text with images) 
in Web Concordances  
•  Consequent re-design of HTML Setup dialog  
 
Fixes: 
•  The program is now more tolerant of control characters in the input text  
•  Some HTML Setup options were not being saved to the .Ini file; fixed. 

_____________________________________________________ 
 
Version 1.1.2  - 29 March 1999 
 
This release fixed a number of bugs; it did not add any new functionality. 
 
Users upgrading from a version earlier than 1.1.2 are recommended to delete their 
Concordance.ini file (in the Windows folder) when upgrading.  As this will cause the program 
to forget your recent settings, you might want to note down your settings first by looking in 
various dialog boxes, such as all four on the Text menu and also HTML Setup on the File 
menu.  
•  Fixed bug causing slow loading of concordance after unloading a concordance while 
percentage display is on  
•  Disallowed two simultaneous instances of print preview form  
•  Fixed frame targetting for 'Made with Concordance' message  
•  Fixed bug which was allowing CR/LF and other non-alphabetic characters in Alphabet 
Editor, corrupting alphabet  
•  Fixed bug which corrupted alphabet after an attempt to load an invalid concordance file  
•  Fixed bug which converted Web Concordance source text to HTML even when it already 
was HTML, and which did not allow selection of preformatted text, as opposed to tables, for 
layout of a Web Concordance  
•  Additions to help file 

_____________________________________________________ 
 
 
Version 1.1.0 - 31 January 1999 
•  Added ability to view Collocations for up to four words left and right of any headword  
•  Added ability to sort contexts by any of the four words to left and right of the headword  
•  Fixed bug where File|New in the editor would replace any unsaved file without warning  
•  Several minor cosmetic bugs fixed  
•  Additions to help file 

_____________________________________________________ 
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Version 1.0.0 - 19 January 1999 
•  First public release 
   

Types and tokens 
 
Types are word-forms and tokens are occurrences of word-forms.  So, for example, in the 
sentence 'The cat sat on the mat', there are two tokens of the type 'the' and one token each of 
the types 'cat', 'sat', 'on', and 'mat'.  

New file format in Version 3 

 
Version 3 of Concordance introduces a new internal format for concordance files. As the 
program manages concordance files automatically, you don't need to know about the details 
of the format.  What you need to know is this: 
•  Version 3 of Concordance can read concordance files made with earlier versions. You can 
re-open them as often as you like, and even make changes such as deleting headwords or 
contexts, but you won't be able to save the changes.  You will be reminded of this when you 
open the concordance. 
•  It is easy to update old concordance files. Just re-make the concordance.  (That is, make a 
concordance to your text over again with Version 3.) 
•  Earlier versions of Concordance can't read files made with version 3. If you still have an 
earlier version of the program and try to open such a file, the program will say 'This is not a 
valid concordance file!'. 
 
Details: 
 
The new file format makes possible two of Version 3's new abilities: exact location of words in 
the full text view when you click on a line of context; and sorting headwords by order of 
occurrence.   
 
If you open a concordance made with an earlier version of the program, these two features 
will not always give accurate results. 
 

Alternative location for .ini file 

 
The program normally creates its .ini file for saving settings in the Windows folder.  On 
some systems, such as Windows Vista, XP, and 2000, it may be desirable to store this file 
elsewhere, as such systems do not always allow users to write to the Windows folder.  To do 
this, you can add a value to the Windows Registry. 
 
You should NOT use this method unless you are fully familiar with the process of 
editing the Windows Registry. Mistakes or accidents while editing the Registry can 
result in an unusable computer.  Make sure you have correctly backed up the Registry 
before proceeding! 
 
Create an extra string value in the Registry under the same key where Concordance stores its 
other settings. This is  
 
HKEY_LOCAL_MACHINE\SOFTWARE\RJCW\Concordance\1.0  
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Call the new string IniPath, and give it the value of the path to the folder where you want to 
store Concordance.ini. The path should *not* include the filename Concordance.ini. A 
trailing backslash on the path is optional. Quotation marks (single or double) around the path 
are optional. If the path you give in this registry value does not exist when the program runs, 
the path will be created if possible. 
 
To sum up, if IniPath exists in the registry and has as its value a path which exists or which 
the program can create, the program will look for Concordance.ini in that location instead 
of in the Windows directory. Concordance.ini itself will be created if it does not exist. 
 

Using Windows XP appearance 

 
Versions of Concordance starting with 3.2, when running on Windows XP, will use Windows 
XP's appearance. This applies to elements such as buttons and icons in the program, and 
standard Windows dialogs such as the File Open and Save dialogs. 
 
If you prefer to revert to the older appearance, or if your computer gives problems when using 
the new XP appearance, find the folder where Concordance is installed, look for the file with 
the full name Concordance.exe.manifest, and rename it to something else, or move it to 
another folder. 

Handle split words as in Version 2.0.0 

This checkbox in the Alphabet dialog allows you to choose between two alternative 
behaviours for splitting words when non-word characters are encountered in the middle of a 
word.  The default behaviour matches that of Version 3.0 of Concordance; the alternative 
matches that of Version 2.0.0.   

Example  

Take the hyphen as an example. Say the text contains 'dog-eared'. Assume the hyphen is not 
included in the Alphabet (and you have also chosen not to have unrecognised characters 
added automatically to the Alphabet). 

Version 2.0.0 rendered the headword as 

DOGEARED 

Version 3.0 rendered it as two words: 

DOG 

EARED 

In Version 3.2 you can choose between these behaviours. Go to the Text menu and open the 
Alphabet dialog.  If you want the behaviour of Version 2.0.0, tick the checkbox 'Handle split 
words as in version 2.0.0.'  If you leave it unticked, you get the behaviour of Version 3.0. 

There is nothing special about the hyphen here. The same applies to the treatment of any 
undefined character occurring inside a word: if you choose Version 2.0.0 behaviour, the word 
will be assembled as a single word; if you choose Version 3.0 behaviour, it will be given as 
two words. 

Talking of the hyphen, you can of course include it in your Alphabet and so produce 'DOG-
EARED'. For fuller information, see Frequently Asked Questions and look for the question 
'How do I... show compound words?' 
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Another Example  

Assume your text contains 'an<n>o'. Assume too that the angle brackets, < and > , are not in 
your Alphabet nor defined elsewhere (e.g. as reference markers). 

Version 2.0.0 rendered the headword as  

ANNO 

Version 3.0 rendered it as 

AN 

N 

O 

In Version 3.2 you can choose which behaviour you want. 

 

This is the end of the Manual 
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